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About This Guide

The Novell Teaming 2.1 Installation Guide covers the installation and configuration of the Novell® 
Teaming software. The guide is divided into the following sections:

Part I, “Product Overview,” on page 13
Part II, “Basic Installation,” on page 25
Part III, “Advanced Installation and Reconfiguration,” on page 79
Part IV, “Multi-Server Configurations and Clustering,” on page 101
Part V, “Update,” on page 137
Part VI, “Appendixes,” on page 171

Audience

This guide is intended for Novell Teaming administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the most recent version of the Novell Teaming 2.1 Installation Guide and other documentation, 
visit the Novell Teaming 2.1 Documentation Web site (http://www.novell.com/documentation/
teaming21).

Additional Documentation

You can find more information in the Novell Teaming documentation, which is accessible from links 
within Novell Teaming:

Novell Teaming Help system
Novell Teaming Quick Start
Novell Teaming User Guide
Novell Teaming Advanced User Guide
Novell Teaming Administration Guide
Novell Teaming Developer Guide

To access the Novell Teaming Help system, log in to the Teaming site, then click the Help icon 
(question mark), then click a yellow Help spot for context-sensitive help.

To access the Novell Teaming guides from within Teaming, click the Help icon (question mark), 
then click Teaming Manuals.
About This Guide 11
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Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux* or UNIX*, should use forward slashes as required by your software.
 Teaming 2.1 Installation Guide



I
novdocx (en)  16 A

pril 2010
IProduct Overview

Chapter 1, “What Is Novell Teaming?,” on page 15
Chapter 2, “Teaming System Requirements,” on page 19
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1What Is Novell Teaming?

Novell® Teaming is an enterprise collaboration tool designed to increase individual productivity, 
team effectiveness, and organizational success by providing the right set of tools to the right people.

Section 1.1, “Teaming Capabilities,” on page 15
Section 1.2, “Teaming Components,” on page 16
Section 1.3, “Teaming Configurations,” on page 17

1.1  Teaming Capabilities
Novell Teaming users fall into three basic groups:

Section 1.1.1, “Content Consumers,” on page 15
Section 1.1.2, “Content Providers,” on page 15
Section 1.1.3, “Administrators,” on page 16

1.1.1  Content Consumers
Content consumers use Novell Teaming to work with important information that pertains to them. 
Content consumers:

Maintain their personal workspaces, including setting up a personal blog, calendar, file folder, 
guestbook, photo album, and task folder
Participate in team workspaces set up for content providers, in order to better collaborate with 
colleagues and facilitate their work assignments
Search the Teaming site for people, places, and other information that pertains to their personal 
work assignments
Identify subject-matter experts to assist them in their personal work assignments 

The typical tasks performed by content consumers are covered in the Novell Teaming 2.1 User 
Guide.

In many cases, content consumers quickly become content providers as well.

1.1.2  Content Providers
Content providers use Novell Teaming to create and manage teams, customize the Teaming 
environment, and import data into the Teaming site for use by other Teaming users. Content 
providers:

Create and manage team workspaces and folders
Control user access to their team workspaces
Establish unique branding for workspaces and folders to clearly differentiate them from other 
places on the Teaming site
What Is Novell Teaming? 15
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Create landing pages for workspaces that consolidate the most information workspace 
information into a single page
Customize data entry forms for gathering information from users
Create workflows to automate otherwise time-consuming manual processes

The typical tasks performed by content providers are covered in the Novell Teaming 2.1 User Guide.

1.1.3  Administrators
A Novell Teaming administrator is responsible for installing the Teaming software and setting up the 
Teaming site. This Novell 2.1 Installation Guide provides instructions for Teaming software 
installation. After installation, the Teaming site administrator can:

Set up user access to the Teaming site
Create initial workspaces and populate them with information that is of interest to Teaming 
users
Control user access to workspaces and folders
Configure e-mail integration, so that Teaming users can receive notifications of updated 
information on the Teaming site and post to the Teaming site using e-mail messages
Set up mirrored folders to make large sets of data that are already available on disk more easily 
available through the Teaming site
Set up software extensions (add-ons) that enhance the power and usefulness of the Teaming site
Set up remote applications that deliver data from a remote location, such as a remote database, 
for easy access on your Teaming site
Manage users, workspaces, and folders as the Teaming site grows and evolves
Perform regular backups to safeguard the data stored in the Teaming site

The typical tasks performed by Teaming site administrators are covered in the Kablink Teaming 2.1 
Administration Guide.

1.2  Teaming Components
A Novell Teaming site consists of four major components:

Section 1.2.1, “Teaming Software,” on page 16
Section 1.2.2, “Teaming Database,” on page 17
Section 1.2.3, “Teaming File Repository,” on page 17
Section 1.2.4, “Lucene Index,” on page 17

1.2.1  Teaming Software
The Novell Teaming software is a customized version of Apache* Tomcat. This software provides 
all the Web-based functionality you use as you access the Teaming site through your Web browser.
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1.2.2  Teaming Database
The Novell Teaming database is used for storing information about the Teaming site and its users:

Structural information about workspaces, folders, and entries (for example, their location in the 
workspace tree)
Identification information about workspaces, folders, and entries (for example, titles, 
descriptions, dates of creation/modification, and users associated with creation/modification)
User profile information (for example, full name, phone number, and e-mail address)

The Teaming database disk space requirements are relatively modest, because it is not used for 
storing files.

1.2.3  Teaming File Repository
The Novell Teaming file repository holds all files that are imported into Teaming, information 
related to the imported files, such as thumbnails and HTML renderings, and the search engine index.

The Teaming file repository disk space requirements depend on the size of the Teaming site. For a 
large Teaming site, disk space requirements can be substantial. 

1.2.4  Lucene Index
The Lucene* Index Server is a high-performance Java* search engine. The Lucene index contains 
pointers to the actual data stored in the Novell Teaming file repository. The index enables the 
Lucene search engine to perform very fast searches through large quantities of Teaming data.

1.3  Teaming Configurations
You can configure Novell Teaming to run on a single server or multiple servers, depending on the 
size and needs of your Teaming site.

Configuration Description

Single Server By default, the Novell Teaming Installation program installs all Teaming 
components on the same server. 

Remote Database 
Server

For better performance and scalability, you can install the Teaming database on a 
remote server

Remote Lucene 
Index Server

For better performance and scalability, you can install the Lucene index on a 
remote server

Multiple Teaming 
Servers

By running Novell Teaming on multiple servers, you can achieve high availability 
functionality, including failover and load balancing, depending on how you 
configure your servers.

Multiple Remote 
Lucene Servers

Your Novell Teaming site depends on the Lucene Index Server for full 
functionality. Running multiple Lucene Index Servers provides high availability 
functionality, so that if one Lucene Index Server goes down, Teaming users can 
still access the Teaming site because other Lucene Index Servers are still 
available.
What Is Novell Teaming? 17
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For more information, see Part IV, “Multi-Server Configurations and Clustering,” on page 101.

Multiple Remote 
Database Servers

The three databases supported by Teaming each have their own approach to 
clustering the database server. Information about clustering database servers is 
available on the Internet.

Configuration Description
 Teaming 2.1 Installation Guide
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2Teaming System Requirements

You, as a Novell® Teaming site administrator, must ensure that your system meets Teaming system 
requirements, so that your Teaming site can be set up successfully. After your Teaming site is set up, 
you must ensure that users’ browsers and office applications meet Teaming user requirements, so 
that users can access the Teaming site successfully.

Section 2.1, “Teaming Server Requirements,” on page 19
Section 2.2, “Teaming User Requirements,” on page 20
Section 2.3, “Mobile Device Requirements,” on page 21
Section 2.4, “Supported Environments,” on page 21
Section 2.5, “Recommended Hardware Configurations,” on page 23

For the latest system requirements details, see the Novell Teaming 2.1 Readme (http://
www.novell.com/documentation/teaming21/team21_readme_novell/data/
team21_readme_novell.html).

2.1  Teaming Server Requirements
Hardware for the Novell Teaming server:

32-bit/x86 processor or 64-bit/x86 processor 
Minimum 2 GHz processor
Multi-CPU systems preferred
Adequate server memory:

At least 3 GB RAM for a 32-bit processor
At least 4 GB RAM for a 64-bit processor

See Section 2.5, “Recommended Hardware Configurations,” on page 23 and 
Section 3.2.3, “Teaming Server Memory,” on page 29

Any of the following supported server operating systems for the Teaming server:
Novell® Open Enterprise Server (OES) 2 Linux, plus the latest Support Pack
SUSE® Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack

NOTE: The X Window System is required by the Teaming Installation program. It is not 
required when running Teaming after installation.

Windows* Server* 2003 or Windows Server 2008, plus the latest Service Pack
Database server:

Linux: 
MySQL* 5.0.26 or later server and client, or MySQL 5.1 server and client

NOTE: MySQL 5.0.26 is included with SLES 10 SP1 and OES 2 Linux. MySQL 
5.0.67 is included with SLES 11.

Oracle* 10g or Oracle 11g
Teaming System Requirements 19
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Windows:
MySQL 5.0.26 or later server and tools, or MySQL 5.1 server and tools
Microsoft* SQL Server* 2005 or SQL Server 2008, plus the latest Service Pack
Oracle 10g or Oracle 11g

More information about MySQL is available in MySQL Database Server in Appendix A, 
“Teaming System Requirements Assistance,” on page 173.
Tomcat 6.0.18

NOTE: Tomcat 6.0.18 is included with Teaming on Linux and Windows.

Java Developer Kit (JDK*):
Sun* JDK 5.0 or JDK 6.0
IBM* JDK 5.0 or JDK 6.0
Java scripting must be enabled for proper Teaming site functionality.
More information about JDKs is available in Java Development Kit in Appendix A, 
“Teaming System Requirements Assistance,” on page 173.

Directory service:
Linux: Novell eDirectoryTM 8.8 or later, plus the latest Support Pack
For information about eDirectory, see the Novell eDirectory 8.8 Documentation Web site 
(http://www.novell.com/documentation/edir88).
Windows: Microsoft Active Directory*, plus the latest Service Pack, or Novell eDirectory 
8.8 or later, plus the latest Support Pack
For information about Active Directory, see Windows Server 2003 Active Directory 
(http://www.microsoft.com/windowsserver2003/technologies/directory/activedirectory) 
or Windows Server 2008 Active Directory (http://www.microsoft.com/
windowsserver2008/en/us/active-directory.aspx).

Adequate server disk space:
Teaming software: Approximately 250 MB
Database server software: Approximately 250 MB
Teaming file repository: Depends on the anticipated size of the Teaming site
Database content: Substantially less than the Teaming file repository
See Section 3.5, “Planning the Teaming Database,” on page 34 to plan for the disk space 
needs of your Teaming site.

NOTE: Teaming 1.0 was integrated with the Liferay* portal, but the Teaming 2.x releases are not. If 
you are updating from Teaming 1.0 to Teaming 2.1, the Installation program backs up your existing 
Liferay data and reconfigures your Teaming site to run without integration with Liferay.

2.2  Teaming User Requirements
Web browser:

Linux: Mozilla* Firefox*
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Windows: Microsoft Internet Explorer* 6.0 or later; Mozilla Firefox
Mac: Safari* 3 or later; Mozilla Firefox

Office applications:
Linux: OpenOffice.org* 3.1.1 or later
Windows: Microsoft Office 2007; OpenOffice.org 3.1.1 or later
Mac: OpenOffice.org 3.1.1 or later

Collaboration clients:
Linux:

GroupWise® 8 with the latest Support Pack
Windows:

GroupWise 8 with the latest Support Pack
Outlook 2007 with iCal support enabled
Notes 7 with iCal support enabled

2.3  Mobile Device Requirements
Section 2.3.1, “Supported Mobile Devices,” on page 21
Section 2.3.2, “Device Browser Requirements,” on page 21

2.3.1  Supported Mobile Devices
The Novell Teaming mobile interface is supported on the following mobile devices:

iPhone*
BlackBerry*

NOTE: The BlackBerry Curve* has issues with JavaScript*, so it does not work with the 
Teaming mobile interface. For more information, see “Your BlackBerry Curve Does Not Work 
with the Mobile Interface” in “Troubleshooting” in the Novell Teaming 2.1 User Guide.

Any other mobile device that provides an HTTP/HTML-based interface

Ensure that your device’s browser meets the requirements that are discussed in Section 2.3.2, 
“Device Browser Requirements,” on page 21.

2.3.2  Device Browser Requirements
To use Novell Teaming from a mobile device, your device’s browser must support: 

HTML 4
JavaScript

2.4  Supported Environments
Section 2.4.1, “File Viewer Support,” on page 22
Section 2.4.2, “IPV6 Support,” on page 22
Teaming System Requirements 21
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Section 2.4.3, “Clustering Support,” on page 22
Section 2.4.4, “Xen Virtualization Support,” on page 22
Section 2.4.5, “VMware Support,” on page 23
Section 2.4.6, “Single Sign-On Support,” on page 23
Section 2.4.7, “Linux File System Support,” on page 23

2.4.1  File Viewer Support
In Novell Teaming, file viewing capabilities are provided by Oracle Outside In viewer technology. 
See Oracle Outside In Technology 8.3 Supported Formats (http://www.oracle.com/technology/
products/content-management/oit/ds_oitFiles.pdf) for a list of the supported file formats. See Oracle 
Outside In Technology (http://www.oracle.com/technologies/embedded/outside-in.html) for 
background information about the Oracle viewer technology included in Teaming.

 The file viewers also support data indexing by the Lucene Index Server.

2.4.2  IPV6 Support
Novell Teaming supports the IPV6 protocol when it is available on the server. If it is available, 
Teaming detects it and supports IPV6 by default, along with IPV4. 

2.4.3  Clustering Support
You can set up your Novell Teaming site in any of the following clustering environments:

Novell Cluster ServicesTM on Linux. 

For information about Novell Cluster Services on Linux, see the Clustering (High Availability) 
section of the Open Enterprise Server 2 SP1 Documentation Web site (http://www.novell.com/
documentation/oes2/cluster-services.html#cluster).
Microsoft Clustering Services in Windows
For more information, see Windows 2003 Server Cluster (http://www.microsoft.com/
windowsserver2003/enterprise/clustering.mspx) or Windows Server 2008 High Availability 
(http://www.microsoft.com/windowsserver2008/en/us/high-availability.aspx).

In addition, you can install Teaming components on multiple servers to provide failover support, as 
described in Part IV, “Multi-Server Configurations and Clustering,” on page 101.

2.4.4  Xen Virtualization Support
You can install Novell Teaming in virtual environments where a software program enables one 
physical server to function as if it were two or more physical servers. Xen* virtualization technology 
in Novell Open Enterprise Server (Linux version) and SUSE Linux Enterprise Server is supported. 
For more information, see:

Open Enterprise Server 2 Virtualization Documentation Web site (http://www.novell.com/
documentation/oes2/virtualization.html#virtualization)
SLES Virtualization Technology Documentation Web site (http://www.novell.com/
documentation/vmserver).
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2.4.5  VMware Support
Novell Teaming is supported on the following versions of VMware*:

VMware Server (formally GSX Server), an enterprise-class virtual infrastructure for x86-based 
servers
VMware ESX Server, a data-center-class virtual infrastructure for mission-critical 
environments
For more information, see the VMWare Web site (http://www.vmware.com).

2.4.6  Single Sign-On Support
Novell Access Manager can be used to provide single sign-on capabilities for your Teaming site. For 
setup instructions, see Section 9.8, “Configuring Single Sign-On with Novell Access Manager,” on 
page 88.

2.4.7  Linux File System Support
For best Novell Teaming performance on Linux, the ext3 file system is recommended. If you are 
running OES Linux and need the feature-rich environment of the NSS file system, Teaming is also 
supported there. The reiser3 file system is also supported.

2.5  Recommended Hardware Configurations
The hardware configuration that you set up for your Teaming site should be based on the number of 
active users that the Teaming site must support.

Active 
Users Teaming Components CPU Memory Java 

Heap

10 1 dedicated Teaming server with:

Tomcat

Lucene

SQL

x86 2 GB 1 GB

50 1 dedicated Teaming server with:

Tomcat

Lucene

SQL

x64 
dual core

4 GB 2 GB

100 Multiple Teaming servers:

1 dedicated Tomcat server

1 dedicated Lucene server

1 dedicated SQL server

x64 
dual core

4 GB 2 GB
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Server machines can be physical or virtual.

You can perform a Basic Installation to set up a single-server configuration, as described in 
Chapter 3, “Planning a Basic Teaming Installation,” on page 27 and Chapter 4, “Setting Up a Basic 
Teaming Site,” on page 49.

You can perform a Basic Installation to set up a multiple-server configuration, but the remote 
database must be created manually and in advance of performing the installation, as described in 
Part IV, “Multi-Server Configurations and Clustering,” on page 101.

500 Multiple Teaming servers:

3 dedicated Tomcat servers with an L4 load balancer

2 dedicated Lucene servers

2 dedicated SQL servers

x64 
quad core

8 GB 6 GB

1000 Multiple Teaming servers:

5 dedicated Tomcat servers with an L4 load balancer

4 dedicated Lucene servers

2 dedicated SQL servers

x64 
quad core

8 GB 6 GB

Active 
Users Teaming Components CPU Memory Java 

Heap
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IIBasic Installation

Chapter 3, “Planning a Basic Teaming Installation,” on page 27
Chapter 4, “Setting Up a Basic Teaming Site,” on page 49
Chapter 5, “Adding Users to Your Teaming Site,” on page 63
Chapter 6, “Updating Your Teaming License,” on page 69
Chapter 7, “What’s Next,” on page 71
Chapter 8, “Basic Teaming Installation Summary Sheet,” on page 73
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3Planning a Basic Teaming 
Installation

The Novell® Teaming Installation program helps you install the Teaming software and file 
repository to the appropriate locations.

Section 3.1, “What Is a Basic Teaming Installation?,” on page 27
Section 3.2, “Selecting the Operating Environment for Your Teaming Server,” on page 28
Section 3.3, “Selecting a Java Development Kit,” on page 31
Section 3.4, “Gathering Network Information for Your Teaming Site,” on page 32
Section 3.5, “Planning the Teaming Database,” on page 34
Section 3.6, “Gathering Outbound E-Mail Information,” on page 37
Section 3.7, “Enabling Inbound E-Mail,” on page 39
Section 3.8, “Planning Site Security,” on page 41
Section 3.9, “Gathering Directory Services Information,” on page 42
Section 3.10, “Accommodating Multiple Languages,” on page 47

3.1  What Is a Basic Teaming Installation?
The Novell Teaming Installation program provides two installation types: Basic and Advanced. 
When you perform a Basic installation, the result is a fully functional Teaming site with all required 
options configured and with typical defaults in use for optional settings. 

If you are new to Teaming, the easiest way to get started is to perform a Basic installation first, with 
all Teaming components installed on the same server, then add advanced configuration options to 
your Teaming site after the Basic installation has been successfully tested. However, experienced 
Teaming administrators can choose to perform an Advanced installation immediately, which 
includes all installation and configuration options, as described in Part III, “Advanced Installation 
and Reconfiguration,” on page 79.

IMPORTANT: The following Teaming configurations require that you perform an Advanced 
installation as your initial installation of the Teaming software:

Setting up the Teaming file repository so that some types of files are located outside the 
Teaming file repository root directory. See Section 9.2, “Distributing Different Data Types to 
Different Locations,” on page 81 for Advanced installation instructions. You cannot move 
subdirectories within the Teaming file repository after they have been created.
Installing the Teaming software on multiple servers to create a clustered environment. See 
Chapter 15, “Running Teaming on Multiple Servers,” on page 113 for Advanced installation 
instructions. The option to enable a clustered environment is available only during an 
Advanced installation.
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If you want to implement an Advanced installation option, you should perform a Basic installation 
first, in a test environment, before performing the Advanced installation to set up your permanent 
Teaming site.

This section helps you make informed decisions about the required options for a Basic installation:

Server platform (Linux or Windows)
Server architecture (32-bit or 64-bit)
Physical server memory requirements
File locations (Teaming software and data)
Java Development Kit (JDK) version (Sun or IBM)
Database type (MySQL, Microsoft SQL Server, or Oracle)
Database creation (during installation or before installation)
Database authentication (username and password)
Network information (Teaming server hostname or fully qualified domain name, and ports)
Outbound e-mail configuration (SMTP vs. SMTPS, hostname, SMTP port, time zone, 
authentication)
Inbound e-mail configuration (SMTP address, SMTP port, and TLS support)
User and group for running the Teaming software (Linux only)

Before performing a Basic installation, make all system requirements are met, as listed in Chapter 2, 
“Teaming System Requirements,” on page 19.

3.2  Selecting the Operating Environment for 
Your Teaming Server

Section 3.2.1, “Teaming Server Platform,” on page 28
Section 3.2.2, “Teaming Server Architecture,” on page 29
Section 3.2.3, “Teaming Server Memory,” on page 29
Section 3.2.4, “Teaming Installation Locations,” on page 30
Section 3.2.5, “TrueType Font Location (Linux Only),” on page 31

3.2.1  Teaming Server Platform
Novell Teaming can run on the versions of Linux and Windows listed in Section 2.1, “Teaming 
Server Requirements,” on page 19.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Teaming Server Platform, mark your operating system of choice.
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3.2.2  Teaming Server Architecture
Novell Teaming can run on 32-bit or 64-bit processors. A 64-bit processor is recommended for a 
large Teaming site where the processor load will be heavy and data storage will require a large 
amount of disk space.

3.2.3  Teaming Server Memory
If a 32-bit processor is sufficient for your Novell Teaming server, the server needs at least 3 GB of 
memory. If you plan to use a 64-bit processor in your Teaming server, the server needs more.

Teaming server memory usage is significantly affected by some factors and less affected by others:

Number of users logged in: No significant effect.
Number of concurrent active sessions: No significant effect.
Database server caches: Significant memory usage. 
When you follow the instructions for a Basic installation, the database is located on the same 
server as the Teaming software. After you have successfully tested your Basic installation, you 
can reconfigure Teaming to have its database on a remote server, so that the database uses 
separate memory resources, as described in Chapter 13, “Creating the Teaming Database on a 
Remote Server,” on page 103.
Teaming internal data caches: Significant memory usage. 
When you follow the instructions for a Basic installation, the Teaming internal data caches are 
subdirectories of the teamingdata directory, described in Section 3.2.4, “Teaming Installation 
Locations,” on page 30. The Teaming internal data caches are separate from any caching or 
memory usage by the database server itself.
Lucene index cache: Significant memory usage. 
The Lucene* Index Server is a high-performance Java search engine. Large file repositories 
(particularly with large files or a large number of files) can create a very large data index. When 
you perform a Basic installation, the Lucene index is created on the same server where the 
Teaming software is installed. After you have successfully tested your Basic installation, you 
can reconfigure Teaming to have its Lucene index on a remote server, so that it uses separate 
memory resources, as described in “Moving the Lucene Index Server to a Remote Server” on 
page 109.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Processor Architecture, mark the processor capacity required for the size of Teaming site that you 
want to set up.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Memory Requirements, specify the amount of physical memory you plan to have in your Teaming 
server.
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When you perform a Basic installation, the amount of memory allocated to the Java Virtual Machine 
(JVM*) where the Teaming software runs defaults to 1 GB, which is adequate for a medium-sized 
Teaming site running on a 32-bit server. This memory allocation, called the Java “heap size,” does 
not include memory used by your database server or by the Lucene Index Server when these 
programs are running on the same server as the Teaming software.

A general rule is that no more than 75% of the available physical memory should be allocated to the 
JVM. Memory not allocated to the JVM must be sufficient to support the operating system, the 
database server, and the Lucene Index Server if they are also running on the Teaming server, and any 
other processes running on the Teaming server.

IMPORTANT: A JVM on a 32-bit server should not be configured to take more than 1.5 G of 
memory. However, large numbers of users and documents often need memory settings higher than 2 
GB to provide adequate performance. Such a Teaming system should be set up on 64-bit hardware.

Although it is possible to run Novell Teaming with less than 1 GB of memory for the JVM, this 
applies only to very small test configurations, and is not suitable for production systems. In a test 
configuration, 512 MB is the minimum amount of memory required to produce a functioning 
Teaming installation.

3.2.4  Teaming Installation Locations
The default file location for the Novell Teaming software varies by platform:

Included under the main Teaming software directory are subdirectories for Tomcat and file viewer 
software.

The default file location for the Novell Teaming file repository also varies by platform:

IMPORTANT: On Windows, the Teaming Installation program displays the Windows pathname 
using forward slashes (/) rather than the traditional back slashes (\). This syntax is necessary in the 
Installation program.

The Teaming file repository holds all files that are imported into Teaming, information related to the 
imported files, such as thumbnails and HTML renderings, and the search engine index.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Java JDK Location, specify the amount of memory to allocate to the JVM where Teaming runs.

Linux: /opt/novell/teaming

Windows: c:\Program Files\Novell\Teaming

Linux: /var/opt/novell/teaming

Windows: c:\Novell\Teaming
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A Basic installation allows you to change the root directory for the Teaming software and the 
Teaming file repository. 

IMPORTANT: If you want to organize the Teaming file repository so that some file types are not 
under the Teaming file repository root directory, you must perform an Advanced installation as your 
initial Teaming installation. You cannot move directories out of the Teaming file repository root 
directory after the initial installation has been performed. To perform an Advanced installation in 
order to organize the Teaming file repository to meet your needs, complete the planning steps for a 
Basic installation and complete the Basic Teaming Installation Summary Sheet, then follow the 
additional instructions in Distributing Different Data Types to Different Locations.

3.2.5  TrueType Font Location (Linux Only)
The Oracle Outside In viewer technology used by Novell Teaming to render various file formats into 
HTML for viewing require access to TrueType* fonts. Typical locations for these fonts are:

/usr/X11R6/lib/X11/fonts/truetype
/usr/share/fonts/truetype

3.3  Selecting a Java Development Kit
As listed in Section 2.1, “Teaming Server Requirements,” on page 19, you need to install a Java 
Development Kit (JDK) before you install Novell Teaming. You can use either the Sun JDK or the 
IBM JDK for the platform where you are installing Teaming (Linux or Windows).

You must install the JDK on the Teaming server before you install the Teaming software. If you are 
not familiar with installing a JDK, see Java Development Kit in Appendix A, “Teaming System 
Requirements Assistance,” on page 173 for instructions.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under File Locations, specify the directories where you want to install the Teaming software and data if 
you prefer not to use the default locations.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under File Locations, specify the directories where you want to install the Teaming software and data if 
you prefer not to use the default locations.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Java Development Kit, mark the JDK that you want to use with Teaming.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Java Development Kit, specify the directory where you install the JDK.
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The Teaming Installation program uses this path as if you had set the JAVA_HOME environment 
variable. The path is stored for future reference in the installer.xml file so that you have to 
specify the path to the JDK only once.

3.4  Gathering Network Information for Your 
Teaming Site
When you perform a Basic installation, the Novell Teaming Installation program needs hostname 
and HTTP port information about the server where you are installing Teaming.

Section 3.4.1, “Host Identification,” on page 32
Section 3.4.2, “Port Numbers,” on page 32

3.4.1  Host Identification
When you install Novell Teaming, the Teaming installation program needs to know the name of the 
server where you are installing the Teaming software. The default is localhost. Do not use the 
default.

For internal use, you can use the DNS hostname of the Teaming server. However, if you want your 
Teaming site to be accessible from the Internet, you must specify the fully qualified domain name 
for the Teaming server in order to allow external access.

3.4.2  Port Numbers
When you install Novell Teaming, Tomcat is installed along with the Teaming software. Teaming 
uses Tomcat as a standalone Web server for delivering data to Teaming users in their Web browsers. 
For more information about Tomcat, see the Apache Tomcat Web site (http://tomcat.apache.org). 

IMPORTANT: If the server where you want to install Teaming already has a Web server running on 
it, shut it down while you install and test Teaming. The instructions for a Basic Teaming installation 
assume that no other Web server is running on the Teaming server. If you want to maintain another 
Web server on the Teaming server, you are responsible to resolve any port conflicts that might arise.

On the command line, use the netstat command to see what ports are currently in use on the server 
where you plan to install Teaming:

Make sure that the port numbers that you specify during Teaming installation do not conflict with 
ports that are already in use on the server.

“HTTP/HTTPS Ports” on page 33

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Network Information, specify the hostname or fully qualified domain name to use for the Teaming 
server.

Linux: netstat -tan

Windows: netstat -a -n -p tcp
 Teaming 2.1 Installation Guide
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“Shutdown Port” on page 33
“AJP Port” on page 34

HTTP/HTTPS Ports

By default, standard Web servers such as Apache and Microsoft Internet Information Server (IIS) 
use port 80 for non-secure HTTP (Hypertext Transfer Protocol) connections and port 443 for secure 
HTTPS connections. HTTPS connections use SSL (Secure Sockets Layer) for added security. As a 
result, Web browsers default to port 80 when no port is specified in a non-secure HTTP URL and to 
port 443 when no port is specified in a secure HTTPS URL.

Tomcat defaults to port 8080 for non-secure HTTP connections and to port 8443 for secure HTTPS 
connections, so that it does not conflict with the standard Web server port numbers. If you configure 
Novell Teaming with the Tomcat default port numbers, users must include the appropriate port 
number when providing the Teaming site URL. Typically, users prefer not to do this. 

Unfortunately, the situation is not as simple as just configuring Teaming to use the default port 
numbers of 80 and 443. On Linux, non-root processes are not allowed access to port numbers lower 
than 1024 and you are counseled against running Teaming as root in Section 3.8.2, “Linux User ID 
for Teaming,” on page 41. Also on Linux and Windows, the default Tomcat installation expects 
ports 8080 and 8443.

For a Basic installation, you can use the default port numbers as presented by the Teaming 
Installation program:

HTTP port: 80
Secure HTTP port: 443
Listen port: 8080
Secure listen port: 8443

After you install Teaming on Linux, you need to complete the steps in “Setting Up Port Forwarding” 
on page 53 so that users are not required to include the port number in the Teaming URL.

If you want to use secure HTTPS connections for your Teaming site, you must obtain signed 
certificate files as described in “Preparing for Secure HTTP Connections” in “Site Security” in the 
Kablink Teaming 2.1 Administration Guide either before or after you install Teaming.

Shutdown Port

By default, Novell Teaming uses 8005 as its shutdown port. For an explanation of the shutdown 
port, see Tomcat - Shutdown Port (http://www.wellho.net/mouth/837_Tomcat-Shutdown-port.html). 

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Network Information, the default port numbers have been provided for you. You only need to 
specify different port numbers if you anticipate port conflicts with other software on the Teaming server. 
Resolving port conflicts is beyond the scope of this Teaming documentation.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Teaming to use as its shutdown port if the default 
of 8005 is already in use on the Teaming server.
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AJP Port

By default, Novell Teaming uses 8009 as its AJP port. For an explanation of the Apache JServ 
Protocol port, see The AJP Connector (http://tomcat.apache.org/tomcat-6.0-doc/config/ajp.html). 

IMPORTANT: If you are installing Teaming on Novell Open Enterprise Server 2, port 8009 is 
already in use, so you need to select a different port (for example 8010). 

3.5  Planning the Teaming Database
Novell Teaming database disk space requirements are relatively modest. Files that are imported into 
Teaming are saved in the Teaming file repository, as described in Section 3.2.4, “Teaming 
Installation Locations,” on page 30. 

The Teaming database is primarily used for storing:

Structural information about workspaces, folders, and entries (for example, their location in the 
workspace tree)
Identification information about workspaces, folders, and entries (for example, titles, 
descriptions, dates of creation/modification, and users associated with creation/modification)
User profile information (for example, full name, phone number, and e-mail address)

You or your database administrator must make the following decisions about the Teaming database:

Section 3.5.1, “Database Type,” on page 34
Section 3.5.2, “Database Setup Method,” on page 35
Section 3.5.3, “Database Location,” on page 35
Section 3.5.4, “Database Credentials,” on page 36
Section 3.5.5, “Database Encryption Algorithm,” on page 37

3.5.1  Database Type
By default, Novell Teaming uses open source MySQL as its database on Linux and on Windows. On 
Linux, Teaming also supports Oracle. On Windows, Teaming also supports Microsoft SQL Server 
and Oracle.

Make sure that a supported version of the database server, as listed in Section 2.1, “Teaming Server 
Requirements,” on page 19, is installed and running before you install Teaming.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Teaming to use as its AJP port if the default of 
8009 is already in use on the Teaming server.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Database Type, mark the type of database that you want to use with Teaming.
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3.5.2  Database Setup Method
If you plan to use a MySQL database or a Microsoft SQL database, the Novell Teaming Installation 
program can automatically set up the database for you. This is the easiest way to get started.

If you plan to use an Oracle database, you must have your database administrator set up the database 
for you. Instructions for your database administrator are provided in Section 13.4, “Creating an 
Oracle Database,” on page 106.

3.5.3  Database Location
When you have the Novell Teaming Installation program create the database for you, the database is 
created on the same server where you install the Teaming software. This is the preferable location 
for your Basic installation. The default database name is sitescape, a reference to the company 
that previously developed the Teaming software.

You can have your database administrator create a database on a remote server later, after you have 
successfully tested your Basic installation. See Chapter 13, “Creating the Teaming Database on a 
Remote Server,” on page 103.

If you need to have your database administrator create an Oracle database, you must decide before 
installation whether you want the database on the Teaming server or on a remote server. See 
Section 13.4, “Creating an Oracle Database,” on page 106.

Teaming knows where to find its database from the JDBC* (Java Database Connectivity) URL that 
you provide during installation. For a database that is local to the Teaming software, the default 
JDBC URL that provides localhost as the hostname of the Teaming server is appropriate. If the 
database is on a remote server, the JDBC URL must provide the hostname of the remote database 
server. 

The JDBC URL also includes the port number on which Teaming can communicate with the 
database server. The default port number depends on the database server you are using:

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Database Setup Method, mark whether you want the Teaming Installation program to 
automatically set up a MySQL or Microsoft SQL database, or you need your database administrator to 
manually set up an Oracle database before you install Teaming.

Database Server Default Linux Location Default Windows Location

MySQL /var/lib/mysql c:\Documents and Settings\All Users\
Application Data\MySQL\
MySQL Server version\Data

Microsoft SQL N/A c:\Program Files\Microsoft SQL Server\
MSSQL\Data

Oracle N/A N/A

Database Server Default Port Number

MySQL 3306
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Use this port number unless it is already in use by another process on the database server.

3.5.4  Database Credentials
When you have the Novell Teaming Installation program create the database for you, it defaults to 
the following administrator usernames for the database server:

For an Oracle database, your database administrator establishes the administrator username and 
password for the database server.

Check with your database administrator to see if the default administrator username is still in use for 
your database server, and obtain the administrator password for the database server before you run 
the Teaming Installation program.

3.5.5  Database Encryption Algorithm
Different encryption algorithms provide differing encryption strength. The supported algorithms for 
encrypting the Novell Teaming database password are listed below, in order from least strength to 
most strength.

MD5
SHA (default)
SHA-256

Microsoft SQL 1433

Oracle 1521

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under JDBC URL, specify the appropriate hostname for the database server (localhost or the 
hostname of a remote server) and the port number it will use to communicate with Teaming.

Database Default Administrative Username

MySQL root

IMPORTANT: The MySQL root username is not the same as the Linux root user on a 
Linux server.

Microsoft SQL sa (system administrator)

Oracle (no default)

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Database Credentials, specify the administrator username and password for the database server 
so that Teaming can access its database.

Database Server Default Port Number
 Teaming 2.1 Installation Guide
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3.6  Gathering Outbound E-Mail Information
Your Novell Teaming site can be configured to send outbound e-mail through an existing e-mail 
system. E-mail from the Teaming site is useful for the following activities:

Teaming users can subscribe to e-mail notifications, so that they automatically receive a 
message whenever a content of interest changes. For more information, see “Subscribing to a 
Folder or Entry” in “Getting Informed” in the Novell Teaming 2.1 User Guide.
From the Teaming site, users can send e-mail messages to individual users or to teams. For 
more information, see “Sending E-Mail From within Teaming” in “Connecting With Your Co-
Workers” in the Novell Teaming 2.1 User Guide.
If your e-mail client is iCal-enabled, appointments created in a Teaming Calendar folder can be 
sent to your e-mail client for posting in your e-mail client Calendar. For example, if you are 
using GroupWise, see “Accepting or Declining Internet Items” in “Calendar” in the GroupWise 
8 Windows Client User GuideGroupWise 8 Windows Client Help.

In order for your Teaming site to communicate with your e-mail system, you need to gather the 
following information about your e-mail system.

Section 3.6.1, “Outbound E-Mail Protocol,” on page 37
Section 3.6.2, “Outbound E-Mail Host,” on page 38
Section 3.6.3, “Outbound E-Mail Authentication,” on page 39
Section 3.6.4, “Outbound E-Mail Send Restriction,” on page 39

After installation, outbound e-mail can be disabled and enabled again on the Teaming site, as 
described in “Configuring E-Mail Integration” in “Site Setup” in the Kablink Teaming 2.1 
Administration Guide. However, you must configure outbound e-mail in the Teaming Installation 
program.

3.6.1  Outbound E-Mail Protocol
E-mail systems communicate using SMTP (Simple Mail Transfer Protocol). You need to determine 
whether the e-mail system that you want your Novell Teaming site to communicate with is using 
SMTP or SMTPS (secure SMTP).

For GroupWise, you can check how the Internet Agent is configured:

1 In ConsoleOne®, browse to and right-click the Internet Agent object, then click Properties.
2 Click GroupWise > Network Address.

In the SMTP field, if the SSL column displays Disabled, GroupWise is using SMTP. If the SSL 
column displays Enabled, GroupWise is using SMTPS.

3 Click Cancel to close the Network Address page.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Database Encryption Algorithm, mark the encryption algorithm you want to use for Teaming 
passwords.
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If the e-mail system requires SMTPS, see “Securing E-Mail Transfer” in “Site Security” in the 
Kablink Teaming 2.1 Administration Guide.

3.6.2  Outbound E-Mail Host
In order to send messages to your e-mail system, Novell Teaming needs to know the hostname of 
your SMTP mail server.

The default SMTP port of 25 is typically appropriate, unless the SMTP mail server requires port 465 
or 587 for SMTPS connections.

For GroupWise, this is the hostname of a server where the Internet Agent is running. GroupWise 
always uses port 25, even when SSL is enabled.

When the Teaming site sends e-mail notifications for scheduled events, the messages are time-
stamped according to the time zone you specify here during installation. This setting allows you to 
use a time zone for e-mail notifications that is different from the time zone where the server is 
located. The time zone list is grouped first by continent or region, optionally by country or state, and 
lastly by city. Some common selections for United States time zones are:

3.6.3  Outbound E-Mail Authentication
Many SMTP mail hosts require a valid e-mail address before they establish the SMTP connection. 
Some e-mail systems can construct a valid e-mail address if you specify only a valid username. 
Other e-mail systems require that you specify the full e-mail address for successful authentication.

Some e-mail systems also require a password. Some do not.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Outbound E-Mail Protocol, mark SMTP or SMTPS to match the e-mail system that you want 
Teaming to communicate with.

Time Zone Continent/City

Pacific Time America/Los Angeles

Mountain Time America/Denver

Central Time America/Chicago

Eastern Time America/New_York

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Outbound E-Mail Host, specify the name of the mail host, the SMTP port number it uses, and the 
time zone for the time stamp you want on scheduled event notifications.
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By default, the GroupWise Internet Agent does not require authentication in order to receive 
inbound messages. However, the /forceinboundauth startup switch is available for use in the Internet 
Agent startup file (gwia.cfg) to configure the Internet Agent to refuse SMTP connections where a 
valid e-mail username and password are not provided. The Internet Agent can accept just the 
username or the full e-mail address.

3.6.4  Outbound E-Mail Send Restriction
By default, the Novell Teaming site allows Teaming users to send messages to all Teaming users 
using the All Users group on the Teaming site. On a very large Teaming site, this generates a very 
large number of e-mail messages. If desired, you can prevent messages from being sent to the All 
Users group.

3.7  Enabling Inbound E-Mail
You can configure your Novell Teaming site so that users can post comments by e-mailing them to 
the folder where they want to post the comment. In order to receive e-mail postings, folders must be 
properly configured, as described in “Enabling Folders to Receive Entries through E-Mail” in 
“Managing Folders” in the Novell Teaming 2.1 User Guide. Also, users must know the e-mail 
address of the folder where they want to post their comment.

Section 3.7.1, “Internal Mail Host for Inbound E-Mail,” on page 40
Section 3.7.2, “Inbound E-Mail Port Number,” on page 40
Section 3.7.3, “Inbound E-Mail IP Address,” on page 40
Section 3.7.4, “Inbound E-Mail Security,” on page 41

After installation, inbound e-mail can be disabled and enabled again on the Teaming site, as 
described in “Disabling/Enabling Inbound E-Mail Postings” in “Site Setup” in the Kablink Teaming 
2.1 Administration Guide. However, you must configure inbound e-mail in the Teaming Installation 
program.

3.7.1  Internal Mail Host for Inbound E-Mail
Inbound e-mail is disabled by default. When you enable it, the Novell Teaming site starts an internal 
SMTP mail host to receive incoming messages and post them to the folders associated with the e-
mail addresses to which the messages are addressed. By default, the internal SMTP mail host uses 
port 2525, so that it does not conflict with another mail host that might be running on the Teaming 
server. 

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Outbound E-Mail Authentication, indicate whether or not authentication is required for the Teaming 
site to communicate with your e-mail system, and if so, specify the username or e-mail address, and if 
necessary, the password for the e-mail account.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Allow Sending E-Mail to All Users, mark whether or not you want users to be able to send 
messages to the All Users group.
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3.7.2  Inbound E-Mail Port Number
Selecting the port number for the Novell Teaming internal SMTP mail host presents the same issue 
that needs to be dealt with for the HTTP port numbers, as described in “HTTP/HTTPS Ports” on 
page 33. You might want to configure the Teaming internal SMTP mail host to use the standard 
SMTP port of 25. How you handle the issue depends on whether you are installing on Linux or on 
Windows.

3.7.3  Inbound E-Mail IP Address
If you want to install Novell Teaming on a server where an SMTP mail host is already running, you 
can do so if the server has multiple IP addresses. The existing SMTP mail host can use port 25 on 
one IP address and Teaming can use port 25 on another IP address. During installation, you only 
need to specify an IP address if the server has multiple IP addresses and you want Teaming to bind 
to a specific IP address rather than all of them.

3.7.4  Inbound E-Mail Security
You can choose whether the Novell Teaming internal mail host uses TLS (Transport Layer Security) 
when it communicates with other SMTP mail hosts. In order for TLS to function properly, you must 
have a certificate on the Teaming server, as described in “Securing E-Mail Transfer” in “Site 
Security” in the Kablink Teaming 2.1 Administration Guide. When an SMTP mail host queries the 
Teaming mail host, the Teaming mail host communicates its ability or inability to handle TLS. The 
other SMTP mail host then communicates appropriately, taking into account how the Teaming 
internal mail host is configured. The default is to use TLS, because this provides more secure 
communication between mail hosts.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, mark whether or not you want users to be able to post to the 
Teaming site from their e-mail clients.

Linux: Keep the default port number (2525) in the Teaming Installation program, then complete the 
steps in Section 4.1.4, “Setting Up Port Forwarding,” on page 53 so that requests incoming 
on port 25 are forwarded to port 2525. 

Windows: Specify port 25 for incoming e-mail in the Teaming Installation program.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, specify the port number for the Teaming internal SMTP host to 
listen on.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, specify the IP address for the Teaming internal SMTP host to listen 
on, if you are installing Teaming on a server with multiple IP addresses and you want Teaming to bind to 
just one of them.
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You can install Teaming with Announce TLS selected, and then set up the certificate afterwards. 
However, if you select Announce TLS, inbound e-mail does not work until the certificate is available 
on the Teaming server.

3.8  Planning Site Security
Section 3.8.1, “Teaming Site Administrator Password,” on page 41
Section 3.8.2, “Linux User ID for Teaming,” on page 41

3.8.1  Teaming Site Administrator Password
When you first log in to the Novell Teaming site, you use admin as the Teaming administrator 
username and admin as the password. You should immediately change the password to one of your 
own choosing.

3.8.2  Linux User ID for Teaming
For optimum security, Novell Teaming should not run as the Linux root user. For example, if an 
intruder manages to assume the identity of the Teaming program, the intruder gains all the privileges 
of the commandeered process. If the process is running with root user privileges, the intruder has 
root access to your system. If the process is running as a user with minimal privileges, the intruder 
has only restricted access to your system. Therefore, your system is more secure if the Teaming 
program does not run as root. For example, you might want to create a user named teamingadmin 
for the Teaming program to run as. Linux users require a full name and a password.

In addition to creating a Linux user for the Teaming program to run as, you can also create a Linux 
group for that user to belong to. This enables the Teaming program to create directories and files 
with consistent ownership and permissions. For example, you might want to create a group named 
teamingadmin for the teamingadmin user to belong to. Groups do not require passwords.

As an alternative to creating a custom Linux username and group for Teaming, you can use the 
existing wwwrun username and the www group. This account is typically used to start Web server 
processes.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, mark whether or not you want the Teaming server to announce that 
it can use TLS.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Teaming Administrator Credentials, specify the password that you want to use whenever you log 
in as the Teaming site administrator.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Linux Username and Group, specify the non-root Linux username and group name to use for 
running the Teaming program. If you are creating a new Linux user, specify its full name and password.
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IMPORTANT: The non-root Linux username and group must exist before you start the Teaming 
Installation program. Instructions for creating the username and group are provided in Section 4.1.1, 
“Performing Pre-Installation Tasks on Linux,” on page 49.

3.9  Gathering Directory Services Information
Unless you are planning a very small Novell Teaming site, the most efficient way to create Teaming 
users is to synchronize initial user information from your network directory service (Novell 
eDirectory, Microsoft Active Directory, or other LDAP directory service) after you have installed 
the Teaming software. Over time, you can continue to synchronize user information from the LDAP 
directory to your Teaming site.

Section 3.9.1, “LDAP Directory Service,” on page 42
Section 3.9.2, “LDAP Connections,” on page 42
Section 3.9.3, “LDAP Synchronization Options,” on page 45

IMPORTANT: Teaming performs one-way synchronization from the LDAP directory to your 
Teaming site. If you change user information on the Teaming site, the changes are not synchronized 
back to your LDAP directory.

3.9.1  LDAP Directory Service
You can synchronize initial Novell Teaming user information from any LDAP directory. This guide 
provides instructions for synchronizing user information from eDirectory and Active Directory. If 
you are using another LDAP directory, the instructions provide guidelines for the tasks you need to 
perform.

3.9.2  LDAP Connections
You can configure one or more LDAP connections. Each connection requires the following 
configuration information:

“LDAP Server” on page 43
“User Attribute” on page 43
“User and Group Object Locations” on page 44

LDAP Server

In order to synchronize initial user information, Novell Teaming needs to access an LDAP server 
where your directory service is running. You need to provide the hostname of the server using a 
URL of the following format:

ldap://hostname

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under LDAP Directory Service, mark the LDAP directory service from which you want to synchronize 
Teaming user information.
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If the LDAP server requires a secure SSL connection, use the following format:

ldaps://hostname

If the LDAP server is configured with a default port number (389 for non-secure connections or 636 
for secure SSL connections), you do not need to include the port number in the URL. If the LDAP 
server uses a different port number, use the following format for the LDAP URL:

ldap://hostname:port_number
ldaps://hostname:port_number

In addition, Teaming needs the username and password of a user on the LDAP server who has 
sufficient rights to access the user information stored there. You need to provide the username, along 
with its context in your LDAP directory tree, in the format expected by your directory service.

If the LDAP server requires a secure SSL connection, additional setup is required. You must 
complete the steps in “Securing LDAP Synchronization” in “Site Security” in the Kablink Teaming 
2.1 Administration Guide to import the root certificate for your LDAP directory into the Java 
keystore on the Teaming server before you configure Teaming for LDAP synchronization.

User Attribute

LDAP directories differ in the LDAP attribute used to identify a User object. eDirectory and Active 
Directory both use the cn (common name) attribute. Other LDAP directories might use the uid 
(unique ID) attribute. Novell Teaming needs to know which attribute to look for in order to find User 
objects.

Teaming calls the User object attribute screenName, so when you configure LDAP synchronization, 
you map screenName to either cn or uid.

As needed, other LDAP attributes can be used for logging in to the Teaming site, as long as the 
attribute is unique for each User object. For example, the mail LDAP attribute on User objects 
could be used to enable Teaming users to log in to the Teaming site using their e-mail addresses. 

Directory Service Format for Username

eDirectory cn=username,ou=organizational_unit,o=organization

Active Directory cn=username,ou=organizational_unit,dc=domain_component

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under LDAP Server, specify the LDAP URL of the server, a fully qualified username with sufficient rights 
to read the user information, and the password for that user.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under LDAP User Attribute, mark cn or uid, based on the convention used by your LDAP directory 
service for User objects. Ensure that users have a value for the attribute that you mark.
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NOTE: Because the login name becomes part of the user’s workspace URL, the at sign (@) in the e-
mail address is replaced with an underscore (_) in the workspace URL because the at sign is not a 
valid character in a URL. 

User and Group Object Locations

Novell Teaming can find and synchronize initial user information from User objects located in one 
or more containers in the LDAP directory tree. A container under which User objects are located is 
called a base DN (distinguished name). The format you use to specify a base DN depends on your 
directory service.

To identify potential Teaming users, Teaming by default filters on the following LDAP directory 
object attributes:

Person

orgPerson

inetOrgPerson

If you want to create Teaming groups based on information in your LDAP directory, Teaming filters 
on the following LDAP directory object attributes:

group

groupOfNames

groupOfUniqueNames

You can add attributes to the user or group filter list if necessary. You can use the following 
operators in the filter:

| OR (the default)
& AND
! NOT

You can choose whether you want Teaming to search for users (and optionally, groups) in containers 
underneath the base DN (that is, in subtrees).

Directory Service Format for the User Container

eDirectory ou=organizational_unit,o=organization

Active Directory ou=organizational_unit,dc=domain_component

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under LDAP User Context, specify a base DN, along with object attributes if any, and mark whether you 
want subtrees searched for Teaming users.

Under LDAP Group Context, specify a base DN, along with object attributes if any, and mark whether you 
want subtrees searched for Teaming groups.
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You might find it convenient to create a group that consists of all the users that you want to set up in 
Teaming, regardless of where they are located in your LDAP directory. After you create the group, 
you can use the following filter to search for User objects that have the specified group membership 
attribute:

(groupMembership=cn=group_name,ou=organizational_unit,o=organization)

IMPORTANT: Be sure to include the parentheses in your filter.

3.9.3  LDAP Synchronization Options
The following synchronization options apply to all LDAP configurations within the same Novell 
Teaming zone:

“Synchronization Schedule” on page 45
“User Synchronization Options” on page 46
“Group Synchronization Options” on page 47

NOTE: Because the synchronization options apply to all LDAP configurations within the same 
zone, you cannot have customized synchronization settings for each LDAP configuration. A Novell 
Teaming site can have multiple zones. For more information about zones, see “Setting Up Zones 
(Virtual Teaming Sites)” in “Site Setup” in the Kablink Teaming 2.1 Administration Guide. 

Synchronization Schedule

When you enable LDAP synchronization, you can set up a schedule for when it is convenient for 
synchronization to occur. In planning the schedule, take into account how often your LDAP 
directory user (and, optionally, group) information changes and the server resources required to 
perform the synchronization for the number of users (and, optionally, groups) that you have.

You can choose to have LDAP synchronization performed every day (for example, on Saturday), or 
you can select specific days of the week when you want it performed (for example, on Monday, 
Wednesday, and Friday). You can choose to have it performed once a day at a specified time (for 
example, at 2:00 a.m.), or you can set a time interval, so that it is performed multiple times each day 
(for example, every four hours). The smallest time interval you can set is .25 hours (every 15 
minutes).

User Synchronization Options

The following options are available for enabling and configuring user synchronization from your 
LDAP directory to your Novell Teaming site:

Synchronize User Profiles: Select this option to synchronize the following user information 
whenever the LDAP directory information changes after initial Teaming site setup:

First name

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Synchronization Schedule, record the schedule for when you want LDAP synchronization to take 
place.
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Last name
Phone number
E-mail address
Description

Register LDAP User Profiles Automatically: Select this option to automatically add LDAP 
users to the Teaming site. However, workspaces are not created until users log into the Teaming 
site for the first time.
Delete Users That Are Not in LDAP: Select this option to delete users that exist on the 
Teaming site but do not exist in your LDAP directory. Use this option under the following 
conditions:

You have deleted users from your LDAP directory and you want the LDAP 
synchronization process to delete them from Teaming as well.
In addition to the users synchronized from LDAP, you create some Teaming users 
manually, as described in Section 5.2, “Creating a User,” on page 64, and you want the 
LDAP synchronization process to delete the manually created users.

When Deleting Users, Delete Associated User Workspaces and Content: Select this option 
to remove obsolete information along with the user accounts.
Time Zone for New Users Select this option to set the time zone for user accounts that are 
synchronized from the LDAP directory into your Teaming site. The time zone list is grouped 
first by continent or region, optionally by country or state, and lastly by city. Some common 
selections for United States time zones are:

Group Synchronization Options

The following options are available for enabling and configuring user and group synchronization 
from your LDAP directory to your Novell Teaming site:

Synchronize Group Profiles: Select this option to synchronize group information, such as the 
group description, to the Teaming site whenever this information changes in LDAP.
Register LDAP Group Profiles Automatically: Select this option to automatically add 
LDAP groups to the Teaming site.

Time Zone Continent/City

Pacific Time America/Los Angeles

Mountain Time America/Denver

Central Time America/Chicago

Eastern Time America/New_York

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under LDAP User Options, mark the synchronization options you want to use.
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Synchronize Group Membership: Select this option so that the Teaming group includes the 
same users (and possibly groups) as the group in your LDAP directory. If you do not select this 
option, when you make changes to group membership in the LDAP directory, the changes are 
not reflected on your Teaming site. 
Delete Local Groups That Are Not in LDAP: Select this option to delete groups that exist on 
the Teaming site but do not exist in your LDAP directory. Use this option under the following 
conditions:

You have deleted groups from your LDAP directory and you want the LDAP 
synchronization process to delete them from Teaming as well.
In addition to the groups synchronized from LDAP, you create some Teaming groups 
manually, as described in “Creating Groups of Users” in “Site Setup”, in the Kablink 
Teaming 2.1 Administration Guide, and you want the LDAP synchronization process to 
delete the manually created groups.

3.10  Accommodating Multiple Languages
The Novell Teaming Installation program runs in English only. When you install the Teaming 
software, you can choose to have the primary language of the Teaming site to be any of the 
following languages:

Chinese-Simplified
Chinese Traditional
Danish
Dutch
English
French
German
Hungarian
Italian
Japanese
Polish
Portuguese
Russian
Spanish
Swedish

Some languages have an additional distinction by locale (the country where the language is spoken).

The language you select during installation establishes the language of the global text that displays 
in locations where all Teaming users see it, such as in the workspace tree above the Workspace 
toolbar:

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under LDAP Group Options, mark the synchronization options you want to use.
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The language you select also establishes the default interface language and locale for creating new 
workspaces.

Additional language customization can be done after installation, as described in “Managing a 
Multiple-Language Teaming Site” in “Site Setup” in the Kablink Teaming 2.1 Administration Guide

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Default Locale, mark the default language and specify the default country for your Teaming site.
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4Setting Up a Basic Teaming Site

Follow the setup instructions for the platform where you are installing the Novell® Teaming 
software:

Section 4.1, “Linux: Setting Up a Basic Teaming Site,” on page 49
Section 4.2, “Windows: Setting Up a Basic Teaming Site,” on page 57

4.1  Linux: Setting Up a Basic Teaming Site
You should already have reviewed Chapter 3, “Planning a Basic Teaming Installation,” on page 27 
and filled out the Basic Teaming Installation Summary Sheet. The following sections step you 
through the process of installing and starting Novell Teaming on Linux.

Section 4.1.1, “Performing Pre-Installation Tasks on Linux,” on page 49
Section 4.1.2, “Running the Linux Teaming Installation Program,” on page 50
Section 4.1.3, “Configuring Teaming to Start Automatically on Reboot,” on page 53
Section 4.1.4, “Setting Up Port Forwarding,” on page 53
Section 4.1.5, “Starting Teaming on Linux,” on page 55
Section 4.1.6, “Checking the Status of the Teaming Server,” on page 56
Section 4.1.7, “Restarting Teaming,” on page 56
Section 4.1.8, “Stopping Teaming,” on page 56
Section 4.1.9, “Uninstalling Teaming,” on page 56

4.1.1  Performing Pre-Installation Tasks on Linux
1 Make sure that the Linux server where you plan to install Teaming meets the system 

requirements listed in Section 2.1, “Teaming Server Requirements,” on page 19.
2 In a terminal window, become root by entering su - and the root password.
3 Set the Linux open file limit to meet the needs of the Teaming software:

3a Open the /etc/security/limits.conf file in an ASCII text editor.
3b Add the following lines to the bottom of the list, following the format of the example 

lines:
* hard nofile 65535
* soft nofile 4096

3c Save the file, then exit the text editor.
4 Perform the following conditional tasks if needed:

“Stopping and Disabling an Existing Web Server” on page 50
“Creating a Teaming User and Group” on page 50
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Stopping and Disabling an Existing Web Server

For example, to stop the Apache Web server and its associated instance of Tomcat:

1 Enter the following commands to stop Apache and Tomcat:
/etc/init.d/tomcat5 stop
/etc/init.d/apache2 stop

2 Enter the following commands to make sure that Apache and Tomcat do not start again when 
you reboot the server:
chkconfig --del apache2
chkconfig --del tomcat5

Creating a Teaming User and Group

If the user and group that you want to use for Teaming, as described in Section 3.8.2, “Linux User 
ID for Teaming,” on page 41 do not exist yet, create them. It is easier if you create the group first.

1 Create the Linux group that you want to own the Teaming software and data store directories:
1a In YaST, click Security and Users > User Management to display the User and Group 

Administration page.
1b Click Groups, then click Add.
1c Specify the group name, then click Accept or OK.

The group does not need a password.
2 Create the Linux user that you want Teaming to run as:

2a Click Users, then click Add.
2b On the User Data tab, specify the user’s full name, username, and password, then select 

Disable User Login.
Like any Linux system user, the Teaming Linux user does not need to manually log in. 
The Teaming Linux user does not need a password, either, but YaST requires you to 
provide one.

2c Click the Details tab.
2d In the Login Shell drop-down list, select /bin/false, because this user does not need to 

manually log in.
2e In the Default Group drop-down list, select the Linux group that you created in Step 1.
2f In the Groups list, select the Linux group that you created in Step 1.

2g Click Accept or OK.
3 Exit YaST.

4.1.2  Running the Linux Teaming Installation Program
When you run the Novell Teaming Installation program for the first time, you typically want to use 
the GUI interface. However, if you are installing Teaming on a server where the X Window System* 
is not available, a text-based Installation program is also available. After you are familiar with the 
Teaming installation process, you can use a silent installation to automate the process.

“Using the GUI Installation Program” on page 51
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“Using the Text-Based Installation Program” on page 52
“Performing a Silent Installation” on page 53

Using the GUI Installation Program

1 In a terminal window, enter su - to become the root user, then enter the root password.
You need root permissions in order to install the Teaming software, but you should not run the 
Teaming software as root.

2 Change to the directory where you downloaded and extracted the Teaming software.
3 Make sure that you have a license-key.xml file in the same directory with the Teaming 

Installation program.
more license-key.xml

The Teaming Installation program does not start without a license file in the same directory, 
and the license file has a different name when you download it.
For more information about licensing, see Chapter 6, “Updating Your Teaming License,” on 
page 69.

4 Enter the following command to start the Teaming Installation program:
./installer-teaming.linux

5 Accept the License Agreement, then click Next.

6 Click Next to accept the default of New installation.

7 Click Next to accept the default of Basic.
8 Use the information that you have gathered on the Basic Teaming Installation Summary Sheet 

to provide the information that the Teaming Installation program prompts you for:

Installation Locations
Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Teaming
User ID for Novell Teaming
Network Information
Database Selection
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Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm

Java JDK Location
Outbound E-Mail Configuration

Protocol
Host, Port, and Time Zone
Username, Password, and Authentication
Allow Sending E-Mail to All Users

Inbound E-Mail Configuration
The Installation program stores the information it gathers in the installer.xml file in the 
same directory where you started the Installation program.

9 After you have provided all the requested information, click Install to begin the Teaming 
installation.

10 When the installation is completed, click Finish to exit the Teaming Installation program.
Information about the installation process is written to the installer.log file in the same 
directory where you ran the Installation program. If a problem arises during the installation, the 
installer.log file provides information that can help you resolve the problem.

11 Continue with Section 4.1.3, “Configuring Teaming to Start Automatically on Reboot,” on 
page 53.

Using the Text-Based Installation Program

If you try to start the GUI Teaming Installation program in an environment where the X Windows 
System is not running, the text-based Teaming Installation program starts instead. 

If you want to use the text-based Installation program in an environment where it is starting with a 
GUI by default, use the following command in the directory where the Installation program is 
located:

./installer-teaming.linux --text
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IMPORTANT: The text-based Teaming Installation program must be run in the same directory 
where the Teaming license file is located. If the license file is not in the same directory, the text-
based Installation program cannot find it.

The text-based Installation program gathers the same configuration information as the GUI 
Installation program does. This information is stored in the installer.xml file in the directory 
where you run the Installation program.

The Installation program does not write the information it gathers into the installer.xml file until 
you exit the Installation program, and you cannot back up when using the text-based Installation 
program. Therefore, when you use the text-based Installation program, you should plan you 
installation carefully in advance, using the Basic Teaming Installation Summary Sheet or the 
Advanced Teaming Installation Summary Sheet. If you make a mistake during the installation, 
continue to the end of the installation process and exit the Installation program normally, so that all 
information is saved. Then run the text-based Installation program again. Your previous information 
is supplied as defaults and you can change the information as needed.

Performing a Silent Installation

If your Novell Teaming system expands beyond one server, you might need to repeatedly install the 
same Teaming components. A silent installation makes this an easy process. Edit an existing 
installer.xml file so that it has the hostname of the server where you want to perform the silent 
installation and copy it to that server. In the directory where the Installation program is located. use 
the appropriate command to run the Teaming installation program, depending on the action that you 
want the silent installation to perform:

./installer-teaming.linux --silent --install

./installer-teaming.linux --silent --upgrade

./installer-teaming.linux --silent --reconfigure

The Installation program obtains all the information it needs from the installer.xml file and 
completes the installation without user interaction.

4.1.3  Configuring Teaming to Start Automatically on Reboot
You can configure Novell Teaming to start automatically each time you reboot the Linux server.

1 As the Linux root user, enter the following command:
chkconfig --add teaming

2 To verify that automatic startup is turned on, enter the following command:
chkconfig teaming

4.1.4  Setting Up Port Forwarding
In order to make Novell Teaming available on the default HTTP/HTTPS ports of 80 and 443, you 
must set up port forwarding in order to forward the browser default ports (80 and 443) to the 
Teaming server ports (8080 and 8443). In addition, you must set up port forwarding if you want to 
forward the default SMTP mail host port (25) to the default Teaming internal mail host port (2525).
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You can set up port forwarding in one of two ways, depending on whether or not you are using the 
Teaming server as a firewall.

“Using the SuSEfirewall2 File” on page 54
“Using iptables Commands” on page 54

Using the SuSEfirewall2 File

To enable port forwarding on a SUSE Linux server that leverages SuSEfirewall2:

1 As the Linux root user, open the following file:
/etc/sysconfig/SuSEfirewall2

2 Find the following line:
FW_REDIRECT=""

3 Between the quotation marks, copy and insert the following string:
0/0,ip_address,tcp,80,8080 0/0,ip_address,tcp,443,8443 

0/0,ip_address,tcp,25,2525

4 Replace ip_address with the IP address of the Teaming server.
5 Save the SuSEfirewall2 file, then exit the text editor.
6 Use the following command to restart the firewall:

/sbin/SuSEfirewall2 start

7 Use the following command to verify that the default browser ports (80 and 443) have been 
forwarded to the Teaming server ports (8080 and 8443) and that the default SMTP mail host 
port (25) has been forwarded to the Teaming internal mail host:
iptables-save | grep REDIRECT

Now, users do not need to include a port number in the Teaming site URL.

Using iptables Commands

To leverage iptables commands to enable port forwarding on any type of Linux server:

1 As the Linux root user, change to the /etc/init.d directory.
2 In a text editor, create a new file for a set of iptables commands, for example:

gedit teaming-iptables

3 Copy and paste the following lines into the teaming-iptables file:
iptables -t nat -A OUTPUT -d localhost -p tcp --dport 80 

-j REDIRECT --to-ports 8080

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 80 
-j REDIRECT --to-ports 8080

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 80 
-j REDIRECT --to-ports 8080

iptables -t nat -A OUTPUT -d localhost -p tcp --dport 443 
-j REDIRECT --to-ports 8443

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 443 
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-j REDIRECT --to-ports 8443

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 443 
-j REDIRECT --to-ports 8443

iptables -t nat -A OUTPUT -d localhost -p tcp --dport 25 
-j REDIRECT --to-ports 2525

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 25 
-j REDIRECT --to-ports 2525

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 25 
-j REDIRECT --to-ports 2525

In this example, the lines are wrapped for readability. When you paste them into the text editor, 
if the lines are still wrapped, remove the hard returns from the middle of the commands, so that 
you have six iptables commands, each on its own line.

4 Replace hostname with the hostname of the Teaming server.
5 Save the teaming-iptables file, then exit the text editor.
6 Use the following command to make the file executable:

chmod +x teaming-iptables

7 Restart the firewall to put the iptables commands into effect:
7a Click Security and Users > Firewall.
7b Click Stop Firewall Now, click Start Firewall Now, then click Next > Accept.
7c Exit YaST, then return to the terminal window where you are logged in as root.

8 Use the following command to verify that the default browser ports (80 and 443) have been 
forwarded to the Teaming server ports (8080 and 8443) and that the default SMTP mail host 
port (25) has been forwarded to the Teaming internal mail host:
iptables-save | grep REDIRECT

Now, users do not need to include a port number in the Teaming site URL.

4.1.5  Starting Teaming on Linux
The Novell Teaming Installation program created a teaming startup script in the /etc/init.d 
directory.

1 In a terminal window, become root by entering su - and the root password.
2 Enter the following command to start Teaming:

/etc/init.d/teaming start

You must execute the teaming script as root, but the script runs Teaming as the user you 
selected in Section 3.8.2, “Linux User ID for Teaming,” on page 41 and specified during 
installation.
You should see output similar to the following example:
Using CATALINA_BASE: /opt/teaming/apache-tomcat-6.0.18
Using CATALINA_HOME: /opt/teaming/apache-tomcat-6.0.18
Using CATALINA_TEMPDIR: /opt/teaming/apache-tomcat-6.0.1/temp
Using JRE_HOME: /use/java/jdk1.5.0_17/jre
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3 To make sure that Teaming is ready for work:
3a Change to the following directory:

/opt/novell/teaming/apache-tomcat-version/logs

where version is the version number of Tomcat that was installed along with Teaming (for 
example, 6.0.18)

3b Enter the following command to display the end of the Tomcat log:
tail --f catalina.out

At the end of the log file listing, you should see:
INFO: Server startup in nnnn ms 

4 Press Ctrl+C when you are finished viewing the end of the catalina.out file.

4.1.6  Checking the Status of the Teaming Server
You can see if Novell Teaming is running by checking for its process ID (PID).

1 In a terminal window, enter the following command:
ps -eaf | grep teaming

You should see the Teaming PID number, along with a listing of configuration settings.

4.1.7  Restarting Teaming
You need to restart Novell Teaming whenever you use the Teaming Installation program to make 
configuration changes, as described in Chapter 10, “Performing an Advanced Teaming Installation,” 
on page 93.

1 As root in a terminal window, enter the following command:
/etc/init.d/teaming restart

You should see the same output as when you originally started Teaming.

4.1.8  Stopping Teaming
1 As root in a terminal window, enter the following command:

/etc/init.d/teaming stop

You should see the same output as when you started Teaming.
2 To verify that Teaming has stopped, check for its PID number:

ps -eaf | grep teaming

The Teaming PID number, along with a listing of configuration settings, should no longer be 
displayed.

4.1.9  Uninstalling Teaming
If you move the Novell Teaming site to a different server, you can delete the Teaming files from the 
original server to reclaim disk space. The default Teaming file locations are: 
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For a complete list of your Teaming files, check the installer.xml file in the directory where you 
originally ran the Teaming Installation program.

4.2  Windows: Setting Up a Basic Teaming Site
You should already have reviewed Chapter 3, “Planning a Basic Teaming Installation,” on page 27 
and filled out the Basic Teaming Installation Summary Sheet. The following sections step you 
through the process of installing and starting Novell Teaming on Windows.

Section 4.2.1, “Performing Pre-Installation Tasks on Windows,” on page 57
Section 4.2.2, “Running the Windows Teaming Installation Program,” on page 58
Section 4.2.3, “Running Teaming as a Windows Service,” on page 59
Section 4.2.4, “Running Teaming as a Windows Application,” on page 61
Section 4.2.5, “Uninstalling Teaming,” on page 61

4.2.1  Performing Pre-Installation Tasks on Windows
“Verifying System Requirements” on page 57
“Stopping an Existing Web Server” on page 57
“Setting Environment Variables” on page 58

Verifying System Requirements

Make sure that the Windows server where you plan to install Novell Teaming meets the system 
requirements listed in Section 2.1, “Teaming Server Requirements,” on page 19.

Stopping an Existing Web Server

If a Web server is currently running on the Teaming server, stop it, and preferably disable it.

For example, to stop and disable the Internet Information Services (IIS) Web server:

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click World Wide Web Publishing Service, then click Properties.
3 In the Startup type drop-down list, select Disabled.
4 Click Stop, then click OK.

Teaming Software /opt/novell/teaming

Teaming File Repository 
and Lucene Index

/var/opt/novell/teaming

MySQL Database /var/lib/mysql
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Setting Environment Variables

Make sure that the JAVA_HOME environment variable is set to the path where you installed the 
Java JDK and that the Windows PATH environment variable includes the path to your database 
server.

1 Right-click My Computer, then click Properties.
2 On the Advanced tab, click Environment Variables.
3 Set the JAVA_HOME environment variable:

3a In the System variables box, click New.
3b In the Variable name field, specify JAVA_HOME.
3c In the Variable value field, specify the path where you installed the Java JDK.
3d Click OK to add the JAVA_HOME environment variable to the list of system variables, 

then click OK again to save the setting and return to the Advanced tab.
4 Check the PATH environment variable:

4a On the Advanced tab, click Environment Variables.
4b In the System variables list, locate the PATH environment variable.
4c If the path includes your database server software directory, click Cancel.

or
If the path does not include your database server software directory, add the directory, then 
click OK. 

4.2.2  Running the Windows Teaming Installation Program
1 Log in to the Windows server as a user with Administrator rights.
2 In Windows Explorer, browse to the directory where you downloaded and extracted the Novell 

Teaming software.
3 Make sure that there is a license-key.xml file in the directory.

The Teaming Installation program does not start without a license file, and it has a different 
name when you download it.
For more information about licensing, see Chapter 6, “Updating Your Teaming License,” on 
page 69.

4 Double-click the installer-teaming.exe file to start the Teaming Installation program.
5 Accept the License Agreement, then click Next.

6 Click Next to accept the default of New installation.
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7 Click Next to accept the default of Basic.
8 Use the information that you have gathered on the Basic Teaming Installation Summary Sheet 

to provide the information that the Teaming Installation program prompts you for:

Installation Locations
Default Locale for Novell Teaming
Network Information
Database Selection

Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm

Java JDK Location
Outbound E-Mail Configuration

Protocol
Host, Port, and Time Zone
Username, Password, and Authentication
Allow Sending E-Mail to All Users

Inbound E-Mail Configuration
The Installation program stores the information it gathers in the installer.xml file in the 
same directory where you started the Installation program.

9 After you have provided all the requested information, click Install to begin the Teaming 
installation.

10 When the installation is completed, click Finish to exit the Teaming Installation program.
Information about the installation process is written to the installer.log file in the same 
directory where you ran the Installation program. If a problem arises during the installation, the 
installer.log file provides information that can help you resolve the problem.

11 Continue with one of the following sections, depending on how you want to run the Teaming 
software:

Section 4.2.3, “Running Teaming as a Windows Service,” on page 59
Section 4.2.4, “Running Teaming as a Windows Application,” on page 61

4.2.3  Running Teaming as a Windows Service
“Configuring Teaming as a Windows Service” on page 60
“Starting Teaming as a Windows Service” on page 60
“Configuring the Teaming Service to Start Automatically on Reboot” on page 60
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“Restarting the Teaming Service” on page 60
“Stopping the Teaming Service” on page 60

Configuring Teaming as a Windows Service

The Novell Teaming Installation program created a service.bat file for configuring Teaming to 
run as a Windows service.

1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat-version\bin

where version is the version number of Tomcat that was installed along with Teaming (for 
example, 6.0.18).

2 Use the following command to configure Teaming as a Windows service:
service.bat install Teaming

This creates a service named Apache Tomcat Teaming.

Starting Teaming as a Windows Service

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Start.

Configuring the Teaming Service to Start Automatically on Reboot

When you run Novell Teaming as a Windows service, you can configure Teaming to start 
automatically each time you reboot the Windows server.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Properties.
3 In the Startup type drop-down list, select Automatic, then click OK.

Restarting the Teaming Service

You need to restart Novell Teaming whenever you use the Teaming Installation program to make 
configuration changes, as described in Chapter 10, “Performing an Advanced Teaming Installation,” 
on page 93.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Restart.
3 Close the Services window.

Stopping the Teaming Service

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Stop.
3 Close the Services window.
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4.2.4  Running Teaming as a Windows Application
“Starting Teaming as an Application” on page 61
“Stopping Teaming as an Application” on page 61

Starting Teaming as an Application

The Novell Teaming Installation program created a startup.bat file for starting Teaming.

1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat-version\bin

where version is the version number of Tomcat that was installed along with Teaming (for 
example, 6.0.18).

2 Run the startup.bat file to start Teaming as an application.

Stopping Teaming as an Application

1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat-version\bin

where version is the version number of Tomcat that was installed along with Teaming (for 
example, 6.0.18).

2 Run the shutdown.bat file to stop the Teaming application.

4.2.5  Uninstalling Teaming
If you move the Novell Teaming site to a different server, you can delete the Teaming files from the 
original server to reclaim disk space. The default Teaming file locations are: 

For a complete list of your Teaming files, check the installer.xml file in the directory where you 
originally ran the Teaming Installation program.

Teaming Software c:\Program Files\Novell\Teaming

Teaming File Repository 
and Lucene Index

c:\Novell\Teaming

MS SQL Database c:\Program Files\Microsoft SQL Server\MSSQL\Data
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5Adding Users to Your Teaming 
Site

After you have installed the Novell® Teaming software and made sure that Teaming starts 
successfully, you are ready to access your Teaming site from your Web browser and add users.

Section 5.1, “Accessing Your Basic Teaming Site as the Site Administrator,” on page 63
Section 5.2, “Creating a User,” on page 64
Section 5.3, “Adding Teaming Users from Your LDAP Directory,” on page 65

5.1  Accessing Your Basic Teaming Site as the 
Site Administrator

1 In your Web browser, specify one of the following URLs, depending on whether or not you are 
using a secure SSL connection:
http://teaming_server
https://teaming_server

where teaming_server is the DNS hostname or fully qualified domain name of the Teaming 
server. If you have configured the HTTP ports correctly, you do not need to include the port 
number in the Teaming URL.

2 Log in using admin as the login name and admin as the password.
The Teaming administrator’s personal workspace displays.
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3 Change the default administrator password to a secure password.
3a On the Workspace toolbar, click Modify Profile.
3b Specify your own password for the Teaming administrator in the New Password and 

Confirm New Password fields.
3c (Optional) Provide useful information in the additional fields of the Teaming 

administrator’s profile.
3d Click OK to return to the administrator’s workspace.

5.2  Creating a User
For testing purposes or for a very small Novell Teaming site, you can create each Teaming user 
manually.

1 Log in as the Teaming administrator, then click Manage on the Workspace toolbar. 
2 Click Site Administration, then click Add User.

3 Specify at least the login name, password, first name, and last name.
4 (Optional) Provide useful information in the additional fields for the new user.
5 Click OK, then click Close to return to the administrator’s workspace.
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If you expand Personal Workspaces in the Workspace tree above the Workspace toolbar, you 
see that the workspace for the user you just created does not exist yet. Workspaces are not 
created for users until the users log in for the first time.

6 Click Sign Out to log out as the Teaming administrator.
7 On the Sign In page, provide the username and password for the Teaming user you just created, 

then click OK to see the workspace for the new user.

As each new user logs into the Teaming site, a personal workspace is created.
8 Click Sign Out to leave the new user’s personal workspace.

5.3  Adding Teaming Users from Your LDAP 
Directory
Unless you have a very small Novell Teaming site, you create Teaming users by synchronizing their 
user information from an LDAP directory service such as Novell eDirectoryTM or Microsoft Active 
Directory. 

IMPORTANT: For a large Teaming site with thousands of users, the synchronization process can 
consume substantial server resources and can take some time to complete. Perform the initial import 
from the LDAP directory at a time when this processing does not conflict with other activities on the 
server.

1 If the LDAP server requires a secure SSL connection in order to access the directory service, 
create a public-key certificate for the Teaming server.
For instructions, see “Securing LDAP Synchronization” in “Site Security” in the Kablink 
Teaming 2.1 Administration Guide.

2 In a Web browser, log in to the Teaming site as the Teaming administrator, then click Manage 
on the Workspace toolbar. 

3 Click Site Administration > Configure LDAP, then click Add a New LDAP Connection.
4 Fill in the following fields based on the information you gathered on the Basic Teaming 

Installation Summary Sheet:
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LDAP Server URL
User DN
Password
LDAP User Attribute
Base DN

5 Set the following synchronization options based on the information you gathered on the Basic 
Teaming Installation Summary Sheet:

Enable Schedule
Synchronize User Profiles
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Register LDAP User Profiles Automatically
6 Click Apply to save the information and settings.
7 Select Run Immediately, then click Apply to test LDAP synchronization.

A status box displays the users and groups that have been added, modified, or deleted on the 
Teaming site. 

IMPORTANT: If you used an LDAP user attribute of uid and some users were not 
synchronized from the LDAP directory to Teaming, repeat the procedure using cn instead of 
uid.
The usernames admin and guest are reserved for use by Teaming. If your LDAP directory 
includes users with these names, LDAP information for these reserved usernames is not 
imported into the Teaming site.

8 Click Close to close the status box, then click Close to close the Configure LDAP 
Synchronization page.
Teaming performs one-way synchronization from the LDAP directory to your Teaming site. If 
you change user information on the Teaming site, the changes are not synchronized back to 
your LDAP directory.

IMPORTANT: At this point, users could log into the Teaming site by using their eDirectory or 
Active Directory usernames and passwords. However, you should not invite users to visit the 
Teaming site until after you have finished setting up the Teaming site, as described in “Site Setup” in 
the Kablink Teaming 2.1 Administration Guide.
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6Updating Your Teaming License

Several different Teaming licenses are available:

Evaluation License: Available from Novell® Downloads (http://download.novell.com)

You receive your evaluation license when you download the evaluation version of Teaming.
Starter Pack License: Available from the Novell Teaming 2 Starter Pack Web page  (http://
www.novell.com/products/teaming/starterpack.html)
You receive your 20-user starter pack license when you download the 20-user starter pack.
Standard Teaming License: Purchased through a Novell sales representative or Novell 
partner
The Standard Teaming License gives full Teaming functionality on a per-user bases. It includes 
Guest user functionality for Teaming users who are covered by a Standard Teaming License. 
However, if non-licensed Teaming users are accessing the Teaming site through the Guest user 
functionality (as an anonymous user), then you must purchase a Guest Access Instance License 
in addition to the Standard Teaming License for each Teaming instance.
After you purchase the Standard Teaming License, you can access your license key or view 
your purchase history in the Novell Customer Center (http://www.novell.com/customercenter)
Guest Access Instance License: Purchased through a Novell sales representative or Novell 
partner
This license must be purchased in addition to the Standard Teaming License. The Guest Access 
Instance Licence licenses you to provide Guest user access to your Teaming site for non-
licensed Teaming users. If you are using Guest user for licensed Teaming users only, you do not 
need to purchase this license.
The Guest Access Instance Licence is a paper license and does not require a new license-
key.xml file.
The Guest Access Instance License can provide added benefit to your site at a manageable cost. 
For example, imagine that your company employs 500 people. Only 200 of which are company 
knowledge-workers who you expect to actively participate in the Teaming site; the other 300 
employees simply need to access information that is already posted on the Teaming site, such 
as files, news, or other company information. In this case, you would purchase 200 Standard 
Teaming Licenses. For the remaining 300 employees who will simply be accessing the site to 
obtain information, you would purchase a single Guest Access Instance License. 
You must purchase one Guest Access Instance License for each Teaming instance that you are 
running.
For more information about the added functionality provided by this license, see “Allowing 
Guest Access to Your Teaming Site” and “Allowing Web Crawler Access to Your Teaming 
Site” in “Site Setup” in the Kablink Teaming 2.1 Administration Guide.

If you originally installed Teaming with an Evaluation License or a Starter Pack License, it is easy to 
update your Teaming site with the new license file.

1 Copy the new license file that you downloaded from one of the sources listed above into the 
directory where you originally ran the Teaming Installation program.

2 Rename the existing license-key.xml file to a different name.
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3 Rename the new license file to be license-key.xml.
4 Stop Teaming.
5 Run the Teaming Installation program, select the Reconfigure Settings option, then select the 

Basic Installation option.
6 Click Next through all the Installation program pages, then click Install to update your Teaming 

license.
7 Start Teaming.
8 Log in to the Teaming site as the Teaming administrator.
9 Click Manage > Site Administration, then click Manage License.

You should see the contents of the new license file.
10 Click Close.

At any time, you can generate a report of license usage, as described in “License Report” in “Site 
Maintenance” in the Kablink Teaming 2.1 Administration Guide.
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7What’s Next

After you have installed and started the Teaming software, there are still administrative tasks to 
perform before your Teaming site is ready for users to log in and use Teaming efficiently. Refer to 
sections of the Kablink Teaming 2.1 Administration Guide as you finish setting up your Teaming 
site.

“Setting Up Initial Workspaces”
“Planning and Controlling User Access to Workspaces and Folders”
“Setting Up User Access to the Teaming Site”
“Configuring E-Mail Integration”
“Configuring Real-Time Communication Tools”
“Setting Up Mirrored Folders”
“Setting Up Zones (Virtual Teaming Sites)”
“Adding Software Extensions to Your Teaming Site”
“Using Remote Applications on Your Teaming Site”
“Customizing Your Teaming Site by Editing Teaming Configuration Files”
“Managing a Multiple-Language Teaming Site”
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8Basic Teaming Installation 
Summary Sheet

Installation Program Field Value for Your Teaming Site Explanation

Teaming Server Platform: 

Windows

Linux

See Section 3.2.1, “Teaming 
Server Platform,” on page 28.

Teaming Server Architecture: 

32-bit

64-bit

See Section 3.2.2, “Teaming 
Server Architecture,” on page 29.

Teaming Server Memory: 

4 GB

8 GB

More

See Section 3.2.3, “Teaming 
Server Memory,” on page 29.

Java Development Kit (JDK): 

Sun JDK

IBM JDK

See Section 3.3, “Selecting a 
Java Development Kit,” on 
page 31.

Teaming Installation 
Locations: 

Software

Linux default:

/opt/novell/teaming

Windows default:

c:\Program 
Files\Novell\Teaming

File repository

Linux default:

/var/opt/novell/
teaming

Windows default:

c:\Novell\Teaming

See Section 3.2.4, “Teaming 
Installation Locations,” on 
page 30.

TrueType Font Location: 

Default:

/usr/X11R6/lib/X11/
fonts/truetype

See Section 3.2.5, “TrueType 
Font Location (Linux Only),” on 
page 31.
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Teaming Site Locale: 

Language:

Chinese-Simplified

Chinese Traditional

Danish

Dutch

English

French

German

Hungarian

Japanese

Polish

Portuguese

Russian

Spanish

Swedish

Country:

See Section 3.10, 
“Accommodating Multiple 
Languages,” on page 47

User ID for Novell Teaming 
(Linux only): 

User ID:

Full name:

Password:

Group ID:

See Section 3.8.2, “Linux User ID 
for Teaming,” on page 41.

Network Information: 

Host:

HTTP port: 80

Secure HTTP port: 443

Listen port: 8080

Secure listen port: 8443

Shutdown port:

AJP port:

Section 3.4, “Gathering Network 
Information for Your Teaming 
Site,” on page 32.

Database Type: 

MySQL

Microsoft SQL

Oracle

See Section 3.5.1, “Database 
Type,” on page 34.

Installation Program Field Value for Your Teaming Site Explanation
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JDBC URL: 

Hostname:

Port number:

See Section 3.5.3, “Database 
Location,” on page 35.

Database Credentials: 

Username:

Password:

See Section 3.5.4, “Database 
Credentials,” on page 36.

Database Setup Method: 

During installation 
(automatically by the 
Teaming Installation 
program)

Before installation (manually 
by your database 
administrator)

See Section 3.5.2, “Database 
Setup Method,” on page 35.

Database Encryption 
Algorithm: 

SHA

SHA-256

MD5

See Section 3.5.5, “Database 
Encryption Algorithm,” on 
page 37.

Java JDK Location: 

Java home:

JVM heap size:

See Section 3.3, “Selecting a 
Java Development Kit,” on 
page 31.

Outbound E-Mail Protocol: 

SMTP

SMTPS

See Section 3.6.1, “Outbound E-
Mail Protocol,” on page 37.

Outbound E-Mail Host: 

Hostname:

SMTP port:

Default: 25

Time zone

Continent/region:

Country/state:

City:

See Section 3.6.2, “Outbound E-
Mail Host,” on page 38.

Installation Program Field Value for Your Teaming Site Explanation
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Outbound E-Mail 
Authentication: 

Username:

Password:

Authentication required? No 
/ Yes

See Section 3.6.3, “Outbound E-
Mail Authentication,” on page 39.

Allow Sending E-Mail to All 
Users 

Yes / No

See Section 3.6.4, “Outbound E-
Mail Send Restriction,” on 
page 39.

Inbound E-Mail Configuration 

Enable: No / Yes

SMTP bind address:

SMTP port:

Announce TLS: Yes / No

See Section 3.7, “Enabling 
Inbound E-Mail,” on page 39.

Teaming Site Password: 

Administrator username: 
admin

Default password: admin

Your password:

See Section 3.8.1, “Teaming Site 
Administrator Password,” on 
page 41.

LDAP Directory Service: 

Novell eDirectory

Microsoft Active Directory

Other LDAP directory

See Section 3.9, “Gathering 
Directory Services Information,” 
on page 42.

LDAP Server: 

LDAP server URL:

User DN:

Password:

See “LDAP Server” on page 43.

LDAP User Attribute: 

cn

screenName=cn

uid

screenName=uid

See “User Attribute” on page 43.

LDAP User Search Context: 

Base DNs:

Additional filter attributes:

Search subtree: Yes / No

See “User and Group Object 
Locations” on page 44.

Installation Program Field Value for Your Teaming Site Explanation
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LDAP Group Search Context: 

Base DNs:

Additional filter attributes:

Search Subtree: Yes / No

See “User and Group Object 
Locations” on page 44.

LDAP Synchronization 
Schedule: 

Days

Every day

Weekly

Sun Mon Tue Wed Thu 
Fri Sat

Hours:

At time:

Repeat every nn hours

See “Synchronization Schedule” 
on page 45.

LDAP User Options: 

Synchronize user profiles

Register LDAP user profiles 
automatically

Delete users that are not in 
LDAP

When deleting a user, delete 
associated user workspaces 
and content

Time zone for new users

See “User Synchronization 
Options” on page 46.

LDAP Group Options: 

Synchronize group profiles

Register LDAP group 
profiles automatically

Synchronize group 
membership

Delete local groups that are 
not in LDAP

See “User Synchronization 
Options” on page 46.

Installation Program Field Value for Your Teaming Site Explanation
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IIIAdvanced Installation and 
Reconfiguration

Chapter 9, “Planning an Advanced Teaming Installation,” on page 81
Chapter 10, “Performing an Advanced Teaming Installation,” on page 93
Chapter 11, “Setting Configuration Options after Installation,” on page 95
Chapter 12, “Advanced Teaming Installation Summary Sheet,” on page 97
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9Planning an Advanced Teaming 
Installation

Section 9.1, “What Is an Advanced Installation?,” on page 81
Section 9.2, “Distributing Different Data Types to Different Locations,” on page 81
Section 9.3, “Using Advanced Network Information Settings,” on page 83
Section 9.4, “Configuring Web Services,” on page 84
Section 9.5, “Changing Your Lucene Index Server Configuration,” on page 84
Section 9.6, “Managing RSS Feeds,” on page 86
Section 9.7, “Configuring Presence,” on page 87
Section 9.8, “Configuring Single Sign-On with Novell Access Manager,” on page 88
Section 9.9, “Configuring Mirrored Folder Resource Drivers,” on page 89
Section 9.10, “Installing the Teaming Software in a Clustered Environment,” on page 91

9.1  What Is an Advanced Installation?
In addition to the Basic installation options described in Section 3.1, “What Is a Basic Teaming 
Installation?,” on page 27, the Novell® Teaming Installation program provides several optional 
advanced installation and configuration alternatives. You can implement the advanced options after 
performing a Basic installation option, or you can opt to have the Installation program present all the 
options together.

Compared to a Basic installation, an Advanced installation offers the following additional options:

Changing the session timeout
Specifying a keystore file
Specifying different directories for different types of data
Disabling and enabling four different Web services
Changing the configuration of the Lucene Index Server
Configuring a remote Lucene Index Server or a group of high-availability Lucene nodes
Reconfiguring how RSS feeds are retained or disabling them entirely
Enabling presence in conjunction with Conferencing
Configuring a reverse proxy to accommodate single sign-on
Configuring mirrored folders
Installing Teaming in a clustered environment

9.2  Distributing Different Data Types to Different 
Locations
The default location for the Novell Teaming file repository varies by platform:
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Under the main Teaming file repository root directory are subdirectories for various kinds of data 

files that are not stored in the Teaming database (MySQL, Microsoft SQL Server, or Oracle). Using 
an Advanced installation, you can store Teaming data files in various locations.

The data files not stored in the Teaming database are divided up into several functional areas:

Simple file repository: A large consumer of disk space.

All attachment files are stored in the file repository. All versions of files are also stored here.
Jackrabbit repository: (Optional) Takes only a fraction of the space consumed by the file 
repository.
By default, Teaming stores all data files individually on disk, in the file repository. If you prefer 
to store data files in the database itself, you can use Apache Jackrabbit* with Teaming. See the 
Apache Jackrabbit Web site (http://jackrabbit.apache.org) for setup instructions.
Extensions repository: Depends on the number of extensions you add to your Teaming site.
An extension is a software program that you can incorporate into your Teaming site in order to 
enhance (extend) Teaming capabilities. Adblock Plus is an example of a browser extension for 
the Firefox Web browser that filters out advertisements. You or a Java developer can create 
custom extensions for your Teaming site. For more information about creating and using 
Teaming extensions, see the Kablink Teaming 2.1 Developer Guide.
Archive store: A large consumer of disk space.
When entries are deleted, files that were attached to the deleted entries are retained in the 
archive store in order to meet compliance and archival goals. Previous versions of documents 
are also retained in the archive store. After files have been archived, they are inaccessible from 
the Teaming site. Files that accumulate in the archive store must be manually deleted as needed 
to manage the disk space occupied by the archive store.
Cache store: Consumes less disk space than the file repository.
Information derived from the attachments, such as thumbnails, HTML renderings, scaled 
images, and word lists for indexing are stored in the cache store. 
Lucene index: Takes only a fraction of the space consumed by the file repository.
The Lucene index contains only pointers to the actual data stored in the file repository. The 
index enables the Lucene search engine to perform very fast searches through large quantities 
of data.

The directories for the various types of data can be on the Teaming server or on a remote server. 
Data access is fastest if the data is local, but depending on the size of your Teaming site and the 
types of data you store, the Teaming server might not be the best place to store all the Teaming data. 
If you want to store any of the data types on a remote server, you must ensure that the remote 
location of the data appears local to the Teaming server and that it is always available with read/
write access.

Linux: /var/opt/novell/teaming

Windows: c:\Novell\Teaming

Linux: Mount the file repository to the Teaming server.

Windows: Map a drive from the Teaming server to the file repository.
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Complete the planning process for additional Advanced installation features as needed, then perform 
the Advanced installation as described in Chapter 10, “Performing an Advanced Teaming 
Installation,” on page 93.

9.3  Using Advanced Network Information 
Settings

Section 9.3.1, “Changing the Teaming Session Timeout,” on page 83
Section 9.3.2, “Providing a Secure Keystore File,” on page 83

9.3.1  Changing the Teaming Session Timeout
By default, if a user’s Novell Teaming session is idle for four hours (240 minutes), Teaming logs the 
idle user out. For increased convenience to Teaming users, you can make the session timeout 
interval longer. For increased security for your Teaming site, you can make the session timeout 
shorter.

Complete the planning process for additional Advanced installation features as needed, then perform 
the Advanced installation as described in Chapter 10, “Performing an Advanced Teaming 
Installation,” on page 93.

9.3.2  Providing a Secure Keystore File
For your convenience, the Novell Teaming software includes a self-signed public certificate that 
enables you to specify secure HTTP and listen ports during installation. This certificate is stored in 
the .keystore file in the following directory:

To ensure secure SSL connections for your Teaming site, you should replace the self-signed public 
certificate with a public certificate issued by a valid Certificate Authority. 

Linux and 
Windows

Place the file repository on a SAN (storage area network) with read/write access. This 
alternative provides the most reliable remote location for the Teaming file repository. This is 
required for a clustered environment, as described in Chapter 15, “Running Teaming on 
Multiple Servers,” on page 113.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Data Locations, specify the directories where you want to store the various types of Teaming data.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Network Information, specify the session timeout interval (in minutes) for your Teaming site.

Linux: /opt/novell/teaming/apache-tomcat-version/conf

Windows: c:\Program Files\Novell\Teaming\apache-tomcat-version\conf
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If you do not already have a permanent public certificate for your Teaming server, see “Securing 

HTTP Browser Connections” in “Site Security” in the Kablink Teaming 2.1 Administration Guide.

Complete the planning process for additional Advanced installation features as needed, then perform 
the Advanced installation as described in Chapter 10, “Performing an Advanced Teaming 
Installation,” on page 93.

9.4  Configuring Web Services
When you install and set up your Novell Teaming site, three Web services are enabled by default. A 
fourth is available for selection. These Web services enable programs to access information on your 
Teaming site just as users would. Allowing programmatic access to your Teaming site can be useful 
or can be viewed as a security risk.

WSS authentication: Uses OASIS Web Services Security (WSS) (http://www.oasis-
open.org).
HTTP Basic authentication: Uses HTTP Basic Access authentication (http://tools.ietf.org/
html/rfc2617).
Token-based authentication: Uses custom Teaming tokens to communicate with Teaming 
remote applications. For more information, see “Using Remote Applications on Your Teaming 
Site” in “Site Setup” in the Kablink Teaming 2.1 Administration Guide.
Anonymous access: Allows access to your Teaming site without authentication. It is similar to 
the Guest access provided for users, as described in “Allowing Guest Access to Your Teaming 
Site” in “Site Setup” in the Kablink Teaming 2.1 Administration Guide.

Complete the planning process for additional Advanced installation features as needed, then perform 
the Advanced installation as described in Chapter 10, “Performing an Advanced Teaming 
Installation,” on page 93.

9.5  Changing Your Lucene Index Server 
Configuration
The default Lucene Index Server configuration is appropriate for a medium-sized Novell Teaming 
site. If you have a larger Teaming site, you can change its Lucene Index Server configuration.

Section 9.5.1, “Understanding Indexing,” on page 85
Section 9.5.2, “Changing Lucene Configuration Settings,” on page 85
Section 9.5.3, “Running the Lucene Index Server in Its Own JVM,” on page 86

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Network Information, specify the name and location of the public certificate.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Web Services, mark which Web services you want enabled for your Teaming site. The first three 
are enabled by default. The fourth is disabled by default.
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Section 9.5.4, “Running the Lucene Index Server on a Remote Server,” on page 86
Section 9.5.5, “Running Multiple Lucene Index Servers,” on page 86

After planning your Lucene configuration, complete the planning process for additional Advanced 
installation features as needed, then perform the Advanced installation as described in Chapter 10, 
“Performing an Advanced Teaming Installation,” on page 93.

9.5.1  Understanding Indexing
The Lucene Index Server is responsible for indexing all data on the Novell Teaming site so that 
Teaming users can easily use the Find and Search features to retrieve the information that they need. 
Text posted in folder entries is easy to index, because the formatting is simple. However, text in 
attached files arrives in many different file formats, many of which require conversion before the 
text in the files can be indexed. Therefore, the Lucene Index Server is dependent on the available file 
conversion technology in order to perform its indexing function. For information about the file 
viewers that Teaming uses, see Section 2.4.1, “File Viewer Support,” on page 22.

The Lucene Index Server provides additional services on your Teaming site in addition to indexing. 
In fact, you cannot access your Teaming site if the Lucene Index Server is not running. For this 
reason, Novell Teaming provides multi-server Lucene configuration options that are not available in 
Kablink Teaming.

9.5.2  Changing Lucene Configuration Settings
If you have an extremely large Novell Teaming site and you need to reindex the Teaming data, you 
might see improved performance by increasing these settings.

Flush threshold: The default is 100. This means that after 100 documents have been cached in 
memory, they are flushed to disk. Increasing the setting allows additional documents to be 
cached in memory before a flush occurs.
Max booleans: The default is 10000. This means that 10,000 Boolean clauses are allowed in a 
query. You would only need to increase this if your Teaming site includes more than 10,000 
users, groups, or teams.
Max merge documents: The default is 1000. This means that the Lucene Index Server starts a 
new index segment after the current index segment contains 1000 documents. Only a very large 
Teaming site would benefit from increasing this.
Merge factor: The default is 10. This sets the number of index segments that are created on 
disk. When additional index segments are needed, existing segments are merged to keep the 
merge factor constant. Only a very large Teaming site would benefit from increasing this.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify any Lucene configuration settings that you want to change.
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9.5.3  Running the Lucene Index Server in Its Own JVM
By default, the Lucene Index Server runs in the same Java Virtual Machine (JVM) as the Teaming 
software. To leave more memory available for the Novell Teaming software, you can configure the 
Lucene Index Server to run in a separate JVM. In this configuration, it communicates with the 
Teaming software using the RMI (Remote Method Invocation (http://java.sun.com/javase/
technologies/core/basic/rmi/index.jsp)) port, which, by default is 1199.

To change from running the Lucene Index Server in the same JVM with Teaming to running it in its 
own JVM, you must complete the same steps as if you were setting up the Lucene Index Server on a 
remote server, including manually installing the Lucene Index Server software on the Teaming 
server, as described in Chapter 14, “Moving the Lucene Index Server to a Remote Server,” on 
page 109.

9.5.4  Running the Lucene Index Server on a Remote Server
If the Lucene Index Server requires more memory, disk space, or CPU resources than are available 
on the Novell Teaming server, you can move it to a remote server. This requires installing the 
Lucene Index Server software on that server. For instructions, see Chapter 14, “Moving the Lucene 
Index Server to a Remote Server,” on page 109.

9.5.5  Running Multiple Lucene Index Servers
Because the availability of the index is critical to the functioning of the Novell Teaming site, you can 
install multiple Lucene Index Servers on multiple remote servers to provide high availability. For 
instructions, see Chapter 16, “Running Multiple Lucene Index Servers,” on page 119.

9.6  Managing RSS Feeds
By default, Teaming users can set up RSS feeds in folders on the Teaming site, as described in 
“Viewing Teaming Folders as RSS or ATOM Feeds” in “Getting Informed” in the Novell Teaming 
2.1 User Guide. 

Section 9.6.1, “Configuring RSS Feeds,” on page 87
Section 9.6.2, “Disabling RSS Feeds,” on page 87

After planning the RSS settings, complete the planning process for additional Advanced installation 
features as needed, then perform the Advanced installation as described in Chapter 10, “Performing 
an Advanced Teaming Installation,” on page 93.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify a hostname of localhost. Use the default RMI port number 
unless it is already in use on the server.
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9.6.1  Configuring RSS Feeds
The following aspects of RSS functionality on your Novell Teaming site are configurable:

Max elapsed days: By default, items from RSS feeds are retained on the Teaming site for 31 
days. You can decrease the number of days to reduce the amount of disk space occupied by the 
RSS files.
Max inactive days: By default, if no one on the Teaming site accesses an RSS feed for 7 days, 
the feed is no longer updated. Increase or decrease the retention time for inactive feeds to meet 
the needs of Teaming users and disk space considerations.

9.6.2  Disabling RSS Feeds
Some administrators consider RSS feeds to be a security risk because the RSS feed URL includes 
username and password information. If you do not want Novell Teaming site users to be able to 
subscribe to RSS feeds from the Teaming site, you can disable this feature.

9.7  Configuring Presence
If you are using the Conferencing component of Novell Teaming + Conferencing 1.0, you can 
configure Novell Teaming to display a user’s Conferencing presence icon anyplace on the Teaming 
site where that user’s name displays. When you click the presence icon, contact options are 
presented. In addition, with Conferencing presence enabled, a link at the bottom of each workspace 
and folder page enables you to start an instant meeting with team members of a team workspace or 
with users who have created entries and comments in the folder.

In order to configure Conferencing presence in Teaming, you need the following information about 
the Conferencing system:

Jabber server: Specify the IP address or DNS hostname of the Conferencing XML router. For 
more information, see “Installing the Conferencing Server ” in the Conferencing 1.0 Server 
Installation Guide.
Broker admin ID: The default admin ID is admin.
Broker admin password: The default admin password is admin.
Jabber domain: Specify the IP address or DNS hostname of the Conferencing XML router.
Default community ID: Users in a Conferencing system are organized into groups called 
communities. When the Conferencing software is installed, a system community is created. For 
more information, see “Conferencing Communities” in the Conferencing 1.0 Operations 
Guide.
Specify the community ID where you want to obtain presence information.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under RSS Configuration, specify the number of days that meet the needs of your Teaming site.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under RSS Configuration, mark No.
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Conferencing URL: Specify the URL of the Conferencing server:
http://ip_address_or_dns_hostname:8000/imidio_api

Complete the planning process for additional Advanced installation features as needed, then perform 
the Advanced installation as described in Chapter 10, “Performing an Advanced Teaming 
Installation,” on page 93.

IMPORTANT: In order for Conferencing presence to display, the Conferencing User Name field of 
each user’s Teaming profile must contain the user’s Conferencing ID. Users can provide this 
information manually, or you can populate the Conferencing User Name field from your LDAP 
directory.

9.8  Configuring Single Sign-On with Novell 
Access Manager
Novell Access Manager provides secure single sign-on access to your Novell Teaming site by 
functioning as a reverse proxy server. Access Manager 3.1 SP1 IR1 is required for use with Novell 
Teaming. You can download the required version of Access Manager from Novell Downloads (http:/
/download.novell.com).

For background information about setting up Novell Access Manager 3.1, see the Access Manager 
3.1 Documentation Web site (http://www.novell.com/documentation/novellaccessmanager31). For 
instructions specific to Teaming, see “Configuring a Protected Resource for a Novell Teaming 2.x 
Server” (http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/
b3nqgsg.html#blpk97e). These instructions are based on the Linux text-based Teaming Installation 
program, as described in “Using the Text-Based Installation Program” on page 52. They can easily 
be adapted for running the Linux GUI Teaming Installation program, as described in “Using the GUI 
Installation Program” on page 51, or when installing on Windows, as described in Section 4.2.2, 
“Running the Windows Teaming Installation Program,” on page 58.

After you have configured Novell Access Manager, you must configure your Teaming site with the 
IP address of one or more Access Gateway servers and with the logout URL. When you configure 
the Teaming site to use the Access Gateway, the IP addresses that you specify are the only locations 
from which the Teaming site accepts logins. The logout URL is the location where users find 
themselves when they log out of the Teaming site.

When you enable the Access Gateway for use with your Teaming site, all Teaming users must log in 
through the Access Gateway. It is not possible to set up the Teaming site so that some users log in 
through the Access Gateway and some do not.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Presence Configuration, list the information that the Teaming site needs to know in order to 
communicate with the Conferencing system.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Reverse Proxy Configuration, list one or more IP addresses of Access Gateway servers that have 
been configured for use by Teaming. List the logout URL, and if necessary, the Access Gateway 
hostname for WebDAV connections.
 Teaming 2.1 Installation Guide

http://download.novell.com
http://www.novell.com/documentation/novellaccessmanager31
http://www.novell.com/documentation/novellaccessmanager31
http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/b3nqgsg.html#blpk97e
http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/b3nqgsg.html#blpk97e
http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/b3nqgsg.html#blpk97e
http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/b3nqgsg.html#blpk97e
http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/b3nqgsg.html#blpk97e


novdocx (en)  16 A
pril 2010
Complete the planning process for additional Advanced installation features as needed, then perform 
the Advanced installation as described in Chapter 10, “Performing an Advanced Teaming 
Installation,” on page 93.

9.9  Configuring Mirrored Folder Resource 
Drivers
A mirrored folder is a directory, either local or shared on a SAN (storage area network), that is 
directly accessible from the Novell Teaming site. The files on the file system are accessed by the 
Teaming program using a resource driver, not directly by individual Teaming users. A resource 
driver defines how the Teaming program accesses the file system. 

During installation, you define the users and groups that can access the mirrored folder resource 
drivers. After installation, from the Teaming site, you associate resource drivers with specific 
Teaming folders and use folder access controls to govern which users and groups can access the data 
in the mirrored folder. As a result, you can set up a small number of users who can create mirrored 
folders, while a large number of users can access shared folders.

Teaming attempts to keep the metadata about each mirrored folder synchronized with the contents of 
the actual file system. Therefore, mirrored folders are most appropriate for large sets of relatively 
static data. Mirrored folders are also useful for making extremely large files available from your 
Teaming site without including them in the Teaming file repository.

Although the Installation program allows you to set up three mirrored folder resource drivers at 
once, you can set up and test just one to start with, then set up additional resource drivers later. 

Section 9.9.1, “File System Type,” on page 89
Section 9.9.2, “File System Directory,” on page 90
Section 9.9.3, “File System Access,” on page 90
Section 9.9.4, “Mirrored Folder Setup,” on page 90

After planning mirrored folders, complete the planning process for additional Advanced installation 
features as needed, then perform the Advanced installation as described in Chapter 10, “Performing 
an Advanced Teaming Installation,” on page 93.

9.9.1  File System Type
Novell Teaming provides resource drivers for two different types of file systems:

file: A directory in a regular file system on a Linux or Windows server.
webdav: A directory on a Web server that supports WebDAV (Web-based Distributed 
Authoring and Versioning). The WebDAV server must support HTTP Basic Authentication 
(http://en.wikipedia.org/wiki/Basic_access_authentication) so that Teaming can provide a 
username and a password when making a request from the WebDAV server.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, mark the type of directory that you want to mirror 
in your Teaming site.
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9.9.2  File System Directory
The file system on which a Novell Teaming mirrored folder is based can be on Linux, NetWare®, or 
Windows, as long as the following conditions are met:

The file system is accessible from the Teaming server, by using a directory path specification 
that the Teaming server operating system understands.
The file system is accessible through the standard java.io package interface.

IMPORTANT: On Windows, you must use forward slashes (/) in the pathname, not the typical 
Windows back slashes (\). For example, use c:/Documents rather than c:\Documents.

If you need to eventually set up more than three directories as mirrored folders in your Teaming site, 
you can edit the installer.xml file in the directory where you run the Installation program.

9.9.3  File System Access
Novell Teaming offers several security options for controlling access to the data that resides on the 
file system.

You can restrict the Teaming program to read-only access to the mirrored data, or you can 
allows full read/write access.
You can list specific Teaming users who are allowed to access the mirrored folder resource 
drivers and thereby create mirrored folders.
You can list specific Teaming groups whose members are allowed to access the mirrored folder 
resource drivers and thereby create mirrored folders.
For WebDAV mirrored folder resource drivers, you must also specify a username and password 
that the Teaming program can use to access the WebDAV server.

9.9.4  Mirrored Folder Setup
After you run the Novell Teaming Installation program to configure the Teaming site for mirrored 
folder resource drivers, additional folder setup is required. Follow the instructions in “Setting Up 
Mirrored Folders” in “Site Setup” in the Kablink Teaming 2.1 Administration Guide.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, specify the full path for the directory that you want 
to mirror in your Teaming site. Also, provide a title for the mirrored folder resource driver that indicates 
what directory or data is being mirrored. For WebDAV mirrored folders, you must also specify the URL of 
the WebDAV host where the data is located.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, list the file access (read/write or read-only) for the 
mirrored data, along with users and groups that you want to have access to the resource driver for it. For 
a WebDAV mirrored folder, list a username and password that provides access to the WebDAV server.
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9.10  Installing the Teaming Software in a 
Clustered Environment
You must use an Advanced installation in order to install the Novell Teaming software on multiple 
servers and set up a clustered environment. Setting up multiple Teaming servers, along with other 
clustering options, are described in Chapter 15, “Running Teaming on Multiple Servers,” on 
page 113.
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10Performing an Advanced Teaming 
Installation

You should already have reviewed Chapter 3, “Planning a Basic Teaming Installation,” on page 27 
and filled out the Basic Teaming Installation Summary Sheet. You should also have reviewed 
Chapter 9, “Planning an Advanced Teaming Installation,” on page 81 and filled out the Advanced 
Teaming Installation Summary Sheet for those aspects of an Advanced installation that you want to 
implement for your Novell® Teaming site.

1 Follow the Basic installation instructions provided in Chapter 4, “Setting Up a Basic Teaming 
Site,” on page 49 for the platform where you are installing Teaming.

2 In the Choose Installation Type page, select Advanced. 

3 Use the information that you have gathered on the Basic Teaming Installation Summary Sheet 
and the Advanced Teaming Installation Summary Sheet to provide the information that the 
Teaming Installation program prompts you for:
Basic Installation Pages: 

Installation Locations
Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Teaming
User ID for Novell Teaming (Linux only)
Network Information
Database Selection
Java JDK Location
Outbound E-Mail Configuration
Inbound E-Mail Configuration
Some Basic installation pages have additional options available when you perform an 
Advanced installation.
Advanced Installation Pages: 

Web Services
Lucene Configuration
RSS Configuration
Presence Configuration
Reverse Proxy Configuration
Mirrored Folder Resource Driver Configuration
Teaming Cluster Configuration
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The Installation program stores the information it gathers in the installer.xml file in the 
same directory where you started the Installation program.

4 After you have provided all the requested information, click Install to begin the Advanced 
installation.

5 When the installation is completed, click Finish to exit the Teaming Installation program.
Information about the installation process is written to the installer.log file in the same 
directory where you ran the Installation program. If a problem arises during the installation, the 
installer.log file provides information that can help you resolve the problem.

6 After you complete the Advanced installation, continue setting up your Teaming site, as 
described in Chapter 5, “Adding Users to Your Teaming Site,” on page 63.
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11Setting Configuration Options 
after Installation

After you install Novell® Teaming following the instructions in Part II, “Basic Installation,” on 
page 25 or Part III, “Advanced Installation and Reconfiguration,” on page 79, you can rerun the 
Teaming Installation program to change configuration options or add new functionality to your 
Teaming site.

1 Stop Teaming.
2 Start the Teaming Installation program.

Because the Installation program finds an existing installer.xml file, it defaults to 
Reconfigure settings. 

3 Click Next.
The Teaming Installation program asks you to verify that you have stopped Teaming.

4 Click Yes.

5 Select Basic or Advanced, depending on the configuration setting that you want to change, then 
click Next.

6 Click Next until you reach an installation page where you want to reconfigure settings.
Basic Installation Pages: 

Installation Locations
Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Teaming
User ID for Novell Teaming (Linux only)
Network Information
Database Selection
Java JDK Location
Outbound E-Mail Configuration
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Inbound E-Mail Configuration
Advanced Installation Pages: 

Web Services
Lucene Configuration
RSS Configuration
Presence Configuration
Reverse Proxy Configuration
Mirrored Folder Resource Driver Configuration
Teaming Cluster Configuration

7 When you reach the Ready to Install page, click Install to implement the reconfigured settings.
8 Start Teaming.
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12Advanced Teaming Installation 
Summary Sheet

Installation Program Field Value for Your Teaming Site Explanation

Data Locations: 

Linux default:

/var/opt/novell/teaming

Windows default:

c:\Novell\Teaming

Simple file repository

Jackrabbit repository

Extensions repository

Archive store

Cache store

Lucene index

See Section 9.2, “Distributing 
Different Data Types to Different 
Locations,” on page 81.

Network Information: 

Enable Web services: 

No / Yes

Session timeout

Default: 240 minutes

Enable Tomcat access log: 

No / Yes

Keystore file:

See Section 9.3, “Using 
Advanced Network Information 
Settings,” on page 83.

Web Services: 

Enable WSS authentication

Enable Basic authentication

Enable token-based 
authentication

Enable anonymous access

See Section 9.4, “Configuring 
Web Services,” on page 84.
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Lucene Configuration: 

Configuration type: all

Flush threshold:

Default: 100

Max booleans:

Default: 10000

Max merge documents:

Default: 1000

Merge factor:

10

See Section 9.5.2, “Changing 
Lucene Configuration Settings,” 
on page 85.

Server Lucene Configuration: 

Configuration type: server only

Host:

RMI port:

Default: 1199

See Section 9.5.3, “Running the 
Lucene Index Server in Its Own 
JVM,” on page 86.

High Availability Lucene 
Configuration: 

Configuration type: high 
availability only

Number of high availability search 
nodes:

Service name:

Service title:

Host:

RMI port:

Service name:

Service title:

Host:

RMI port:

See Chapter 16, “Running 
Multiple Lucene Index Servers,” 
on page 119.

RSS Configuration: 

Enable RSS: No / Yes

Max elapsed days:

Max inactive days:

See Section 9.6, “Managing RSS 
Feeds,” on page 86.

Installation Program Field Value for Your Teaming Site Explanation
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Presence Configuration: 

Enable presence: No / Yes

Jabber server:

Broker admin ID:

Broker admin password:

Jabber domain:

Default community ID:

Conferencing URL:

See Section 9.7, “Configuring 
Presence,” on page 87.

Reverse Proxy Configuration: 

Enable Access Gateway: No / 
Yes

Access Gateway 
address(es):

Logout URL:

Use Access Gateway for 
WebDav connections: No / 
Yes

WebDAV Access 
Gateway address:

See Section 9.8, “Configuring 
Single Sign-On with Novell 
Access Manager,” on page 88.

Mirrored Folder Resource 
Driver Configuration: 

Enable file share: No / Yes

Share type

File

WebDav

Sharepoint

Read only: No / Yes

Title

Root path

Allowed users

Allowed groups

User

Password

Host URL

See Section 9.9, “Configuring 
Mirrored Folder Resource 
Drivers,” on page 89.

Installation Program Field Value for Your Teaming Site Explanation
Advanced Teaming Installation Summary Sheet 99



100 Novell

novdocx (en)  16 A
pril 2010
 Teaming 2.1 Installation Guide



IV
novdocx (en)  16 A

pril 2010
IVMulti-Server Configurations and 
Clustering

Chapter 13, “Creating the Teaming Database on a Remote Server,” on page 103
Chapter 14, “Moving the Lucene Index Server to a Remote Server,” on page 109
Chapter 15, “Running Teaming on Multiple Servers,” on page 113
Chapter 16, “Running Multiple Lucene Index Servers,” on page 119
Chapter 17, “Running Multiple Database Servers,” on page 135
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13Creating the Teaming Database on 
a Remote Server

The default location for the Novell® Teaming database is on the same server with the Teaming 
software, as described in Section 3.5.3, “Database Location,” on page 35. However, for better 
performance and scalability, you can install the database server (MySQL, Microsoft SQL, or Oracle) 
on a remote server, then use the scripts that are included with the Teaming software to manually 
create the Teaming database in any location that you prefer.

Section 13.1, “Preparing to Manually Create a Database,” on page 103
Section 13.2, “Creating a MySQL Database,” on page 104
Section 13.3, “Creating a Microsoft SQL Database,” on page 105
Section 13.4, “Creating an Oracle Database,” on page 106
Section 13.5, “Installing Teaming with a Remote Database,” on page 107

NOTE: This section assumes that you already have a Basic installation of Teaming up and running 
successfully. It is highly recommended to follow the instructions in Part II, “Basic Installation,” on 
page 25 before attempting a more complex Teaming configuration.

13.1  Preparing to Manually Create a Database
Novell Teaming includes scripts for creating the Teaming database on a remote server.

1 In the directory where the Teaming Installation program is located on the Teaming server, unzip 
the teaming-2.1.n-sql.zip file.
This creates two new subdirectories, the create subdirectory for database creation scripts and 
the update-2.0.n-2.1.n directory for database update scripts.

2 Change to the create subdirectory.
3 Copy all the scripts for your database type to a convenient temporary location on the server 

where you want to create the database, and make sure that your database management utility is 
on your path so that you can run it from that directory

4 Continue with the instructions for the type of database that you want to create:
Section 13.2, “Creating a MySQL Database,” on page 104
Section 13.3, “Creating a Microsoft SQL Database,” on page 105
Section 13.4, “Creating an Oracle Database,” on page 106

Database Database Script Database Management Utility

MySQL: *mysql.sql mysql

Microsoft SQL: *sqlserver.sql osql

Oracle: *oracle.sql sqlplus
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13.2  Creating a MySQL Database
1 Review the MySQL requirements listed in Section 2.1, “Teaming Server Requirements,” on 

page 19
2 Make sure that the MySQL database server and client have been installed and configured, as 

described in Section A.2, “MySQL Database Server,” on page 175.
3 Make sure that the MySQL database client is also installed on the Teaming server

The Teaming Installation program needs the MySQL client in order to communicate with the 
remote MySQL database server.

4 Make sure that you know the password for the MySQL root administrator user.
5 Make sure that innodb support is enabled. 

It is enabled by default. To verify that innodb support is enabled:
5a Enter the following command to access the MySQL monitor:

mysql -u root -p

For information on how to set a password for your MySQL database if you have not 
already done so, see “Configuring MySQL” on page 176.

5b Specify your password.
5c From the mysql prompt, enter the following command to display status information about 

the server’s storage engines:
SHOW ENGINES\G

5d Locate the InnoDB engine, and ensure that innodb support is enabled.
6 Update the MySQL configuration file.

6a Locate the MySQL configuration file and open it in a text editor.

6b Under the [client] section, add the following line:
default_character_set = utf8

6c Under the [mysqld] section, add the following line:
character_set_server = utf8

Setting the character set to UTF-8 ensures that extended characters are handled correctly 
in the database.

6d (Conditional) On a system with multiple network interfaces, under the [mysqld] section, 
add the following line:
bind-address = mysql_server_address

where mysql_server_address is the IP address that you want MySQL to bind to and to 
listen on.

6e Save the updated configuration file, then exit the text editor.
7 In the directory where you copied the database scripts (Step 3 in Section 13.1, “Preparing to 

Manually Create a Database,” on page 103), enter the following command to run the MySQL 
database creation script:

Linux: /etc/my.cnf

Windows: c:\Program Files\MySQL\MySQL Server version\my.ini
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mysql -uuser -ppassword < create-database-mysql.sql

8 Configure MySQL to allow access from a remote server:
mysql -uuser -ppassword
mysql> grant all privileges on *.* 

-> to 'username'@'%'
-> identified by 'password' 
-> with grant option
-> ;

9 Be familiar with standard database maintenance procedures.
For more information about MySQL, see the following references:

MySQL 5.0 Reference Manual (http://dev.mysql.com/doc/refman/5.0/en)
MySQL 5.1 Reference Manual (http://dev.mysql.com/doc/refman/5.1/en)

The following database tools can be helpful:
MySQL GUI Tools (http://dev.mysql.com/downloads/gui-tools)
SQLyog (http://www.webyog.com)
Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

10 Skip to Section 13.5, “Installing Teaming with a Remote Database,” on page 107.

13.3  Creating a Microsoft SQL Database
1 Review the Microsoft SQL requirements listed in Section 2.1, “Teaming Server 

Requirements,” on page 19.
2 Make sure that the Microsoft SQL Server and Client have been installed and configured 

properly.

IMPORTANT: Make sure that TCP/IP is enabled for Microsoft SQL Server.

For more information, see Microsoft SQL Server (http://msdn.microsoft.com/en-us/library/
bb545450.aspx).

3 Make sure that the Microsoft SQL database client is also installed on the Teaming server
The Teaming Installation program needs the Microsoft SQL client in order to communicate 
with the remote Microsoft SQL database server.

4 When you install Microsoft SQL Server, select SQL Server and Windows for authentication.
The default is Windows Only, which is not appropriate for Teaming

5 Immediately establish the database administrator username and password for the SQL database 
server.

6 Change to the directory where you copied the database scripts in Step 3 in Section 13.1, 
“Preparing to Manually Create a Database,” on page 103.

7 Enter the following command to run the Microsoft SQL database creation script:
osql -Uuser -Ppassword -i create-database-sqlserver.sql

8 Be familiar with standard database maintenance procedures.
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For more information about Microsoft SQL, see the following references:
Microsoft SQL Server 2008 Learning Resources (http://www.microsoft.com/sqlserver/
2008/en/us/learning.aspx)
Microsoft SQL Server 2005 Learning Resources (http://www.microsoft.com/sqlserver/
2005/en/us/learning-resources.aspx)

The following database tool can be helpful:
Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

9 Skip to Section 13.5, “Installing Teaming with a Remote Database,” on page 107.

13.4  Creating an Oracle Database
When you use an Oracle database, your database administrator must create it for you. The Novell 
Teaming Installation program cannot create an Oracle database.

1 Review the Oracle database requirements listed in Section 2.1, “Teaming Server 
Requirements,” on page 19.

2 Make sure that the Oracle database server and client software has been installed and configured 
properly.
For more information, see Oracle Database (http://www.oracle.com/database).

3 Make sure that the Oracle database client is also installed on the Teaming server
The Teaming Installation program needs the Oracle client in order to communicate with the 
remote Oracle database server.

4 Make sure that you know the password for the Oracle database administrator user.
5 Set up the Oracle database character set to support Unicode character encodings. 

Teaming requires either the UTF-8 or AL32UTF8 character set for proper operation. Oracle 
recommends the use of AL32UTF8, because it has increased support for certain Asian 
languages. For more information, see Choosing a Character Set (http://download.oracle.com/
docs/cd/B19306_01/server.102/b14225/ch2charset.htm) in the Oracle Database Globalization 
Support Guide.

6 Change to the directory where you copied the Oracle database scripts in Step 3 in Section 13.1, 
“Preparing to Manually Create a Database,” on page 103.

7 Edit the create-database-oracle.sql script with your Oracle database password.
Original: 
drop user sitescape cascade;
create user sitescape identified by sitescape;
grant connect, resource to sitescape;
connect sitescape/sitescape;

NOTE: SiteScape® is the name of the company that previously owned the Teaming software. 

Updated: 

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Database Creation, make sure you have marked that you want your database administrator to 
manually create the Oracle database before installation.
 Teaming 2.1 Installation Guide
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drop user sitescape cascade;
create user sitescape identified by your_oracle_password;
grant connect, resource to sitescape;
connect sitescape/your_oracle_password;

IMPORTANT: Unless you are very familiar with editing scripts, change only the password. 
Do not attempt to change the name of the database from the legacy default of sitescape.

8 Enter the following commands to run the database creation script:
sqlplus "/ as sysdba"
SQL> spool create-database-oracle.out;
SQL> @create-database-oracle;
SQL> quit

9 Check the resulting create-database-oracle.out file for errors and resolve them.
10 Be familiar with standard database maintenance procedures.

For more information about your Oracle database, see the following reference:
Oracle Product Documentation (http://www.oracle.com/technology/documentation)
Oracle SQL*Plus Documentation (http://www.oracle.com/technology/docs/tech/sql_plus)

The following database tool can be helpful:
Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

11 (Conditional) If you created the Oracle database on the Teaming server, skip to Chapter 4, 
“Setting Up a Basic Teaming Site,” on page 49 or Chapter 10, “Performing an Advanced 
Teaming Installation,” on page 93.

IMPORTANT: On the Database Selection page in the Installation program, be sure to select 
Database already exists or has already been created.

or
(Conditional) If you created the Oracle database on a remote server, continue with Installing 
Teaming with a Remote Database.

13.5  Installing Teaming with a Remote Database
1 Run the Novell Teaming Installation program, as described in Chapter 4, “Setting Up a Basic 

Teaming Site,” on page 49 or Chapter 10, “Performing an Advanced Teaming Installation,” on 
page 93.

2 When you get to the Database Selection page:
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2a Fill in the fields:
Database type: Select the type of database that you just created.
JDBC URL: Replace localhost with the hostname of the server where you created the 
Teaming database.
Credentials: Specify the password for the database administrator user.
Setup: Select Database already exists or has already been created so that the Installation 
program does not create one for you.
Encryption algorithm: Set the encryption appropriate for the security needs of the 
Teaming site. For more information, see Section 3.5.5, “Database Encryption Algorithm,” 
on page 37.

2b Click Next.
The Teaming Installation program tries to connect to the database. If it connects 
successfully, you can continue with the installation. If the Teaming Installation program 
cannot connect to the database, you must resolve the problem with the database before you 
can continue with the Teaming installation.

2c When the Teaming Installation program can successfully connect to the remote database, 
continue as usual with the installation.
 Teaming 2.1 Installation Guide
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14Moving the Lucene Index Server to 
a Remote Server

You can install the Lucene Index Server on a different server from where Novell® Teaming is 
running so that both programs have access to more server memory, disk space, and CPU resources. 

IMPORTANT: The Teaming server and the Lucene Index Server must not have a firewall between 
them. The RMI protocol used for the Lucene Index Server port works only within a trusted local 
area network (LAN).

Section 14.1, “Installing the Lucene Software,” on page 109
Section 14.2, “Updating Your Teaming Site,” on page 110
Section 14.3, “Managing a Remote Lucene Index Server,” on page 111

NOTE: This section assumes that you already have a Basic installation of Teaming up and running 
successfully. It is highly recommended to follow the instructions in Part II, “Basic Installation,” on 
page 25 before attempting a more complex Teaming configuration.

14.1  Installing the Lucene Software
1 Make sure that a supported Java Developer Kit (JDK) is installed on the remote server where 

you want to install the Lucene Index Server.
For instructions, see Appendix A, “Teaming System Requirements Assistance,” on page 173.

2 Make sure that there is no firewall between the Teaming server and the Lucene Index Server.
3 Copy the Lucene Installation program from its original location in the same directory with the 

Teaming Installation program to a convenient temporary directory on the remote server.
The filename for the Lucene Installation program varies by platform:

4 Change to the directory where you copied the Lucene Installation program, then start it.
5 Accept the License Agreement, then click Next.
6 Select New installation, then click Next.
7 Browse to and select the directory where you want to install the Lucene Index Server, then 

click Next.
The default location varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Linux: /opt/novell/teaming/luceneserver

Windows: c:\Program Files\Novell\Teaming\luceneserver
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8 Browse to and select the directory where you installed the JDK, then click Next.
9 Adjust the configuration of the Lucene Index Server, as described in Section 9.5, “Changing 

Your Lucene Index Server Configuration,” on page 84, then click Next.
10 Click Install to install the Lucene software.
11 (Conditional) On Linux, deselect Start Lucene server.

You must edit the Lucene Index Server startup script before you start the Lucene Index Server.
12 (Conditional) On Windows, if you do not want to start the Lucene Index Server immediately, 

deselect Start Lucene server.
For instructions for starting and stopping the Lucene Index Server manually, see Section 14.3, 
“Managing a Remote Lucene Index Server,” on page 111.

13 Click Finish.
14 (Conditional) On Linux:

14a Change to the following directory:
/opt/novell/teaming/luceneserver/indexserver/bin

14b Open the indexserver-startup.sh file in a text editor.
14c Add the following switch to the java launch command at the end of the script:

-Djava.rmi.server.hostname=ip_address

where ip_address is the IP address of the server where you installed the Lucene Index 
Server.

14d Save the indexserver-startup.sh file, then exit the text editor.
14e Start the Lucene Index Server.

For instructions for starting and stopping the Lucene Index Server manually, see 
Section 14.3, “Managing a Remote Lucene Index Server,” on page 111.

Moving the Lucene Index Server from the Teaming server to a remote server increases the 
scalability of your Teaming system because the workload is distributed between two different 
physical servers. However, in this configuration, the Lucene Index Server still runs on a single 
server. Your Teaming site depends on the Lucene Index Server for full functionality. If that server 
goes down for some reason, the Teaming site becomes inaccessible until access to the Lucene Index 
Server is restored. You can further expand your Teaming system by setting up multiple Lucene 
Index Servers to provide high availability, as described in Chapter 16, “Running Multiple Lucene 
Index Servers,” on page 119.

14.2  Updating Your Teaming Site
1 Stop Novell Teaming.
2 Start the Teaming Installation program to reconfigure the Lucene Index Server settings.
3 On the Choose Installation Type page, select Advanced, then click Next.
4 Click Next until you reach the Lucene Configuration page.
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5 In the Lucene configuration type field, select server to activate additional fields.
Host: Specify the hostname of the server where you installed the Lucene Index Server 
software.
RMI Port: Use the same port number that you used when you installed the Lucene Index 
Server software. The default RMI port is 1199.

6 Click Next until you reach the Ready to Install page, then click Install.
7 When the installation is complete, click Finish.
8 Start Teaming

14.3  Managing a Remote Lucene Index Server
Section 14.3.1, “Linux: Managing a Remote Lucene Index Server,” on page 111
Section 14.3.2, “Windows: Managing a Remote Lucene Index Server,” on page 111

14.3.1  Linux: Managing a Remote Lucene Index Server
Use the following commands to start and stop the Lucene Index Server manually:

/etc/init.d/indexserver start
/etc/init.d/indexserver stop

To configure the Lucene Index Server to start automatically when the Linux server reboots, use:

chkconfig --add indexserver

14.3.2  Windows: Managing a Remote Lucene Index Server
Use the following command at a DOS command prompt to start the Lucene Index Server manually:

c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin\
indexserver-startup.bat

To stop the Lucene Index Server, close the command prompt window where you started the Lucene 
Index Server. 
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To configure the Lucene Index Server to start automatically when the Windows server reboots, you 
can set it up as a scheduled task that runs at system startup.

1 On the Windows server where the Lucene Index Server is installed, click Start > All Programs 
> Accessories > System Tools > Scheduled Tasks.

2 Double-click Add Scheduled Task. to open the Scheduled Task Wizard, then click Next to 
continue.

3 Click Browse, then browse to and double-click the indexserver-startup.bat file in the 
following directory:
c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin

4 In the Task name field, specify an informative name for the task, such as Lucene Index Server.
The default task name is the name of the batch file.

5 In the Perform this task field, select When my computer starts, then click Next.
6 Specify and confirm the Administrator password for the Windows server, then click Next.
7 Select Open advanced properties for this task when I click Finish, then click Finish.
8 Verify that Run only if logged on is deselected, then click OK.

A new task with the name you specified in Step 4 is added to the list in the Scheduled Tasks 
window.

9 Click File > Exit to close the Scheduled Task Wizard.
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15Running Teaming on Multiple 
Servers

By running Novell® Teaming on multiple servers, you can achieve high availability functionality, 
including failover and load balancing, depending on how you configure your servers. You must 
perform an Advanced installation on each server in order to configure the Teaming software for such 
a clustered environment. 

Section 15.1, “Planning a Multi-Server Teaming Configuration,” on page 113
Section 15.2, “Installing the Teaming Software on Multiple Servers,” on page 113
Section 15.3, “Configuring a Web Application to Provide High Availability Functionality for 
Your Teaming Site,” on page 115

NOTE: This section assumes that you already have a Basic installation of Teaming up and running 
successfully. It is highly recommended to follow the instructions in Part II, “Basic Installation,” on 
page 25 before attempting a more complex Teaming configuration.

15.1  Planning a Multi-Server Teaming 
Configuration

Section 15.1.1, “Lucene Index Server Considerations,” on page 113
Section 15.1.2, “Teaming File Repository Considerations,” on page 113

15.1.1  Lucene Index Server Considerations
Before you can implement a multi-server Novell Teaming configuration, you must move your 
Lucene Index Server off of the initial Teaming server, as described in Chapter 14, “Moving the 
Lucene Index Server to a Remote Server,” on page 109. 

15.1.2  Teaming File Repository Considerations
Before you implement a multi-server Novell Teaming configuration, you must plan the Teaming file 
repository for the clustered Teaming servers. The Teaming file repository must be placed in a shared 
location that is accessible to all Teaming servers. For background information on the contents of the 
Teaming file repository, see Section 9.2, “Distributing Different Data Types to Different Locations,” 
on page 81.

15.2  Installing the Teaming Software on Multiple 
Servers

1 Update your existing Novell Teaming server to participate in a multi-server configuration.
1a Stop Teaming.
1b Start the Teaming Installation program.
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1c On the Installation Settings page, select Reconfigure Settings, then click Next.
1d On the Choose Installation Type page, select Advanced, then click Next.
1e Click Next to proceed through the installation pages where no changes are needed.
1f (Conditional) If you do not have the Basic Teaming Installation Summary Sheet and 

Advanced Teaming Installation Summary Sheet from the initial Teaming server 
installation, record the configuration of the initial Teaming server as you proceed through 
the installation pages.
Subsequent Teaming servers in the multi-server configuration must be installed with the 
same configuration settings as the initial Teaming server.

1g On the Teaming Cluster Configuration page, select Enable clustered environment, then 
click Next.

Selecting this option configures Ehcache (http://ehcache.sourceforge.net) for your 
Teaming cluster. If you need to have more than one cluster, see Section 15.3.3, 
“Configuring Ehcache for Multiple Clusters,” on page 117 for additional instructions.

1h On the Ready to Install page, click Install.
1i On the Installation Complete page, click Finish.

2 Install the Teaming software on each additional server, using the same installation settings that 
you used for the initial Teaming server.

3 (Conditional) On each Linux server where you installed the Teaming software, set the multicast 
route to enable the servers to function as a cluster:
3a Use the following command on the command line to immediately set the multicast route 

for the server:
route add -net 232.0.0.0/8 dev eth0

3b To run this command each time the server reboots, add the command to the following file 
on each server:
/etc/init.d/boot.local

4 Start Teaming on each server, as described for the platform where you are installing Teaming:
Section 4.1.5, “Starting Teaming on Linux,” on page 55
Section 4.2.3, “Running Teaming as a Windows Service,” on page 59
Section 4.2.4, “Running Teaming as a Windows Application,” on page 61

5 Continue with Configuring a Web Application to Provide High Availability Functionality for 
Your Teaming Site.
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15.3  Configuring a Web Application to Provide 
High Availability Functionality for Your Teaming 
Site
After the Novell Teaming software is installed and running on multiple servers, you must provide 
additional software to provide high availability functionality. Because Teaming is based on Tomcat, 
software that can provide high availability for Tomcat can be used to provide high availability for 
your Teaming site.

1 Install and configure one of the following Web applications to provide high availability 
functionality for your Teaming site:

Apache Web server (http://www.apache.org)
Linux Virtual Server (http://www.linuxvirtualserver.org)
Novell Access Manager (http://www.novell.com/products/accessmanager)
Microsoft Internet Information Services (http://www.iis.net)

2 Configure the Web application to establish the Teaming site URL, which then stays constant for 
Teaming users regardless of which Teaming server they access at any given time.

3 Start the Web application with its new configuration settings.
4 Test your Teaming site for high availability functionality.

If you are using Apache Web server, Linux Virtual Services, or Microsoft Internet 
Information Services, users can immediately log in to the Teaming site again after a 
failover has occurred. The connection between the user’s browser and the Teaming site is 
maintained as the failover occurs.
If you are using Novell Access Manager, users must start a new browser session, then log 
into the Teaming site after a failover has occurred. They cannot log in again from the same 
browser session because the connection between the user’s browser and the Teaming site 
must be reestablished after the failover.

Some illustrative examples are provided:

Section 15.3.1, “Configuring Tomcat and Apache as a Load Balancer,” on page 115
Section 15.3.2, “Configuring Linux Virtual Server as a Load Balancer,” on page 116
Section 15.3.3, “Configuring Ehcache for Multiple Clusters,” on page 117

15.3.1  Configuring Tomcat and Apache as a Load Balancer
The following example configuration uses the balancer module built into the newer Apache (version 
2.2.4) Web server, and is based on a widely used sticky session technique. Novell Teaming does not 
support session sharing/replication among Tomcat instances.

1 Edit the Tomcat server.xml file on each Teaming server.
The location of the server.xml file varies by platform:
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1a Search for jvmRoute.

A sample line with a jvmRoute tag is provided in a comment.
<Engine name="Catalina" defaultHost="localhost" jvmRoute="jvm1">

1b Update the active line below the comment so that it looks like the sample.
1c On the second Teaming server, make the same change, incrementing the jvmRoute 

setting.
<Engine name="Catalina" defaultHost="localhost" jvmRoute="jvm2">

1d Repeat Step 1c for each Teaming server, so that each Tomcat instance has a unique 
jvmRoute setting.

2 Install the Apache Web server (http://httpd.apache.org) on one server.
3 Edit the httpd.conf file in the Apache installation.

The httpd.conf file is located in the conf subdirectory in the Apache installation.
3a Locate and uncomment the following lines:

LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_ajp_module modules/mod_proxy_ajp.so
LoadModule proxy_balancer_module modules/mod_proxy_balancer.so

3b Append the following section to the httpd.conf file, providing a BalancerMember line 
for each jvmRoute value in a Tomcat server.xml file. 
<Location /balancer-manager>

SetHandler balancer-manager
Order deny,allow
Deny from all
Allow from 127.0.0.1

</Location>
<Proxy balancer://cluster_name>

BalancerMember ajp://teaming_server_1:8009 route=jvm1
BalancerMember ajp://teaming_server_2:8009 route=jvm2

</Proxy>
<Location />

ProxyPass balancer://cluster_name/ stickysession=JSESSIONID
</Location>

4 Restart Tomcat and Apache.

15.3.2  Configuring Linux Virtual Server as a Load Balancer
Consult the following online sources for instructions for setting up Linux Virtual Server as a load 
balancer for your Novell Teaming site:

The Linux Virtual Server Project (http://www.linuxvirtualserver.org)
Linux Virtual Server (LVS) Project (http://www.austintek.com/LVS)
Linux Virtual Server Tutorial (http://www.ultramonkey.org/papers/lvs_tutorial/html)

Linux: /opt/novell/teaming/apache-tomcat-version/conf

Windows: c:\Program Files\Novell\Teaming\apache-tomcat-version\conf
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15.3.3  Configuring Ehcache for Multiple Clusters
Ehcache (http://ehcache.sourceforge.net) is a distributed cache often used in a clustered Apache/
Tomcat environment. In such a cluster, each clustered Tomcat node knows about other nodes in the 
cluster by means of a common multicast group IP address that is specified in the ehcache-
hibernate-clustered.xml file.

The location of the ehcache-hibernate-clustered.xml file varies by platform:

The default multicast group IP address is 232.0.0.1. If you have more than one clustered Novell 
Teaming system (for example, one in the lab and one in production), or if you have another software 
product that is already using the default multicast group IP address, you must update the ehcache-
hibernate-clustered.xml file for one installation so that it uses an IP address other than the 
default.

1 On each clustered Teaming server, change to the directory where the ehcache-hibernate-
clustered.xml file is located, then open the file in a text editor.

2 Search for 232.
3 Replace the default address with a unique IP address.

Use an IP address in the range of 224.0.0.1 to 239.255.255.255.

IMPORTANT: Make sure that you specify the same IP address on all clustered Teaming 
nodes. 

4 Save the updated ehcache-hibernate-clustered.xml file.
5 Restart all Teaming nodes.

Linux: /opt/novell/teaming/apache-tomcat-version/
webapps/ssf/WEB-INF/classes/config

Windows: c:\Program Files\Novell\Teaming\apache-tomcat-version\
webapps\ssf\WEB-INF\classes\config
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16Running Multiple Lucene Index 
Servers

Your Novell® Teaming site depends on the Lucene Index Server for full functionality. Different 
Lucene configurations provide different levels of scalability and reliability:

You can install the Lucene Index Server on a different server from where Teaming is running so that 
both programs have access to more server memory, disk space, and CPU resources. However, the 
Teaming server and the Lucene Index Server must not have a firewall between them. The RMI 
protocol used for the Lucene Index Server port works only within a trusted local area network 
(LAN).

A Basic installation of Teaming places the Lucene Index Server on the same server where the 
Teaming software is installed.
To provide additional memory for the Lucene Index Server, you might already have configured 
it to run in its own memory space, as described in Section 9.5.3, “Running the Lucene Index 
Server in Its Own JVM,” on page 86. 
To provide additional disk space and memory for the Lucene Index Server, you might already 
have moved it to a different server, as described in Chapter 14, “Moving the Lucene Index 
Server to a Remote Server,” on page 109.

These configurations provide additional resources for the Lucene Index Server, but it is still a single 
point of failure for your Teaming site. If the Lucene Index Server goes down, the Teaming site 
becomes inaccessible until access to the Lucene Index Server is restored.

Running multiple Lucene Index Servers provides high availability functionality, so that if one 
Lucene Index Server goes down, Teaming users can still access the Teaming site because other 
Lucene Index Servers are still available.

Section 16.1, “Planning a High Availability Lucene Configuration,” on page 119
Section 16.2, “Setting Up a High Availability Lucene Configuration,” on page 120
Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 132
Section 16.4, “Synchronizing a High Availability Lucene Configuration,” on page 134

NOTE: This section assumes that you already have a Basic installation of Teaming up and running 
successfully. It is highly recommended that you follow the instructions in Part II, “Basic 
Installation,” on page 25 before attempting a more complex Teaming and Lucene configuration.

16.1  Planning a High Availability Lucene 
Configuration
A high availability Lucene Index Server configuration must include at least two different servers 
(either physical or virtual), referred to as “nodes” in the Novell Teaming Installation program. 
Lucene nodes in a high availability configuration can be set up on Linux servers, Windows servers, 
or both.
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Each Lucene node must have its own independent directory structure for index files. The default 
location for the index files for the Lucene Index Server varies by platform:

Each Lucene node needs a unique name, a descriptive title, and a static IP address. The name and 
title identify the node in the Teaming administrative interface. Typically, the Lucene Index Server 
listens on RMI port 1199 on its server, but you can configure it to use a different port number if the 
default port number is already in use.

If you have already accumulated index data on your initial Teaming server, you can choose to copy 
the index files to the Lucene nodes, or you can reindex the Teaming site after the new Lucene nodes 
are running. Depending on the amount of accumulated index data, reindexing can be a time-
consuming process.

The Teaming server and the Lucene nodes must not have a firewall between them. The RMI 
protocol used for the Lucene Index Server port works only within a trusted local area network 
(LAN).

16.2  Setting Up a High Availability Lucene 
Configuration

Section 16.2.1, “Changing from a Local Lucene Index Server,” on page 120
Section 16.2.2, “Changing from a Single Remote Lucene Index Server,” on page 123
Section 16.2.3, “Expanding an Existing High Availability Lucene Configuration,” on page 126
Section 16.2.4, “Changing Your Lucene Configuration without Teaming Site Down Time,” on 
page 128

16.2.1  Changing from a Local Lucene Index Server
To change from a local Lucene Index Server running on the Novell Teaming server, you must install 
the Lucene Index Server on two or more remote servers, then reconfigure Teaming for a high 
availability Lucene configuration.

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the number of Lucene nodes that you want in your 
high availability Lucene configuration.

ADVANCED TEAMING INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the name, description, IP address, and RMI port 
number for each Lucene node.
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NOTE: Although it is possible to use the Lucene Index Server on the Teaming server as one of the 
“remote” Lucene nodes, this is not a recommended configuration. Consider it only if you are 
restricted to two servers for your Teaming site.

1 Set up two or more Lucene nodes:
1a Install the Lucene Index Server on each node, as described in Section 14.1, “Installing the 

Lucene Software,” on page 109.
1b (Optional) Copy accumulated index data from the initial Lucene Index Server to each 

additional Lucene node.
The default location for the index files varies by platform:

1c Start the Lucene Index Server on each Lucene node, as described in Section 14.3, 
“Managing a Remote Lucene Index Server,” on page 111.

2 Stop Teaming.
If you have installed the Teaming software on multiple servers, as described in Chapter 15, 
“Running Teaming on Multiple Servers,” on page 113, stop Teaming on all servers, or follow 
the instructions in Section 16.2.4, “Changing Your Lucene Configuration without Teaming Site 
Down Time,” on page 128.

3 Run the Teaming Installation program to configure the Teaming server for multiple Lucene 
nodes.
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields, then click Next.

Lucene configuration type: Select high availability.
Number of high availability search nodes: Specify the number of Lucene nodes where 
you have installed and started the Lucene Index Server.

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene
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3e On the Configure High Availability Search Nodes page, specify the configuration 
information for each Lucene node from the Advanced Teaming Installation Summary 
Sheet that you filled out in Section 16.1, “Planning a High Availability Lucene 
Configuration,” on page 119, then click Next.

3f Click Next until you reach the Ready to Install page, then click Install.
3g On the Installation Complete page, click Finish.
3h Start Teaming.
3i (Conditional) If you have multiple Teaming servers, repeat Step 3 on each Teaming server.

4 Configure the Teaming site for the additional Lucene nodes:
4a Log in to the Teaming site as the Teaming administrator.
4b Click Manage > Site Administration.
4c Expand Manage the Search Index, then click Nodes.
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By default, the first Lucene node in the list has Read and Write access, meaning that 
Teaming updates it as new content is added to the Teaming site. By default, subsequent 
nodes in the list have Write Only access, meaning that the Teaming software can update 
content on the server, but users cannot access it. This setting is useful when you need to 
perform maintenance on a Lucene node, but it is not the setting you want when setting up 
a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes, click Apply, 
then click Close.
The new setting is put into effect immediately, so that users immediately have access to 
the additional Lucene nodes.

5 Skip to Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 132.

16.2.2  Changing from a Single Remote Lucene Index Server
To change from a single remote Lucene Index Servers to a high availability configuration, you must 
install the Lucene Index Server on one or more additional remote servers, then reconfigure Novell 
Teaming for additional Lucene nodes.

1 Bring down your Teaming site:
1a Stop Teaming.
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If you have installed the Teaming software on multiple servers, as described in 
Chapter 15, “Running Teaming on Multiple Servers,” on page 113, stop Teaming on all 
servers, or follow the instructions in Section 16.2.4, “Changing Your Lucene 
Configuration without Teaming Site Down Time,” on page 128.

1b Make sure that the existing remote Lucene Index Server also stops.
2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in 
Section 14.1, “Installing the Lucene Software,” on page 109.

2b (Optional) Copy accumulated index data from the initial remote Lucene node to each 
additional Lucene node.
The default location for the index files varies by platform:

2c Start the Lucene Index Server on each Lucene node, as described in Section 14.3, 
“Managing a Remote Lucene Index Server,” on page 111, but do not bring up your 
Teaming site.

3 Run the Teaming Installation program to configure the Teaming server for multiple Lucene 
nodes.
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields, then click Next.

Lucene configuration type: Change server to high availability.
Number of high availability search nodes: Specify the number of Lucene nodes where 
you have installed the Lucene Index Server.

3e On the Configure High Availability Search Nodes page, specify the configuration 
information for each Lucene node from the Advanced Teaming Installation Summary 
Sheet that you filled out in Section 16.1, “Planning a High Availability Lucene 
Configuration,” on page 119, then click Next.

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene
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3f Click Next until you reach the Ready to Install page, then click Install.
3g On the Installation Complete page, click Finish.
3h Start Teaming.
3i (Conditional) If you have multiple Teaming servers, repeat Step 3 on each Teaming server.

4 Configure the Teaming site for the additional Lucene nodes:
4a Log in to the Teaming site as the Teaming administrator.
4b Click Manage > Site Administration.
4c Expand Manage the Search Index, then click Nodes.

By default, the first Lucene node in the list has Read and Write access, meaning that 
Teaming updates it as new content is added to the Teaming site. By default, subsequent 
nodes in the list have Write Only access, meaning that the Teaming software can update 
content on the server, but users cannot access it. This setting is useful when you need to 
perform maintenance on a Lucene node, but it is not the setting you want when setting up 
a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes.
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4e Click Apply, then click Close.
The new setting is put into effect immediately, so that users immediately have access to 
the additional Lucene nodes.

5 Skip to Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 132.

16.2.3  Expanding an Existing High Availability Lucene 
Configuration
After you have set up an initial high availability Lucene configuration, you can add additional 
Lucene nodes at any time.

1 Bring down your Teaming site:
1a Stop Teaming.

If you have installed the Teaming software on multiple servers, as described in 
Chapter 15, “Running Teaming on Multiple Servers,” on page 113, stop Teaming on all 
servers, or follow the instructions in Section 16.2.4, “Changing Your Lucene 
Configuration without Teaming Site Down Time,” on page 128.

1b Stop all Lucene nodes, as described in Section 14.3, “Managing a Remote Lucene Index 
Server,” on page 111.

2 Set up one or more additional Lucene nodes:
2a Install the Lucene Index Server on each additional remote server, as described in 

Section 14.1, “Installing the Lucene Software,” on page 109.
2b (Optional) Copy accumulated index data from an existing Lucene node to each additional 

Lucene node.
The default location for the index files varies by platform:

2c Start the Lucene Index Server on each Lucene node, as described in Section 14.3, 
“Managing a Remote Lucene Index Server,” on page 111, but do not bring up your 
Teaming site.

3 Run the Teaming Installation program to configure the Teaming server for the additional 
Lucene nodes.
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, increase the number of nodes in the Number of high 

availability search nodes field, then click Next.

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene
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3e On the Configure High Availability Search Nodes page, specify the configuration 
information for each additional Lucene node, then click Next.

3f Click Next until you reach the Ready to Install page, then click Install.
3g On the Installation Complete page, click Finish.
3h Start Teaming.
3i (Conditional) If you have multiple Teaming servers, repeat Step 3 on each Teaming server.

4 Configure the Teaming site for the additional Lucene nodes:
4a Log in to the Teaming site as the Teaming administrator.
4b Click Manage > Site Administration.
4c Expand Manage the Search Index, then click Nodes.
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By default, the first Lucene node in the list has Read and Write access, meaning that 
Teaming updates it as new content is added to the Teaming site. By default, subsequent 
nodes in the list have Write Only access, meaning that the Teaming software can update 
content on the server, but users cannot access it. This setting is useful when you need to 
perform maintenance on a Lucene node, but it is not the setting you want when setting up 
a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to 
the additional Lucene nodes.

5 Skip to Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 132.

16.2.4  Changing Your Lucene Configuration without Teaming 
Site Down Time
Teaming site down time can be avoided only if you have installed the Novell Teaming software on 
multiple servers, as described in Chapter 15, “Running Teaming on Multiple Servers,” on page 113.

To change to a high availability Lucene configuration in a multiple Teaming server configuration:

1 Set up two or more Lucene nodes:
1a Install the Lucene Index Server on each node, as described in Section 14.1, “Installing the 

Lucene Software,” on page 109
1b Start the Lucene Index Server on each Lucene node, as described in Section 14.3, 

“Managing a Remote Lucene Index Server,” on page 111.
2 Stop Teaming on one server.

The other Teaming servers remain in service for users and continue to communicate with the 
original Lucene Index Server.

3 Run the Teaming Installation program on the Teaming server that you stopped to configure it 
for multiple Lucene Index Servers.
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
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3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields, then click Next.

Lucene configuration type: Select high availability.
Number of high availability search nodes: Specify the number of Lucene nodes where 
you have installed the Lucene Index Server.

3e On the Configure High Availability Search Nodes page, specify the configuration 
information for each Lucene node from the Advanced Teaming Installation Summary 
Sheet that you filled out in Section 16.1, “Planning a High Availability Lucene 
Configuration,” on page 119, then click Next.

3f Click Next until you reach the Ready to Install page, then click Install.
3g On the Installation Complete page, click Finish.

4 Start the reconfigured Teaming server.
5 Access the reconfigured Teaming server and prevent access to the additional Lucene nodes:

IMPORTANT: All Teaming servers must be reconfigured before any of them access the 
additional Lucene nodes.

5a Log in to the reconfigured Teaming server as the Teaming administrator, using the server 
hostname rather than your Teaming site URL.

5b Click Manage > Site Administration.
Running Multiple Lucene Index Servers 129



130 Novell

novdocx (en)  16 A
pril 2010
5c Expand Manage the Search Index, then click Nodes.

By default, the first Lucene node in the list has Read and Write access, meaning that 
Teaming updates it as new content is added to the Teaming site. By default, subsequent 
nodes in the list have Write Only access, meaning that the Teaming software can update 
content on the server, but users cannot access it. When setting up a high availability 
Lucene configuration without Teaming site down time, you need to prevent write access 
during the reconfiguration process.

5d In the User Mode Access box, change Write Only to No Access for the additional Lucene 
nodes.

5e Click Apply, then click Close.
The new setting is put into effect immediately, so that the reconfigured Teaming server 
does not communicate with the additional Lucene nodes. 

6 Reconfigure the rest of the Teaming servers:
6a Stop each Teaming server.
6b Repeat Step 3 to configure each Teaming server for the additional Lucene nodes.
6c Start each reconfigured Teaming server.

7 Access the reconfigured Teaming site and allow write access to the additional Lucene nodes:
7a Log in to the reconfigured Teaming as the Teaming administrator.
7b Click Manage > Site Administration.
7c Expand Manage the Search Index, then click Nodes.
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7d In the User Mode Access box, change No Access to Write Only for the additional Lucene 
nodes.

7e Click Apply, then click Close.
The new setting is put into effect immediately, so that the reconfigured Teaming servers 
can now communicate with the additional Lucene nodes, although user access is still 
disallowed. 

8 Reindex the Teaming site, so that the additional Lucene nodes are updated with the same index 
data that the original Lucene Index Server has:
8a On the Site Administration page, click Index.

8b Select Home Workspace, so that the entire Teaming site is reindexed.
8c Select the additional Lucene nodes, but do not select any previously existing nodes.
8d Click OK to start the indexing.

Depending on the size of your Teaming site, reindexing can be a time-consuming process. 
However, because one or more previously existing Lucene Index Servers are still 
servicing the Teaming site, users are not affected by the reindexing process.

8e When the reindexing is completed, click Close.
9 Make the additional Lucene nodes available to Teaming users:

9a On the Site Administration page, expand Mange the Search Index, then click Nodes.
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9b In the User Mode Access box, change Write Access to Read and Write for the additional 
Lucene nodes.

9c Click Apply, then click Close.
The new setting is put into effect immediately, so that Teaming users have additional 
Lucene Index Servers available as they use the Teaming site.

16.3  Testing Your Lucene High Availability 
Configuration
When you first set up your high availability Lucene configuration, you can configure Novell 
Teaming to write Lucene node information to the Tomcat log file so that you can observer the 
behavior of the Lucene nodes. Then you can take nodes down and bring them up again to see the 
effect on your Teaming site. This process helps you prepare for the situation where a Lucene node 
goes down unexpectedly or you need to take one down on purpose, perhaps for maintenance.

Section 16.3.1, “Configuring Teaming to Log Lucene Node Activity,” on page 132
Section 16.3.2, “Observing Lucene Node Activity,” on page 133

NOTE: For background information about the Tomcat log file, see “Tomcat Log File” in “Site 
Maintenance” in the Kablink Teaming 2.1 Administration Guide.

16.3.1  Configuring Teaming to Log Lucene Node Activity
By default, Novell Teaming writes an error to the Tomcat log file whenever it cannot communicate 
with a Lucene node. For testing purposes, you can increase the logging so that the Tomcat log file 
includes a message for each time Teaming contacts a Lucene Index Server. After observing and 
understanding the behavior, you should return the logging to normal levels.

1 Open the log4j.properties file in a text editor.
The location of the log4j.properties file varies by platform. 

Linux: /opt/novell/teaming/apache-tomcat-version/webapps/ssf/WEB-INF
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2 Search for the following line:
#log4j.category.com.novell.teaming.search=DEBUG

3 Remove the pound sign (#) from the beginning of the line to activate DEBUG level logging for 
the Lucene Index Server.

4 Save the log4j.properties file, then exit the text editor.
5 Stop Teaming, then start Teaming to put the new logging level into effect.

16.3.2  Observing Lucene Node Activity
After changing the Novell Teaming logging level to include Lucene node activity, you can monitor 
the Tomcat log file to see which Lucene nodes Teaming is contacting.

1 Change to the directory where the Tomcat log file is located.
For background information about the Tomcat log file, see “Tomcat Log File” in “Site 
Maintenance” in the Kablink Teaming 2.1 Administration Guide.

2 On Linux, use the tail command to monitor the end of the Tomcat log file.
tail -f catalina.out

or
On Windows, download an equivalent command from the Internet in order to perform the 
following steps.
For example, there is one available at SourceForge.net (http://sourceforge.net/projects/
tailforwin32).

3 Perform some activities on the Teaming site to create new content.
For example, you could create a blog entry. The Tomcat log file shows that Teaming is 
contacting each available Lucene Index Server in turn as it submits the new information for 
indexing. Nodes are considered available if they are marked Read and Write in the User Mode 
Access box on the Lucene Nodes page.

4 Bring down one of the Lucene nodes.
For example, you might reboot the Lucene server, stop the Lucene Index Server on the node, or 
otherwise prevent Teaming from contacting the Lucene node.

5 Observe that the Tomcat log file displays an error when the Lucene node becomes unavailable.
6 Perform some additional activities on the Teaming site that create new content.

You might notice a pause as Teaming tries to connect with the Lucene node that is no longer 
available.

7 Observe that the Tomcat log file shows when normal Teaming processing has resumed without 
access to the unavailable Lucene node.

8 Make the unavailable Lucene node available again.
9 Observe that the Tomcat log file indicates that Teaming has created a journal record on the 

Lucene node that was temporarily unavailable.

Windows: c:\Program Files\Novell\Teaming\apache-tomcat-version\
webapps\ssf\WEB-INF
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The journal record contains the indexing operations that failed to take place while the Lucene 
node was unavailable. Even though the Lucene node is back up, Teaming does not start 
accessing it until it has been synchronized with the latest index information.

10 To synchronize the out-of-date Lucene node, follow the steps in Section 16.4, “Synchronizing a 
High Availability Lucene Configuration,” on page 134.
After the out-of-date Lucene node has been synchronized, Teaming starts accessing it again.

If a situation arises where no Lucene node is marked Read and Write in the User Mode Access box 
on the Lucene Nodes page, Teaming temporarily accesses the first node in the list that is set Write 
Only. If no nodes are set to Write Only or Read and Write, Teaming temporarily access the first node 
in the list, even though it is set to No Access. This functionality is required because you cannot log in 
to the Teaming site without access to a Lucene Index Server.

16.4  Synchronizing a High Availability Lucene 
Configuration
Whenever a Lucene node is down for a relatively short period of time (no more than a couple of 
days), you can synchronize it with other Lucene nodes whose index files are up to date.

1 Make sure that the out-of-date Lucene node is running reliably again.
2 Log in to the Teaming site as the Teaming administrator.
3 Click Manage > Site Administration.
4 Expand Manage the Search Index, then click Nodes.

5 To repair the out-of-date Lucene node, select Apply Deferred Update Log Records to the Index, 
then click Apply.
The Deferred Update Log options disappear if the update is successful. If for some reason the 
deferred update log records cannot be applied to the index, you can rebuild the index, as 
described in “Rebuilding the Lucene Index” in “Site Maintenance” in the Kablink Teaming 2.1 
Administration Guide.

6 Click Close.
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17Running Multiple Database 
Servers

The three databases supported by Novell® Teaming (MySQL, Microsoft SQL, and Oracle) each 
have their own approach to clustering the database server. Information about clustering database 
servers is available on the Internet, for example:

MySQL Cluster (http://www.mysql.com/products/database/cluster)
SQL Server Clustering (http://www.sql-server-performance.com/articles/clustering/
clustering_intro_p1.aspx)
Oracle Real Application Clusters (http://www.oracle.com/technology/products/database/
clustering)

NOTE: It is highly recommended to follow the instructions in Part II, “Basic Installation,” on 
page 25 before attempting a more complex Teaming configuration.
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VUpdate

Chapter 18, “What’s New in Novell Teaming 2.x,” on page 139
Chapter 19, “Updating from Novell Teaming 2.0 to Novell Teaming 2.1,” on page 141
Chapter 20, “Updating from Novell Teaming 1.0 to Novell Teaming 2.1,” on page 147
Chapter 21, “Updating from Kablink Teaming 1.0 to Novell Teaming 2.1,” on page 157
Chapter 22, “Changing from Kablink Teaming 2.1 to Novell Teaming 2.1,” on page 159
Chapter 23, “Migrating Existing Novell Teaming Data into a New Teaming 2.1 System,” on 
page 161
Chapter 24, “Migrating from SiteScape Forum or Other Collaboration Software,” on page 169
Update 137



138 Novell

novdocx (en)  16 A
pril 2010
 Teaming 2.1 Installation Guide



18
novdocx (en)  16 A

pril 2010
18What’s New in Novell Teaming 2.x

Section 18.1, “Teaming 2.x User Enhancements,” on page 139
Section 18.2, “Teaming 2.x Installation Enhancements,” on page 139
Section 18.3, “Teaming 2.x Administration Enhancements,” on page 139

18.1  Teaming 2.x User Enhancements
For a list of Novell® Teaming enhancements and instructions for use, see:

“What’s New in Teaming” in the Novell Teaming 2.1 User Guide
“What’s New in Teaming” in the Novell Teaming 2.1 Advanced User Guide

18.2  Teaming 2.x Installation Enhancements
No Liferay dependency (v2.0): Novell Teaming 2.x is a standalone application with no 
dependency on Liferay. 
Built-in mail server for incoming posts (v2.0): Teaming 2.0 includes a build-in SMTP mail 
server for incoming e-mail. This allows Teaming users to easily post to folders in the Teaming 
site from their e-mail clients. For configuration instructions, see Section 3.7, “Enabling 
Inbound E-Mail,” on page 39.
Multiple Lucene Index Servers (v2.0): You can install multiple Lucene Index Servers to 
provide high availability for the Teaming site index. For setup instructions, see Chapter 16, 
“Running Multiple Lucene Index Servers,” on page 119.
Novell Access Manager Integration (v2.0): Novell Access Manager can provide single sign-
on access to your Teaming site. For configuration instructions, see Section 9.8, “Configuring 
Single Sign-On with Novell Access Manager,” on page 88.

18.3  Teaming 2.x Administration Enhancements
User/Entry Data Quota (v2.1): The Teaming administrator can set a maximum size limit for 
each Teaming user’s accumulated attached files and versions in any single folder entry. Users 
receive a warning when they reach a “high-water mark” (a percentage of their data quota for 
the folder entry). When they finally reach the data quota for the folder entry, users cannot create 
additional file attachments or versions in that folder entry until they free up space by deleting 
file attachments and versions in that folder entry. Administrators can assign data quotas on an 
individual user basis, or use groups to easily assign the same data quota to multiple users. For 
usage instructions, see “Managing User Disk Space Usage with User Data Quotas” in “Site 
Maintenance” in the Kablink Teaming 2.1 Administration Guide.
Administrative Purge for Workspaces and Folders (v2.1): Because deleted items count 
against users’ data quotas, the Teaming administrator can choose to purge deleted items from 
the Teaming site to free up storage space. For usage instructions, see “Purging Deleted Files” in 
“Site Maintenance” in the Kablink Teaming 2.1 Administration Guide.
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Workspace/Folder Export/Import (v2.1): The Teaming administrator can export 
workspaces, folders, and folder entries, then import them into a different Teaming system. The 
export process includes all content associated with the exported workspace, folder, or folder 
entry, such as users, groups, team members, roles, custom forms, landing pages, workflows, 
custom JSPs, and simple URLs. The import process attempts to reconcile imported data with 
data already existing in the target Teaming site. For usage instructions, see “Exporting/
Importing Workspaces, Folders, and Entries” in “Site Maintenance” in the Kablink Teaming 2.1 
Administration Guide.
Multiple LDAP queries (v2.0): Novell Teaming 2.x can search multiple LDAP containers for 
User objects so that Teaming user accounts can be set up for users distributed throughout your 
LDAP directory. For setup instructions, see Section 5.3, “Adding Teaming Users from Your 
LDAP Directory,” on page 65.
Multiple zones (v2.0): A zone is like a separate Teaming site that exists as a subset of your 
overall Teaming site. Different zones have different URLs and all data in different zones is kept 
completely separated. For setup instructions, see “Setting Up Zones (Virtual Teaming Sites)” in 
“Site Setup” in the Kablink Teaming 2.1 Administration Guide.
Software extensions (v2.0 / v2.1): You can enhance the functionality of your Teaming site by 
implementing software extensions. In Teaming 2.1, you can deploy extensions to the Teaming 
software while logged in to the Teaming site, without manually editing the Teaming properties 
file (ssf-ext.properties). Existing Teaming software extensions can also be viewed and 
deleted from the new Manage Extensions page on the Teaming site. For usage instructions, see 
“Adding Software Extensions to Your Teaming Site” in “Site Setup” in the Kablink Teaming 
2.1 Administration Guide.
Remote applications (v2.0): You can also expand the functionality of your Teaming site by 
running remote applications from the Teaming site. For setup instructions, see “Using Remote 
Applications on Your Teaming Site” in “Site Setup” in the Kablink Teaming 2.1 Administration 
Guide.
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19Updating from Novell Teaming 2.0 
to Novell Teaming 2.1

Section 19.1, “Understanding the Update Process from 2.0 to 2.1,” on page 141
Section 19.2, “Updating a Single-Server Teaming System from 2.0 to 2.1,” on page 141
Section 19.3, “Updating a Multiple-Server Teaming System from 2.0 to 2.1,” on page 143
Section 19.4, “Performing Post-Update Tasks,” on page 145

19.1  Understanding the Update Process from 2.0 
to 2.1
During the update from Novell® Teaming 2.0 to Teaming 2.1, the following aspects of your 
Teaming system are modified:

The Teaming software is updated from version 2.0 to 2.1.
The Teaming database is updated with a new database structure to support the new features in 
2.1. All teams, groups, roles, workspaces, and folders are preserved throughout the update 
process.
A backup copy of your existing Teaming installation is created in the following directory:
/opt/novell/teaming/teaming-backup

19.2  Updating a Single-Server Teaming System 
from 2.0 to 2.1
When you update a single-server Novell Teaming installation from version 2.0 to version 2.1, the 
Teaming Installation program can perform the entire update in a single process, unless the Teaming 
system uses an Oracle database.

1 Make sure you have a current backup of your Teaming 2.0 system.
2 Stop Teaming.
3 (Conditional) If your Teaming system uses an Oracle database, update the database as 

described in Section 19.2.1, “Updating an Oracle Database from 2.0 to 2.1,” on page 142 
before running the Teaming Installation program.

4 Copy the installer.xml file and the license-key.xml file from the directory where the 
Teaming 2.0 Installation program is located to the directory where you have extracted the 
Teaming 2.1 software.
The installer.xml file provides default values when you run the Teaming 2.1 Installation 
program, and you can use the same license file for Teaming 2.1 as your used for Teaming 2.0.

5 Start the Teaming 2.1 Installation program.
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If you need assistance with this task, see the detailed installation instructions for the platform 
where you are updating Teaming:

Section 4.1.2, “Running the Linux Teaming Installation Program,” on page 50
Section 4.2.2, “Running the Windows Teaming Installation Program,” on page 58

6 Accept the License Agreement, then click Next.

Because you provided your Teaming 2.0 installer.xml file in the directory with the Teaming 
2.1 Installation program, the Update software and settings installation option is selected by 
default.

7 Click Next to continue.
8 Click Yes to let the Installation program know that you have stopped Teaming.
9 Select the check box to let the Installation program know that you have backed up all of your 

Teaming data, then click Next.
10 Select Basic or Advanced, depending on the type of Teaming installation you are updating, then 

click Next.
11 Continue through the installation process, retaining or changing configuration information 

depending on the needs of your Teaming 2.1 system.
12 Click Install when you are ready to perform the update.

The Installation program might seem to pause at this point. It needs to update tables and 
indexes in the Teaming database. If you have a large database, this process can be time-
consuming.

13 Click Finish when the update is completed.
14 Start Teaming 2.1 in the same way that you have been starting Teaming 2.0

When you start Teaming for the first time after the update, it takes longer to start than usual 
because data in the Teaming database must be updated before the Teaming site is ready to use.

19.2.1  Updating an Oracle Database from 2.0 to 2.1
The Novell 2.1 Teaming Installation program can update MySQL and Microsoft SQL databases as 
part of the Teaming software update, but it cannot update an Oracle database. Therefore, if you are 
using Oracle, you must manually run the Teaming 2.1 database update script after you have stopped 
Teaming.

1 Change to the directory where the Teaming 2.1 Installation program is located.
2 Unzip the teaming-2.1.n-sql.zip file to create the update-2.0.0-2.1.n directory

The update-2.0.0-2.1.n directory contains an update script for each type of database 
(MySQL, Microsoft SQL, and Oracle).

3 Run the update-oracle.sql script to update the database structure.
 Teaming 2.1 Installation Guide
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sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle;
SQL>quit;

4 Return to Step 4 in Section 19.2, “Updating a Single-Server Teaming System from 2.0 to 2.1,” 
on page 141.

19.3  Updating a Multiple-Server Teaming System 
from 2.0 to 2.1
If your Novell Teaming 2.0 system is distributed across multiple servers, the Teaming 2.1 
Installation program can update Teaming components on the Teaming server, but you must manually 
update any Teaming components that you have placed on remote servers.

Section 19.3.1, “Manual Teaming Database Update,” on page 143
Section 19.3.2, “Manual Lucene Index Server Update,” on page 144

19.3.1  Manual Teaming Database Update
In order to update the Novell Teaming database when the Teaming Installation program cannot do it 
for you, you must run the Teaming 2.1 database update script. 

1 Stop Teaming.
2 Change to the directory where the Teaming 2.1 Installation program is located.
3 Unzip the teaming-2.1.n-sql.zip file to create the update-2.0.0-2.1.n directory

The update-2.0.0-2.1.n directory contains an update script for each type of database 
(MySQL, Microsoft SQL, and Oracle).

4 Copy the script for your database type to the server where the Teaming database is located.
5 Use the database client utility for your database type to run the script:

6 After you have updated the Teaming database:

MySQL: mysql -uusername -ppassword < /path/update-mysql.sql

Microsoft 
SQL:

osql -Uusername -Ppassword -i update-sqlserver.sql

You can also use the script with the SQL Server Express Utility (http://
www.microsoft.com/downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.

Oracle: sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;
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(Conditional) If your Lucene Index Server is also on a remote server, continue with 
Section 19.3.2, “Manual Lucene Index Server Update,” on page 144.
or
(Conditional) If all remaining Teaming components that need to be updated are on the Teaming 
server, follow the instructions in Section 19.2, “Updating a Single-Server Teaming System 
from 2.0 to 2.1,” on page 141.

19.3.2  Manual Lucene Index Server Update
In order to update your Novell Teaming index when the Teaming Installation program cannot do it 
for you, you need to run the Remote Lucene Server Installation program. 

1 Stop Teaming.
2 Stop the Lucene Index Server.
3 Copy the Teaming 2.1 Remote Lucene Server Installation program from the directory where 

the Teaming 2.1 Installation program is located to a convenient directory on the server where 
the remote Lucene Index Server is located.
The name of the Remote Lucene Server Installation program varies by platform:

Because you are updating from Teaming 2.0, the existing license file (license-key.xml) on 
the remote Lucene server still works with the Teaming 2.1 Remote Lucene Server Installation 
program.

4 Start the Teaming 2.1 Remote Lucene Server Installation program.
5 Accept the License Agreement, then click Next.
6 Select Update software and settings.
7 Click Next to continue.
8 Click Next to accept the installation location.
9 Click Next to accept the Java JDK location.

10 In the Host field, specify the hostname where you are installing the remote Lucene Index 
Server.

11 Change Lucene configuration settings as needed, then click Next.
For information about Lucene configuration settings, see Section 9.5.2, “Changing Lucene 
Configuration Settings,” on page 85.

12 Click Install to install the updated Lucene Index Server software.
13 Click Finish when the update is completed.
14 Start the Lucene Index Server.
15 Now that all remote Teaming components have been updated, follow the instructions in 

Section 19.2, “Updating a Single-Server Teaming System from 2.0 to 2.1,” on page 141.

Linux: lucene-installer.linux

Windows: lucene-installer.exe
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19.4  Performing Post-Update Tasks
After you start Novell Teaming 2.1, you can access your Teaming site as usual. However, you need 
to reset some aspects of the interface before you allow users to access the updated site. The interface 
reset affects only those definitions and templates that are included with the Teaming product. If you 
have created custom definitions and templates, they are unaffected by the interface reset.

IMPORTANT: If you have manually customized any definitions or templates that are included with 
the Teaming product, back up the files you have modified before performing the interface reset.

1 Log in to the Teaming site as the Teaming administrator.
2 Reset the public form and view definitions:

2a Click Manage > Site Administration > Form and View Designer.

2b Click Reset.
2c Click Select All, click OK to confirm, then click Close.

3 Reset the standard templates:
3a On the Site Administration page, click Manage Workspace and Folder Templates.

3b Click Reset.
3c Click OK to confirm, then click Close.

Your Teaming 2.1 site is now ready for use.

IMPORTANT: If Teaming users encounter problems displaying any pages on the Teaming site 
after the update, simply have them clear the browser cache.
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20Updating from Novell Teaming 1.0 
to Novell Teaming 2.1

Section 20.1, “Understanding the Update Process,” on page 147
Section 20.2, “Preparing Your Teaming System for Updating from 1.0 to 2.1,” on page 147
Section 20.3, “Updating a Single-Server Teaming System from 1.0 to 2.1,” on page 150
Section 20.4, “Updating a Multiple-Server Teaming System from 1.0 to 2.1,” on page 152
Section 20.5, “Performing Post-Update Tasks,” on page 155

20.1  Understanding the Update Process
The major change when you update from Novell® Teaming 1.0 to Novell Teaming 2.1 is that the 
Liferay portal is no longer used by your Teaming system. The Teaming 2.1 Installation program 
backs up your Teaming data and disconnects your Teaming system from the Liferay software that 
was installed as part of Teaming 1.0. No Teaming data is lost in this process. 

During the update from Teaming 1.0 to Teaming 2.1, the following aspects of your Teaming system 
are modified:

The Teaming software is updated from version 1.0 to 2.1.
The Teaming database is updated with a new database structure to support the new features in 
2.1. All teams, groups, roles, workspaces, and folders are preserved throughout the update 
process.
The Lucene Index Server is updated for improved functionality.
Teaming no longer uses an external e-mail system for inbound message delivery. Teaming 2.1 
includes an internal SMTP mail host for incoming messages. This implementation allows for 
the easy creation of simple URLs to facilitate posting to the Teaming site from e-mail clients.
The Liferay portal is eliminated from your Teaming installation. The Liferay data is backed up, 
so if you have made customizations to Liferay, they remain intact, but the Liferay portal is not 
left in a usable state after the Teaming files are removed from it. If you want to continue to use 
Liferay, you must set up a new, independent installation of Liferay and transfer any 
customizations that you have made to the Teaming version into the new, independent version. 
To obtain the latest version of Liferay, see Liferay Portal (http://www.liferay.com).
A backup copy of your existing Teaming installation is created in the following directory:
/opt/icecore/teaming-backup

20.2  Preparing Your Teaming System for 
Updating from 1.0 to 2.1

Section 20.2.1, “Updating Your Operating Environment,” on page 148
Section 20.2.2, “Backing Up Your Teaming 1.0 Data,” on page 148
Section 20.2.3, “Planning and Performing Your Update to Teaming 2.1,” on page 149
Section 20.2.4, “Entry Type Repair for Imported Files in Your Teaming 2.1 Site,” on page 149
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20.2.1  Updating Your Operating Environment
The following components of the Novell Teaming operating environment were supported for 
Teaming 1.0 but are not supported for Teaming 2.1:

Red Hat* Enterprise Linux 3 and 4
Oracle 9g
Microsoft SQL Server 2000

If the operating environment for your Teaming system includes any of these components, you must 
update the components before your update to Teaming 2.1. For currently supported versions, see 
Chapter 2, “Teaming System Requirements,” on page 19.

For assistance with updating your operating system, see Chapter 23, “Migrating Existing Novell 
Teaming Data into a New Teaming 2.1 System,” on page 161.

20.2.2   Backing Up Your Teaming 1.0 Data
Novell Teaming data is stored in the Teaming file repository and in the Teaming database. Make 
sure that you back up both kinds of Teaming data. In addition, you might want to back up your log 
files.

“Teaming File Repository” on page 148
“Teaming Database” on page 148
“Teaming and Tomcat Log Files” on page 149

Teaming File Repository

The default file location for the Novell Teaming 1.0 file repository varies by platform:

The default locations for Teaming 2.1 are different, as listed in Section 3.2.4, “Teaming Installation 
Locations,” on page 30, but the Teaming 2.1 Installation program does not move the data as part of 
the update process. If you have performed an Advanced installation and have distributed different 
types of Teaming data to different locations, check the installer.xml file located in the same 
directory with the Teaming 1.0 Installation program to make sure that you have backed up all 
different types of Teaming data.

Teaming Database

The default database locations have remained the same from Novell Teaming 1.0 to Novell Teaming 
2.1, as listed in Section 3.5.3, “Database Location,” on page 35. However, if your database 
administrator created the Teaming database in a different location, either on the Teaming server or 
on a remote server, you need to know where it is and make sure that it is backed up before you 
perform the Teaming update. Check the installer.xml file for the location, if necessary.

Linux: /home/icecoredata

Windows: c:\teaming
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Teaming and Tomcat Log Files

The update process eliminates all existing Teaming and Tomcat log files. If you want to retain these 
log files, copy them to a location outside of the Teaming software directory structure.

The Teaming 1.0 log file (ssf.log) is located here:

The Tomcat log file (catalina.out on Linux and stdout_*.log on Windows) is located here:

20.2.3  Planning and Performing Your Update to Teaming 2.1
After confirming that you have backed up your Novell Teaming data, the Teaming 2.1 Installation 
program performs either a Basic installation or an Advanced installation of Teaming 2.1. As 
defaults, it uses the configuration information stored in the Teaming 1.0 installer.xml file. 

In preparation for the update, review Chapter 3, “Planning a Basic Teaming Installation,” on page 27 
and fill out the Basic Teaming Installation Summary Sheet. If you performed an Advanced 
installation for Teaming 1.0, review Chapter 9, “Planning an Advanced Teaming Installation,” on 
page 81 and fill out the Advanced Teaming Installation Summary Sheet. 

To update your Teaming site, follow the instructions in Chapter 4, “Setting Up a Basic Teaming 
Site,” on page 49 or Chapter 10, “Performing an Advanced Teaming Installation,” on page 93.

20.2.4  Entry Type Repair for Imported Files in Your Teaming 2.1 
Site
In Novell Teaming 1.0, if you used the Add Files to Folder feature to drag and drop a directory full 
of files into a Teaming folder, the files were automatically given the Discussion entry type, even if 
the Teaming folder was not a Discussion folder. In addition, if the directory contained subdirectories 
of files, the subdirectories were created as Teaming Discussion folders. 

If you want to change the entry type and folder type to match the top-level Teaming folder type in 
Teaming 2.1, you can enable the Recursive Apply feature on the Configure Default Settings page of 
the top-level Teaming folder by editing the Teaming ssf-ext.properties file.

1 On the Teaming server, change to the directory where the ssf-ext.properties file is 
located.
The default location of this file varies by platform:

Linux: /opt/icecore/liferay-portal-tomcat-version-jdk5-version/
webapps/ssf/WEB-INF/logs

Windows: c:\icecore\liferay-portal-tomcat-version-jdk5-version\
webapps\ssf\WEB-INF\logs

Linux: /opt/icecore/liferay-portal-tomcat-version-jdk5-version/logs

Windows: c:\icecore\liferay-portal-tomcat-version-jdk5-version\logs

Linux: /opt/novell/teaming/apache-tomcat-version/webapps/
ssf/WEB-INF/classes/config
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2 Make a backup copy of the ssf-ext.properties file.
3 Open the ssf-ext.properties file in a text editor, then scroll to the bottom of the file.
4 Add the following line:

ssf.allowFolderDefinitionFixups=true

5 Save the ssf-ext.properties file, then exit the text editor.
6 Restart Teaming to put the change into effect.
7 To change the entry types and folder types for imported files, follow the instructions in 

“Recursively Applying Folder Entry Types” in “Managing Folders” in the Novell Teaming 2.1 
Advanced User Guide.

20.3  Updating a Single-Server Teaming System 
from 1.0 to 2.1
When you update a single-server Novell Teaming installation from version 1.0 to version 2.1, the 
Teaming 2.1 Installation program can perform the entire update in a single process, unless the 
Teaming system uses an Oracle database.

1 Stop Teaming.
2 (Conditional) If your Teaming system uses an Oracle database, update the database as 

described in Section 20.3.1, “Updating an Oracle Database from 1.0 to 2.1,” on page 151 
before running the Teaming 2.1 Installation program.

3 Copy the installer.xml file from the directory where the Teaming 1.0 Installation program 
is located to the directory where you have extracted the Teaming 2.1 software.

4 Remove old license file from your Teaming 1.0 system and make sure that you have a 
license-key.xml file in the same directory with the Teaming 2.1 Installation program.

5 Start the Teaming 2.1 Installation program.
If you need assistance with this task, see the detailed installation instructions for the platform 
where you are updating Teaming:

Section 4.1.2, “Running the Linux Teaming Installation Program,” on page 50
Section 4.2.2, “Running the Windows Teaming Installation Program,” on page 58

6 Accept the License Agreement, then click Next.

Because you provided your Teaming 1.0 installer.xml file in the directory with the Teaming 
2.1 Installation program, the Update software and settings installation option is selected by 
default.

Windows: c:\Program Files\Novell\Teaming\apache-tomcat-version\webapps\
ssf\WEB-INF\classes\config
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7 Click Next to continue.
8 Click Yes to let the Installation program know that you have stopped Teaming.
9 Select the check box to let the Installation program know that you have backed up all of your 

Teaming data, then click Next.
10 Select Basic or Advanced, depending on the type of Teaming installation you are updating, then 

click Next.
11 Continue through the installation process, using the configuration information gathered on the 

Teaming Installation Summary Sheet.
12 Click Install when you are ready to perform the update.

The Installation program might seem to pause at this point. It needs to update tables and 
indexes in the Teaming database. If you have a large database, this process can be time-
consuming.

13 Click Finish when the update is completed.
14 Start Teaming 2.1.

When you start Teaming 2.1 for the first time after the update, it takes longer to start than usual 
because data in the Teaming database must be updated before the Teaming site is ready to use.

20.3.1  Updating an Oracle Database from 1.0 to 2.1
The Novell Teaming Installation program can update MySQL and Microsoft SQL databases as part 
of the Teaming software update, but it cannot update an Oracle database. Therefore, if you are using 
Oracle, you must manually run the Teaming 2.1 database update scripts after you have stopped 
Teaming.

1 Change to the directory where the Teaming 2.1 Installation program is located.
2 Unzip the teaming-2.1.n-sql.zip file to create the update-1.0.0-2.0.n directory and the 

update-2.0.0-2.1.n directory.

These directories contains an update script for each type of database (MySQL, Microsoft SQL, 
and Oracle).

3 Change to the update-1.0.0-2.0.n directory.

Linux: New command: 

/etc/init.d/teaming start

For more information, see Section 4.1.5, “Starting Teaming on Linux,” on page 55.

Windows: Same command, different directory: 

c:\Program Files\Novell\Teaming\apache-tomcat-version\
bin\startup.bat

NOTE: The default locations for Teaming 2.1 are different from 1.0, as listed in 
Section 3.2.4, “Teaming Installation Locations,” on page 30, but the Teaming 
Installation program does not move the Teaming installation as part of the update 
process. 

For more information, see Section 4.2.3, “Running Teaming as a Windows Service,” on 
page 59 and Section 4.2.4, “Running Teaming as a Windows Application,” on page 61.
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4 Run the update-oracle.sql script to update the database structure from 1.0 to 2.0.
sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle;
SQL>quit;

5 Change to the update-2.0.0-2.1.n directory.
6 Run the update-oracle.sql script to update the database structure from 2.0 to 2.1.

sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle;
SQL>quit;

7 Return to Section 20.3, “Updating a Single-Server Teaming System from 1.0 to 2.1,” on 
page 150.

20.4  Updating a Multiple-Server Teaming System 
from 1.0 to 2.1
If your Novell Teaming 1.0 system is distributed across multiple servers, the Teaming 2.1 
Installation program can update Teaming components on the Teaming server, but you must manually 
update any Teaming components that you have placed on remote servers.

Section 20.4.1, “Manual Teaming Database Update,” on page 152
Section 20.4.2, “Manual Lucene Index Server Update,” on page 153

20.4.1  Manual Teaming Database Update
In order to update the Novell Teaming 1.0 database when the Teaming Installation program cannot 
do it for you, you must run the Teaming 2.1 database update scripts on the database server.

1 Stop Teaming.
2 Change to the directory where the Teaming 2.1Installation program is located.
3 Unzip the teaming-2.1.n-sql.zip file to create the update-1.0.0-2.0.n directory and the 

update-2.0.0-2.1.n directory.

These directories contain update scripts for each type of database (MySQL, Microsoft SQL, 
and Oracle).

4 Change to the update-1.0.0-2.0.n directory.
5 Copy the update script for your database type to the server where the Teaming database is 

located.
6 On the database server, use the database client utility for your database type to run the update 

script to convert the Teaming database structure from 1.0 to 2.0:

MySQL: mysql -uusername -ppassword < /path/update-mysql.sql

Microsoft 
SQL:

osql -Uusername -Ppassword -i update-sqlserver.sql

You can also use the script with the SQL Server Express Utility (http://
www.microsoft.com/downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.
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7 Return to directory where the Teaming 2.1 Installation program is located.
8 Change to the update-2.0.0-2.1.n directory.
9 Copy the update script for your database type to the server where the Teaming database is 

located.
The update script for converting the database from 2.0 to 2.1 has the same name as the update 
script for converting from 1.0 to 2.0, so you overwrite the first update script when you copy the 
second update script to your database server.

10 On the database server, use the client utility for your database type to run the update script to 
convert the Teaming database structure from 2.0 to 2.1.

11 After you have updated the Teaming database to 2.1:
(Conditional) If your Lucene Index Server is also on a remote server, continue with 
Section 20.4.2, “Manual Lucene Index Server Update,” on page 153.
or
(Conditional) If all Teaming components that need to be updated are on the Teaming server, 
follow the instructions in Section 20.3, “Updating a Single-Server Teaming System from 1.0 to 
2.1,” on page 150.

20.4.2  Manual Lucene Index Server Update
In order to update your Novell Teaming index when the Teaming Installation program cannot do it 
for you, you need to run the Teaming 2.1 Remote Lucene Server Installation program. 

The default location for the Lucene Index Server software has change from Teaming 1.0 to Teaming 
2.1:

You can update the Lucene Index Server software in its current Teaming 1.0 location or you can 
install to the new Teaming 2.1 default location.

The default location for the Lucene index has also changed from Teaming 1.0 to Teaming 2.1:

Oracle: sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;

Linux: Teaming 1.0: /opt/icecore/luceneserver

Teaming 2.1: /opt/novell/teaming/luceneserver

Windows: Teaming 1.0: c:\icecore\luceneserver

Teaming 2.1: c:\Program Files\Novell\Teaming\luceneserver

Linux: Teaming 1.0: /home/icecoredata/lucene

Teaming 2.1: /var/opt/novell/teaming/lucene

Windows: Teaming 1.0: c:\home\icecoredata\lucene

Teaming 2.1: c:\Novell\Teaming\lucene
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Because you need to reindex your Teaming site after performing the update, the Teaming 2.1 Lucene 
index is created in the new default location.

1 Stop Teaming.
2 Stop the Lucene Index Server by using the following command in the directory where the 

Lucene Index Server is currently installed:

3 Copy the Teaming 2.1 Remote Lucene Server Installation program and the Teaming 2.1 license 
file (license-key.xml) from the directory where the Teaming 2.1 Installation program is 
located to a convenient directory on the server where the remote Lucene Index Server is 
located.
The name of the Remote Lucene Server Installation program varies by platform:

4 Start the Remote Lucene Server Installation program.
5 Accept the License Agreement, then click Next.
6 Select Update software and settings to install to the current Teaming 1.0 location.

or
Select New installation to install to the new Teaming 2.1 location.

7 Click Next to continue.
8 Click Next to accept the installation location.
9 Click Next to accept the Java JDK location.

10 In the Host field, specify the hostname where you are installing the remote Lucene Index 
Server.

11 Change Lucene configuration settings as needed, then click Next.
For information about Lucene configuration settings, see Section 9.5.2, “Changing Lucene 
Configuration Settings,” on page 85.

12 Click Install to install the updated Lucene Index Server software.
13 Click Finish when the update is completed.
14 Start the Lucene Index Server.

15 Now that all remote Teaming components have been updated, follow the instructions in 
Section 20.3, “Updating a Single-Server Teaming System from 1.0 to 2.1,” on page 150.

Linux: ./indexserver-stop.sh

Windows: indexserver-stop.bat

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Linux: ./indexserver-startup.sh

Windows: indexserver-startup.bat
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20.5  Performing Post-Update Tasks
After you start Novell Teaming 2.1, you can access your Teaming site as usual. However, you need 
to reindex the site and reset some aspects of the interface before you allow users to access the 
updated site. The reindexing process can consume a substantial amount of time for a large Teaming 
site. The interface reset affects only those definitions and templates that are included with the 
Teaming product. If you have created custom definitions and templates, they are unaffected by the 
interface reset.

IMPORTANT: If you have manually customized any definitions or templates that are included with 
the Teaming product, back up the files you have modified before performing the interface reset.

1 Log in to the Teaming site as the Teaming administrator.
2 Click Manage > Site Administration > Form and View Designer, click Reset, then click Close.

3 On the Site Administration page, click Manage Workspace and Folder Templates, click Reset, 
then click Close.

4 On the Site Administration page, click Manage the Search Index, select the Home Workspace, 
then click OK. 
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5 When the indexing is completed, click Close.
6 Update the LDAP configuration for your Teaming site.

In Teaming 1.0, if you did not want Teaming to search the entire directory service for users, you 
specified the search context right after the URL for the LDAP server. In Teaming 2.1, you 
specify the search context in a separate field. The syntax that worked for Teaming 1.0 does not 
work for Teaming 2.1.
6a On the Site Administration page, click Configure LDAP.

6b If the LDAP server URL field includes an object context, move that object context down 
to the Base DN field.

7 Select Run Immediately, then click Apply to test your change.
8 If your revised LDAP connection is valid, click Close.

Your Teaming 2.1 site is now ready for use.

IMPORTANT: If Teaming users encounter problems displaying any pages on the Teaming site 
after the update, simply have them clear the browser cache.
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21Updating from Kablink Teaming 
1.0 to Novell Teaming 2.1

To update from Kablink® Teaming 1.0 to Novell® Teaming 2.1, you must first purchase Novell 
Teaming 2.1 in the Novell Customer Center (http://www.novell.com/customercenter). After you 
obtain the license and download the Novell Teaming 2.1 software, following the instructions in 
Chapter 20, “Updating from Novell Teaming 1.0 to Novell Teaming 2.1,” on page 147

See also Chapter 22, “Changing from Kablink Teaming 2.1 to Novell Teaming 2.1,” on page 159.
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22Changing from Kablink Teaming 
2.1 to Novell Teaming 2.1

To change from Kablink® Teaming 2.1 to Novell® Teaming 2.1, you must first purchase Novell 
Teaming 2.1 in the Novell Customer Center (http://www.novell.com/customercenter).

After you obtain the license and download the Novell Teaming 2.1 software:

1 Stop Kablink Teaming.
2 In the directory where you downloaded the Novell Teaming 2.1 software, rename the license 

file that came with the software to the name license-key.xml.
The Novell Teaming Installation program does not start unless there is a license-key.xml 
file in the same directory with the Installation program.

3 Install Novell Teaming using the same options that you used to install Kablink Teaming, as 
described in:

Chapter 3, “Planning a Basic Teaming Installation,” on page 27
Chapter 9, “Planning an Advanced Teaming Installation,” on page 81

4 Start Novell Teaming, as described for the platform where you installed Teaming:
Section 4.1.5, “Starting Teaming on Linux,” on page 55
Section 4.2.3, “Running Teaming as a Windows Service,” on page 59
Section 4.2.4, “Running Teaming as a Windows Application,” on page 61

5 Verify that your Teaming license has been updated from Kablink to Novell:
5a Log in to the Teaming site as the Teaming administrator.
5b Click Manage > Site Administration > Reports > Licensing.
5c Verify that a Novell Teaming license is now listed.
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23Migrating Existing Novell Teaming 
Data into a New Teaming 2.1 
System

If your existing Novell®Teaming system has outgrown the server where you originally set it up, or 
you want to move to a different operating system, you can install Teaming 2.1 on a new server, then 
migrate your existing Teaming data from a Teaming 1.0 or 2.0 system to your new Teaming 2.1 
system. This is especially helpful if you created your Teaming system using the Virtual Eval version 
of the Novell Teaming Starter Pack (http://www.novell.com/products/teaming/starterpack.html).

Section 23.1, “Linux Migration with a MySQL Database,” on page 161
Section 23.2, “Windows Migration with an MS SQL Database,” on page 165

NOTE: In these instructions, “target server” refers to the server where you install the Teaming 2.1 
software, and “source server” refers to your existing Teaming 1.0 or 2.0 server from which you are 
migrating Teaming data.

The instructions in this section are based on a single-server Teaming configuration. If you have a 
multi-server Teaming configuration, the single-server instructions can serve as a foundation to get 
you started with your more complex migration process.

This section does not include instructions for migrating an Oracle database. Use the instructions for 
your Teaming platform as a guideline for the tasks that are involved in migrating Teaming data, then 
apply these guidelines to your Oracle database migration.

23.1  Linux Migration with a MySQL Database
Section 23.1.1, “Preparing the Target Linux Server,” on page 161
Section 23.1.2, “Preparing the Source Linux Server,” on page 162
Section 23.1.3, “Transferring Data from the Source Server to the Target Server,” on page 162
Section 23.1.4, “Importing the Teaming Database to the Target Server,” on page 163
Section 23.1.5, “Updating the Teaming Database on the Target Server,” on page 163
Section 23.1.6, “Updating the Zone Name from Teaming 1.0 to Teaming 2.1 (Conditional),” on 
page 164
Section 23.1.7, “Finalizing Your New Teaming 2.1 Site,” on page 164

23.1.1  Preparing the Target Linux Server
On the target server:

1 Install the Teaming 2.1 software on the target server, as described in Part II, “Basic 
Installation,” on page 25, paying special attention to these important details:

Set up the same Linux user to run the Teaming software that has been used to run the 
Teaming software in the past.
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Select the same encryption algorithm for the Teaming database. 

IMPORTANT: If the database encryption algorithms do not match between the source 
and target Teaming systems, you cannot log in to the new Teaming 2.1 site.

2 Start Teaming on the target server.
3 Verify that the new Teaming site is working as expected.
4 Stop Teaming on the target server.

23.1.2  Preparing the Source Linux Server
On the source server:

1 Stop Teaming.
2 Back up your existing database:

mysqldump -uusername -ppassword sitescape > sitescape.sql

This creates a file named sitescape.sql in the directory where you executed the mysqldump 
command.

3 Make sure that you have a recent backup of your entire Teaming system.

23.1.3  Transferring Data from the Source Server to the Target 
Server
On the source server:

1 Mount the target server to the source server so that data can be copied from one server to the 
other.

2 In a terminal window on the source server, become the Linux user that runs the Teaming 
software. 

3 (Conditional) If you are migrating data from Teaming 1.0:
3a Copy your existing Teaming file repository to the target server:

IMPORTANT: Do not copy the liferay directory.

3b Copy the database backup of your existing Teaming database (sitescape.sql file) that 
you created in Step 2 in Section 23.1.2, “Preparing the Source Linux Server,” on page 162 
to a convenient temporary location on the target server.

3c Copy your existing Teaming Lucene index to the target server:

From: /home/icecoredata

To: /var/opt/novell/teaming

From: /home/icecoredata/lucene

To: /var/opt/novell/teaming/lucene
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In Teaming 2.1, the lucene directory now contains kablink and liferay.com 
directories.

3d Delete the empty kablink directory.
3e Rename the liferay.com directory where your existing Teaming database resides to 

kablink, which is the Teaming 2.1 zone name.
3f Copy your existing software extensions to the target server:

In Teaming 2.1, the extensions directory now contains the kablink and liferay.com 
directories.

3g Delete the empty kablink directory.
3h Rename the liferay.com directory where your existing software extensions reside to 

kablink, which is the Teaming 2.1 zone name.
4 (Conditional) If you are migrating data from Teaming 2.0:

4a Copy your existing Teaming file repository from /var/opt/novell/teaming on the 
source server to the same location on the target server.

4b Copy the database backup of your existing Teaming database (sitescape.sql file) that 
you created in Step 2 in Section 23.1.2, “Preparing the Source Linux Server,” on page 162 
to a convenient temporary location on the target server.

4c Copy your existing Teaming database index from /var/opt/novell/teaming/lucene 
on the source server to the same location on the target server.

4d Copy your existing software extensions from /var/opt/novell/teaming/extensions 
on the source server to the same location on the target server.

23.1.4  Importing the Teaming Database to the Target Server
On the target server:

1 Remove the empty Teaming database that was created when you installed the Teaming 2.1 
software:
mysql>drop sitescape;

2 Change to the directory where you copied the sitescape.sql file in Step 3b or Step 4b in 
Section 23.1.3, “Transferring Data from the Source Server to the Target Server,” on page 162.

3 Manually re-create the Teaming database with the data that you copied from the source server:
mysql -uusername -ppassword sitescape < sitescape.sql

23.1.5  Updating the Teaming Database on the Target Server
On the target server:

1 (Conditional) If your are updating from Teaming 1.0 to 2.1, unzip the update-1.0.0-
2.0.n.zip file, change to the resulting update-1.0.0-2.0.n directory, then run the update 
script to update the Teaming database from Teaming 1.0 to 2.0:

From: /home/icecoredata/extensions

To: /var/opt/novell/teaming/extensions
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mysql -uusername -ppassword < update-mysql.sql

For more complete database update instructions, refer to Section 20.4.1, “Manual Teaming 
Database Update,” on page 152. 

2 To update from Teaming 2.0 to 2.1, unzip the update-2.0.0-2.1.n.zip file, change to the 
resulting update-2.0.0-2.1.n directory, then run the update script to update the Teaming 
database from Teaming 2.0 to 2.1:
mysql -uusername -ppassword < update-mysql.sql

For more complete database update instructions, refer to Section 19.3.1, “Manual Teaming 
Database Update,” on page 143. 

23.1.6  Updating the Zone Name from Teaming 1.0 to Teaming 
2.1 (Conditional)
In Teaming 1.0, the default zone name was liferay.com. Starting in Teaming 2.0, the default zone 
name is kablink. If your Teaming site originated as Teaming 2.0, rather than 1.0, skip to 
Section 23.1.7, “Finalizing Your New Teaming 2.1 Site,” on page 164.

If your Teaming site originated as Teaming 1.0, you must reset the default zone name.

On the target server:

1 Change to the following directory:
/opt/novell/teaming/apache-tomcat-version/webapps/

ssf/WEB-INF/classes/config

2 View the following files to ensure that the current zone name is set to kablink.
zone.cfg.xml
zone-ext.cfg.xml

3 Use the following commands to update the Teaming database with the new default zone name:
mysql -uusername -ppassword 
mysql>use sitescape; 
mysql>update SS_ZoneInfo set zoneName='kablink' 

where zoneName='liferay.com'; 
mysql>update SS_Forums set name='kablink' where name='liferay.com';

4 Find and rename any liferay.com subdirectories to kablink.
You might or might not find liferay.com subdirectories in the following locations, so you 
should check them all:
/var/opt/novell/teaming/filerepository
/var/opt/novell/teaming/lucene
/var/opt/novell/teaming/extensions
/var/opt/novell/teaming/archivestore
/var/opt/novell/teaming/cachefilestore

23.1.7  Finalizing Your New Teaming 2.1 Site
1 Start Teaming 2.1, as described in Section 4.1.5, “Starting Teaming on Linux,” on page 55.
2 Reindex the Teaming site, as described in “Rebuilding the Lucene Index” in “Site 

Maintenance” in the Kablink Teaming 2.1 Administration Guide.
Your Teaming site should now function just as it did on the original source server.
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23.2  Windows Migration with an MS SQL 
Database

Section 23.2.1, “Preparing the Target Windows Server,” on page 165
Section 23.2.2, “Preparing the Source Windows Server,” on page 165
Section 23.2.3, “Transferring Data from the Source Server to the Target Server,” on page 166
Section 23.2.4, “Importing the Teaming Database to the Target Server,” on page 167
Section 23.2.5, “Updating the Teaming Database on the Target Server,” on page 167
Section 23.2.6, “Updating the Zone Name from Teaming 1.0 to Teaming 2.1 (Conditional),” on 
page 168
Section 23.2.7, “Finalizing Your New Teaming 2.1 Site,” on page 168

23.2.1  Preparing the Target Windows Server
On the target server:

1 Install the Teaming 2.1 software, as described in Part II, “Basic Installation,” on page 25.

IMPORTANT: Select the same encryption algorithm for the Teaming database. If the database 
encryption algorithms do not match between the source and target systems, you cannot log in to 
the new Teaming 2.1 site.

2 Start Teaming on the target server.
3 Verify that the new Teaming site is working as expected.
4 Stop Teaming on the target server.

23.2.2  Preparing the Source Windows Server
On the source server:

1 Stop Teaming.
2 Back up your existing Teaming database:

2a In Microsoft SQL Server Management Studio, browse to and right-click the existing 
Teaming database (named sitescape), then click Tasks > Back Up.

2b For Backup type, select Full.
2c Set other backup options as desired, then click OK.

This creates a file named sitescape.bak in the following directory:
c:\Program Files\Microsoft SQL Server\MSSQL\Backup

3 Make sure that you have a recent backup of your entire Teaming system.
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23.2.3  Transferring Data from the Source Server to the Target 
Server
On the source server:

1 Map a drive from the destination server to the source server so that data can be copied from one 
server to the other.

2 (Conditional) If you are migrating data from Teaming 1.0:
2a Copy your existing Teaming file repository to the target server

IMPORTANT: Do not copy the liferay directory.

2b Copy the database backup of your existing Teaming database (sitescape.bak file) from 
the source server to the same location on the target server.
You created this file Step 2 in Section 23.2.2, “Preparing the Source Windows Server,” on 
page 165.

2c Copy your existing Teaming Lucene index to the target server:

In Teaming 2.1, the lucene directory now contains the kablink and liferay.com 
directories.

2d Delete the empty kablink directory.
2e Rename the liferay.com directory where your existing Teaming database resides to 

kablink.
3 Copy your existing software extensions to the target server:

In Teaming 2.1, the extensions directory now contains kablink and liferay.com 
directories.

4 Delete the empty kablink directory.
5 Rename the liferay.com directory where your existing software extensions reside to 

kablink.
6 (Conditional) If you are migrating data from Teaming 2.0:

6a Delete or rename the following directories to make room for the corresponding directories 
that you are copying from the source server:

From: c:\home\icecoredata

To: c:\novell\teaming

From: c:\home\icecoredata\lucene

To: c:\novell\teaming\lucene

From: c:\home\icecoredata\extensions

To: c:\novell\teaming\extensions
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c:\novell\teaming
c:\novell\teaming\lucene
c:\novell\teaming\extensions

6b Copy your existing Teaming file repository from c:\novell\teaming on the source 
server to the same location on the target server.

6c Copy your existing Teaming database index from c:\novell\teaming\lucene on the 
source server to the same location on the target server.

6d Copy your existing software extensions from c:\novell\teaming\extensions on the 
source server to the same location on the target server.

23.2.4  Importing the Teaming Database to the Target Server
On the target server:

1 In Microsoft SQL Server Management Studio, browse to and right-click the existing Teaming 
database (named sitescape) that was created when you installed the Teaming 2.1 software, 
then click Delete.

2 To import the data from your source Teaming database, browse to and right-click Databases, 
then click Tasks > Restore.

3 In the To database field, specify sitescape.
4 In the From device field, browse to and select the sitescape.bak file that you transferred to 

the target server.
5 Set other restore options as desired, then click OK.

This creates the sitescape database in the following directory on the target server:
c:\Program Files\Microsoft SQL Server\MSSQL

Backed-up data from the source Teaming database is imported into the database for your new 
Teaming 2.1 system.

23.2.5  Updating the Teaming Database on the Target Server
On the target server:

1 (Conditional) If your are updating from Teaming 1.0 to 2.1, unzip the update-1.0.0-
2.0.n.zip file, change to the resulting update-1.0.0-2.0.n directory, then run the update 
script to update the Teaming database from Teaming 1.0 to 2.0:
osql -Uusername -Ppassword -i update-sqlserver.sql

For more complete database update instructions, refer to Section 20.4.1, “Manual Teaming 
Database Update,” on page 152. 

2 To update from Teaming 2.0 to 2.1, unzip the update-2.0.0-2.1.n.zip file, change to the 
resulting update-2.0.0-2.1.n directory, then run the update script to update the Teaming 
database from Teaming 2.0 to 2.1:
osql -Uusername -Ppassword -i update-sqlserver.sql

For more complete database update instructions, refer to Section 19.3.1, “Manual Teaming 
Database Update,” on page 143. 
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23.2.6  Updating the Zone Name from Teaming 1.0 to Teaming 
2.1 (Conditional)
If you are migrating data from Teaming 2.0, rather than 1.0, skip to Section 23.2.7, “Finalizing Your 
New Teaming 2.1 Site,” on page 168.

In Teaming 1.0, the default zone name was liferay.com. Starting in Teaming 2.0, the default zone 
name is kablink. In order to migrate Teaming 1.0 data into a Teaming 2.1 system, you must reset 
the default zone name.

On the target server:

1 Change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat-version\webapps\

ssf\WEB-INF\classes\config

2 View the following files to ensure that the current zone name is set to kablink.
zone.cfg.xml
zone-ext.cfg.xml

3 Use the following commands to update the Teaming database with the new default zone name:
update SS_ZoneInfo set zoneName='kablink' where zoneName='liferay.com'; 
update SS_Forums set name='kablink' where name='liferay.com';

4 Find and rename any liferay.com subdirectories to kablink.
You might or might not find liferay.com subdirectories in the following locations, so you 
should check them all:
c:\Novell\Teaming\filerepository
c:\Novell\Teaming\lucene
c:\Novell\Teaming\extensions
c:\Novell\Teaming\archivestore
c:\Novell\Teaming\cachefilestore

23.2.7  Finalizing Your New Teaming 2.1 Site
1 Start Teaming 2.1, as described in Section 4.1.5, “Starting Teaming on Linux,” on page 55.
2 Reindex the Teaming site, as described in “Rebuilding the Lucene Index” in “Site 

Maintenance” in the Kablink Teaming 2.1 Administration Guide.
Your Teaming site should now function just as it did on the original source server.
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24Migrating from SiteScape Forum 
or Other Collaboration Software

Moving legacy corporate data into a new collaboration system can look like a long, challenging 
process. To make the job easier, see the Novell Teaming Migration Services Flyer. (http://
www.novell.com/rc/docrepository/public/14/basedocument.2009-04-23.2174214965/
Novell_Teaming_Migration_Flyer_en.pdf)
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ATeaming System Requirements 
Assistance

The Novell® Teaming system requirements include supporting components that might or might not 
already be installed on your Teaming server. This section helps you meet the Teaming system 
requirements if you are not already familiar with how to install these supporting components.

Section A.1, “Java Development Kit,” on page 173
Section A.2, “MySQL Database Server,” on page 175

A.1  Java Development Kit
The Novell Teaming software runs inside a Java Virtual Machine (JVM). At present, Teaming 
requires a Java Development Kit (JDK) not a Java Runtime Environment (JRE*) in order to run 
properly. You can use either the Sun JDK or the IBM JDK. Follow the instructions in the section 
below for your operating system and JDK preference:

Section A.1.1, “Sun JDK on Linux,” on page 173
Section A.1.2, “IBM JDK on Linux,” on page 174
Section A.1.3, “Sun JDK on Windows,” on page 175

A.1.1  Sun JDK on Linux
1 Go to the following URL:

Java SE Downloads (http://java.sun.com/javase/downloads/index.jsp)
The update you need is listed as “JDK 6 Update nn.”

2 Click Download next to this update.
3 In the Platform field, select Linux or Linux x64 depending on the processor in your Teaming 

server.
4 Select I agree..., then click Continue to accept Sun’s License Agreement.
5 Click the jdk-6unn-linux-version-rpm.bin file., then save the file to an empty temporary 

directory on your Linux server.
6 As the root user, change to that temporary directory, then use the following command to make 

sure that the download arrived safely:
ls -l

You should see a file named jdk-6unn-linux-version-rpm.bin.
7 Change the permissions on the file to include execute permissions:

chmod +x jdk-6unn-linux-version-rpm.bin

8 Run the self-extracting file:
./jdk-6unn-linux-version-rpm.bin

9 Scroll through the License Agreement, then enter y to accept it.
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This creates a file named jdk-6unn-linux-version.rpm, and a directory named /usr/
java/jdk.1.6.0_nn with the Sun JDK software in it.
The Sun JDK is now installed on your Linux server.

A.1.2  IBM JDK on Linux
“Installing the IBM JDK on SUSE Linux Enterprise Server 11” on page 174
“Installing the IBM JDK on Open Enterprise Server 2 and SUSE Linux Enterprise Server 10” 
on page 174

Installing the IBM JDK on SUSE Linux Enterprise Server 11

The IBM JDK is not included with SUSE® Linux Enterprise Server (SLES) 11. It is available in the 
SLES 11 Software Development Kit at:

http://developer.novell.com/wiki/index.php/
SLES_SDK#SUSE_Linux_Enterprise_11_SDK_Release

Installation instructions are provided as part of the download process.

Installing the IBM JDK on Open Enterprise Server 2 and SUSE Linux Enterprise 
Server 10

IBM JDK 5.0 is available with SUSE Linux Enterprise Server (SLES) 10, on which Open Enterprise 
Server (OES) 2 is based. You can install it using YaST.

1 In YaST, click Software > Software Management.
2 In the Search field, type ibm, then click Search.
3 Select Java 5 SDK, Standard Edition (java-1_5_0-ibm-devel), then click Accept.
4 Click Continue to accept the suggested dependencies, then click No because you don’t need 

any more packages.
5 Exit YaST.

This creates a directory named /usr/lib/jvm/java-1_5_0-ibm-1.5.0_sr3 with the IBM 
JDK software in it.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Teaming Installation Summary Sheet, specify the directory where 
you install the JDK. The Teaming Installation program prompts you for this location.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Teaming Installation Summary Sheet, specify the directory where 
you install the JDK. The Teaming Installation program prompts you for this location.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Teaming Installation Summary Sheet, specify the directory where 
you install the JDK. The Teaming Installation program prompts you for this location.
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A.1.3  Sun JDK on Windows
1 Go to the following URL:

Java SE Downloads (http://java.sun.com/javase/downloads/index.jsp)
The update you need is listed as “JDK 6 Update nn.”

2 Click Download next to this update.
3 In the Platform field, select Windows or Windows x64 depending on the processor in your 

Teaming server.
4 Select I agree..., then click Continue to accept Sun’s License Agreement.
5 Click the jdk-6unn-windows-version.exe file., then save the file to an empty temporary 

directory on your Windows server.
6 Change to that temporary directory, then run the downloaded executable.

This creates a directory named c:\Program Files\Java\jdk6unn with the Sun JDK 
software in it.
The Sun JDK is now installed on your Windows server.

A.2  MySQL Database Server
Section A.2.1, “MySQL on Linux,” on page 175
Section A.2.2, “MySQL on Windows,” on page 177

A.2.1  MySQL on Linux
Depending on the options you select when installing Open Enterprise Server 2 and SUSE Linux 
Enterprise Server (SLES), the MySQL database server might be installed along with the operating 
system. Check for the following directory:

/usr/bin/mysql

If the /usr/bin/mysql directory does not exist, you need to install the MySQL database server. If 
MySQL is already installed, you still need to configure it for use with Teaming.

“Installing MySQL” on page 175
“Configuring MySQL” on page 176
“Learning More about MySQL” on page 176

Installing MySQL

1 Make sure you have access to your operating system installation media.
2 In YaST, click Software > Software Management.
3 In the Search field, type mysql, then click Search.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Teaming Installation Summary Sheet, specify the directory where 
you install the JDK. The Teaming Installation program prompts you for this location.
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4 Select mysql, then click Accept.
5 Click Continue to resolve dependencies.
6 Click Continue to acknowledge package support status.

MySQL is then installed from the SLES media.
7 Continue with “Configuring MySQL” on page 176.

Configuring MySQL

When MySQL is initially installed, it is not configured with an administrator password, nor is it 
configured to start automatically. Follow the steps below to set up the MySQL database server for 
use with Teaming:

1 In YaST, click System > System Services.
2 Scroll to and select the MySQL service, then click Enable.
3 Click Continue to install dependencies, then click OK to close the status box.
4 Click OK > Yes to finish the installation, then exit YaST.
5 In a terminal window, become the root user.
6 To verify that the MySQL database server has started, use the following command:

ps -eaf | grep mysql

You should see MySQL processes running. 
7 Set the administrator password for the MySQL database server:

mysqladmin -u root password new_password

This command changes the password for the MySQL root user, which is the default 
administrator username for the MySQL database server. This command is part of the MySQL 
client package.

IMPORTANT: The MySQL root username is not the same as the Linux root user. The 
Linux root user has a password established for it when you install Linux. In a parallel fashion, 
the MySQL root user needs to have a password established for it when you install MySQL. 

Learning More about MySQL

The following are some basic and useful MySQL commands:

If you want to administer MySQL using a GUI interface, you can download tools from:

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Teaming Installation Summary Sheet, specify the MySQL 
administrator password. The Teaming Installation program prompts you for this information.

Action Command

Stop MySQL /etc/initd/mysql stop

Start MySQL /etc/initd/mysql start

Show MySQL status mysqladmin -u root -p extended-status
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MySQL GUI Tools Downloads (http://dev.mysql.com/downloads/gui-tools/5.0.html)

For more information about MySQL, see:

MySQL Documentation (http://dev.mysql.com/doc)

A.2.2  MySQL on Windows
1 In your Web browser, go to the following URL:

MySQL 5.1 Downloads (http://dev.mysql.com/downloads/mysql/5.1.html)
2 Scroll down if necessary, then click the type of Windows operating system you are using (32-

bit or 64-bit).
3 On the Windows Essentials line, click Download.
4 Click Save File, browse to and select a convenient temporary directory, then click Save. 
5 In Windows Explorer, browse to the directory where you saved the MySQL .exe file. 
6 Double-click the MySQL .exe file to start the MySQL Setup Wizard.
7 Follow the on-line instructions to install the MySQL software on the Windows server, then 

continue with configuring the server.
8 Unless you are already familiar with configuring MySQL on a Windows server, select Standard 

Configuration, then click Next.
9 Select Include Bin Directory in Windows PATH, then click Next.

10 Set the MySQL root user password, then click Next.

11 Click Execute to configure the MySQL database server, then click Finish.
Some messages report the status of your MySQL installation.

12 To monitor the MySQL database server, click Start > All Programs, then click MySQL > 
MySQL Server 5.1 > MySQL Command Line Client.

BASIC TEAMING INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Teaming Installation Summary Sheet, specify the MySQL 
administrator password. The Teaming Installation program prompts you for this information.
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BThird-Party Materials

Section B.1, “ANTLR 3 License,” on page 179
Section B.2, “Colt License Agreement,” on page 180
Section B.3, “Dom4j License,” on page 180
Section B.4, “iCal4j License,” on page 181
Section B.5, “ICU4J license (ICU4J 1.3.1 and later),” on page 181
Section B.6, “JAXEN License,” on page 182
Section B.7, “Jung,” on page 183

B.1  ANTLR 3 License
Copyright (c) 2003-2008, Terence Parr

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution. 
Neither the name of the author nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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B.2  Colt License Agreement
Packages cern.colt*, cern.jet*, cern.clhep 

Copyright (c) 1999 CERN - European Organization for Nuclear Research.
Permission to use, copy, modify, distribute and sell this software and its documentation for any 
purpose is hereby granted without fee, provided that the above copyright notice appear in all 
copies and that both that copyright notice and this permission notice appear in supporting 
documentation. CERN makes no representations about the suitability of this software for any 
purpose. It is provided “as is” without expressed or implied warranty. 

Packages hep.aida.* 
Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas 
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or 
redistribute this work is granted under the terms of the LGPL License, with the exception that 
any usage related to military applications is expressly forbidden. The software and 
documentation made available under the terms of this license are provided with no warranty.

B.3  Dom4j License
Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“Software”), with or without 
modification, are permitted provided that the following conditions are met: 

1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions 
must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution. 

3. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com.

4. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com. 

5. Products derived from this Software may not be called “DOM4J” nor may “DOM4J” appear in 
their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered 
trademark of MetaStuff, Ltd. 

6. Due credit should be given to the DOM4J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “AS IS”' 
AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR 
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
 Teaming 2.1 Installation Guide



novdocx (en)  16 A
pril 2010
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

B.4  iCal4j License
Copyright (c) 2008, Ben Fortuna

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.
Neither the name of Ben Fortuna nor the names of any other contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.5  ICU4J license (ICU4J 1.3.1 and later)
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995-2001 International Business Machines Corporation and others

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell 
copies of the Software, and to permit persons to whom the Software is furnished to do so, provided 
that the above copyright notice(s) and this permission notice appear in all copies of the Software and 
that both the above copyright notice(s) and this permission notice appear in supporting 
documentation.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT 
HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR 
ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN 
ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT 
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization of the copyright holder. 

B.6  JAXEN License
Copyright (C) 2000-2002 Bob McWhirter & James Strachan.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, 
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright     notice, this list of 
conditions, and the disclaimer that follows these conditions in the documentation and/or other 
materials provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products     derived from this 
software without prior written permission. For written permission, please contact 
license@jaxen.org.

4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their 
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation provided 
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
www.jaxen.org.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 
IN NO EVENT SHALL THE Jaxen AUTHORS OR THE PROJECT CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER 
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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This software consists of voluntary contributions made by many individuals on behalf of the Jaxen 
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan 
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://
www.jaxen.org.

B.7  Jung
THE JUNG LICENSE

Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.
Neither the name of the University of California nor the names of its contributors may be used 
to endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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